Migrating from Microsoft Exchange 5.5 to Lotus Notes and Domino 6

Benefits of migration

Planning and implementing a migration project

Coexistence and migration tools

Tommi Tulisalo
Ted Dziekanowski
Sean Long
Kurt Nielsen
Graeme Povall
**Note:** Before using this information and the product it supports, read the information in "Notices" on page ix.

**First Edition (July 2003)**

This edition applies to IBM Lotus Notes and Domino version 6.0.1 and Microsoft Exchange 5.5.

© Copyright International Business Machines Corporation 2003. All rights reserved.
Note to U.S. Government Users Restricted Rights -- Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
Contents

Notices ......................................................... ix
Trademarks ..................................................... x

Preface .......................................................... xi
The team that wrote this redbook. .............................................. xi
Become a published author ................................................ xiii
Comments welcome .................................................. xiii

Part 1. Why migrate from Exchange 5.5 ........................................ 1

Chapter 1. Why migrate from Exchange 5.5 to Domino 6 .................. 3
  1.1 Introduction .................................................. 4
  1.2 Why migrate? .................................................. 4
    1.2.1 What does migrating from Exchange to Domino involve? ....... 5
    1.2.2 Why migrate to Domino from Exchange? ........................ 9

Chapter 2. Messaging options for organizations using Exchange 5.5 .... 17
  2.1 Remain on Microsoft Exchange 5.5 ................................ 18
  2.2 Upgrade to Windows 2000, remain on Exchange 5.5 ............... 19
  2.3 Migrate to Exchange 2000 and Active Directory .................. 20
  2.4 Migrate to Domino 6 .......................................... 23

Part 2. Planning for the migration ............................................. 25

Chapter 3. Migration project overview ...................................... 27
  3.1 The key steps in a coexistence/migration project .................. 28
  3.2 The sponsor .................................................. 31
  3.3 The project vision ............................................. 32
  3.4 The project team .............................................. 32
  3.5 The schedule .................................................. 34
  3.6 The scope .................................................... 34
  3.7 Documenting the business requirements ........................... 34
    3.7.1 The basic requirements ................................... 35
    3.7.2 Further requirements .................................... 36
  3.8 The communication plan ....................................... 37
  3.9 Setting the expectations ...................................... 38
  3.10 Documenting the current messaging environment ................. 38
    3.10.1 Documenting the Microsoft Exchange environment .......... 39
    3.10.2 Documenting the hardware profile ........................ 43

© Copyright IBM Corp. 2003. All rights reserved.
3.10.3 Documenting the network infrastructure ........................................ 44
3.10.4 Administration and support infrastructure ...................................... 44
3.11 Developing the training plan .............................................................. 46
3.12 Risk ................................................................................................. 48
3.13 Plan, design, and document the new environment ................................. 49
  3.13.1 Determining the characteristics of the servers needed ....................... 49
  3.13.2 Client selection .......................................................................... 53
3.14 Developing a coexistence and migration strategy ................................. 60
  3.14.1 Levels of coexistence .................................................................. 61
  3.14.2 Pros and cons of migrating ............................................................ 64
  3.14.3 What to migrate ......................................................................... 64
  3.14.4 Overview of the migration process ............................................... 65
  3.14.5 Migration tools ......................................................................... 66
  3.14.6 Acquiring the necessary information for migration ....................... 67
3.15 Realigning the expectations .................................................................. 71
3.16 Deploying the coexistence and migration strategy .................................. 72
3.17 Final phase: Closure ......................................................................... 74

Part 3. Coexistence .................................................................................. 75

Chapter 4. Using the Microsoft Exchange Connector for coexistence ............ 77
  4.1 Preparation ...................................................................................... 78
    4.1.1 Supported environment .............................................................. 78
    4.1.2 General setup information .......................................................... 78
  4.2 Installing the Exchange Connector ..................................................... 79
    4.2.1 Step 1: Install the Notes Client .................................................. 79
    4.2.2 Step 2: Install the Exchange Connector for Lotus Notes .......... 81
    4.2.3 Step 3: Registering the Connector with Lotus Notes ......... 86
  4.3 Configuring the Connector ................................................................ 94
  4.4 Exchange Connector for Lotus Notes customization ............................ 116
    4.4.1 Defining import and export containers .................................. 116
  4.5 Operating and monitoring the Connectors ........................................... 127
    4.5.1 Start the Connectors ................................................................. 127
    4.5.2 Operate the Connectors ............................................................ 128
    4.5.3 Monitor the Connectors ............................................................. 135
    4.5.4 Stop the Connectors ................................................................. 136
  4.6 Customizing the Microsoft Exchange Connector for Lotus Notes tables ... 137
    4.6.1 Customizing the synchronization ............................................. 138
  4.7 Customizing for SMTP mail ............................................................... 140
    4.7.1 Customizing for SMTP as the mail transport .......................... 140

Chapter 5. Using the TFS Gateway for coexistence .................................... 145
  5.1 TFS Gateway .................................................................................. 146
    5.1.1 Coexistence-related features ................................................... 146
<table>
<thead>
<tr>
<th>Appendix A. Exchange Connector installation checklist</th>
<th>449</th>
</tr>
</thead>
<tbody>
<tr>
<td>General setup information</td>
<td>450</td>
</tr>
<tr>
<td><strong>Appendix B. Creating an Outlook profile</strong></td>
<td>451</td>
</tr>
<tr>
<td>Creating an Outlook profile</td>
<td>452</td>
</tr>
<tr>
<td><strong>Appendix C. Comparing the features of different clients for Domino</strong></td>
<td>455</td>
</tr>
<tr>
<td><strong>Appendix D. Additional material</strong></td>
<td>465</td>
</tr>
<tr>
<td>Locating the Web material</td>
<td>465</td>
</tr>
<tr>
<td>Using the Web material</td>
<td>465</td>
</tr>
<tr>
<td>How to use the Web material</td>
<td>466</td>
</tr>
<tr>
<td><strong>Related publications</strong></td>
<td>467</td>
</tr>
<tr>
<td>IBM Redbooks</td>
<td>467</td>
</tr>
<tr>
<td>Online resources</td>
<td>467</td>
</tr>
<tr>
<td>How to get IBM Redbooks</td>
<td>468</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td>469</td>
</tr>
</tbody>
</table>
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing, IBM Corporation, North Castle Drive Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:
This information contains sample application programs in source language, which illustrates programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. You may copy, modify, and distribute these sample programs in any form without payment to IBM for the purposes of developing, using, marketing, or distributing application programs conforming to IBM’s application programming interfaces.
Trademarks

The following terms are trademarks of the International Business Machines Corporation in the United States, other countries, or both:

- Redbooks (logo)™
- Domino Designer®
- PowerPC®
- IBM®
- Redbooks™
- IMS™
- Sametime®
- pSeries™
- Lotus Notes®
- SP1®
- z/OS®
- Lotus Organizer®
- Tivoli®
- iSeries™
- Notes®
- WebSphere®
- AIX®
- OS/2®
- Workplace Messaging™
- Domino™

The following terms are trademarks of other companies:

- ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel Corporation in the United States, other countries, or both.
- Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.
- Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.
- C-bus is a trademark of Corollary, Inc. in the United States, other countries, or both.
- UNIX is a registered trademark of The Open Group in the United States and other countries.
- SET, SET Secure Electronic Transaction, and the SET Logo are trademarks owned by SET Secure Electronic Transaction LLC.
- Other company, product, and service names may be trademarks or service marks of others.
Preface

This IBM® Redbook describes why and how to migrate from Microsoft Exchange 5.5 to IBM Lotus® Notes® and Domino™ 6.

It begins with a discussion of the reasons an organization using Exchange 5.5 would want to move to Domino 6, and describes the benefits that can be gained. It lays out the different options that the organization has for a future messaging infrastructure and discusses the pros and cons of each alternative. It is particularly suited to business and IT managers.

The next part is about planning and managing a migration project. It covers how to assess the current messaging environment, design the migration project and the future infrastructure, and successfully implement the migration plan. This part is primarily of interest to project managers and IT architects.

The rest of the book deals with the technical aspects of moving to a Lotus Notes and Domino 6 messaging environment. Topics covered are:

- Coexistence and migration scenarios
- Strategies for coexistence during the project
- Installation and setup of coexistence and migration tools
- How to migrate users and messaging and calendaring information
- Public Folder migration and coexistence
- Results achieved in the lab using various tools and techniques
- Wrapping up a migration project

This material is useful for anyone who has to evaluate the tools, install them, and conduct a messaging migration project.

The team that wrote this redbook

This redbook was produced by a team of specialists from around the world working at the International Technical Support Organization, Rochester Center.

Tommi Tulisalo is a Project Leader for the International Technical Support Organization at Cambridge, Massachusetts. He manages projects whose objective is to produce redbooks on all areas of Lotus Software products. Before joining the ITSO in 2001, he was an IT Architect for IBM Global Services in Finland, designing solutions for customers, often based on Lotus software.
Ted Dziekanowski is an independent consultant and owner of the Chatham Technology Group, which is based in the New York Metropolitan area. Ted is both a Lotus and Microsoft Certified Trainer, holds PCLP, MCSE+I, and Windows 2000 certifications, and has a BS in Accounting and an MBA in Management. His recent engagements include Active Directory infrastructure design for a Fortune 50 company, migrations from Exchange 5.5 to Exchange 2000, as well as numerous engagements involving versions of Domino 3.0a to 6.0.1 and Exchange 4.0 to Exchange 2000.

Sean Long is a Senior IT Specialist for IBM Software Services for Lotus. He has more than 15 years of experience managing technology projects and providing consulting services. Among his areas of expertise are MS Exchange and Lotus Domino architectures, migration and coexistence strategies and implementations, and optimizing data center operations.

Kurt Nielsen is a Senior IT Specialist for the ITS Lotus Technology Group in Denmark, with an emphasis on architecture and infrastructure. He has been with IBM/Lotus since 1998, originally working as a systems programmer and systems specialist in Networking Services. His primary responsibilities are Domino design, infrastructure, migration, and analysis. Kurt has over 12 years of experience in consulting with client organizations in the insurance, banking, and manufacturing sectors.

Graeme Povall is a Senior IT Specialist with IBM UK. He provides pre- and post-sales support to customers within EMEA as part of the Pan EMEA technical sales support team. Graeme was previously a member of the Lotus Integration Services and Support team in Boeblingen, where he provided support and training to “Move2Lotus” business partners worldwide. He has more than 17 years experience working with different messaging systems, and providing coexistence and migration consulting and support.

A number of people have provided support and guidance. In particular we would like to thank Arthur Fontaine for direction and contributions. Arthur is a Senior Market Manager at IBM Lotus Software in Cambridge, Massachusetts, USA. He is responsible for the Notes/Domino Tradeup family of offerings that target Microsoft Exchange and other competitors. Arthur has been at Lotus for seven years; prior to that, he was a Lotus contractor and Business Partner. He holds a BA in English Literature and an MBA. Arthur can be reached at afontaine@us.ibm.com.

Special thanks to Vadim Gringolts, who is the Director of Messaging Solutions for Binary Tree. Vadim has been with Binary Tree for 4 years. Prior to that he was with Lotus/IBM for 14 years, and he started his career with Soft-Switch, a messaging connectivity company acquired by Lotus in the mid-90s. Vadim has worked with messaging and migration products and projects for almost 20 years, both as a product developer and as a consultant. He has assisted many Fortune
500 clients, as well as smaller companies world wide, in solving their messaging and migration problems. In addition to contributing to the redbook, Vadim managed the support efforts that various people at Binary Tree provided to the redbook team.

In addition, we would like to thank the following people for help and guidance:

- Mike Kurtti and Kim Armstrong - BinaryTree
- David Via and John Wargo - Wolcott
- Sudeep Trivedi and Harry Wong - CASAHL
- Don Gillespie - TFS Technology
- Emilio Penedo - ABSystems SA
- John Bergland, Ed Brill, David Hinkle, Pascal De Mulder, Jacques-Marie Perrier - IBM
- Alison Chandler - ITSO Poughkeepsie

**Become a published author**

Join us for a two- to six-week residency program! Help write an IBM Redbook dealing with specific products or solutions, while getting hands-on experience with leading-edge technologies. You'll team with IBM technical professionals, Business Partners and/or customers.

Your efforts will help increase product acceptance and customer satisfaction. As a bonus, you'll develop a network of contacts in IBM development labs, and increase your productivity and marketability.

Find out more about the residency program, browse the residency index, and apply online at:

[ibm.com/redbooks/residencies.html](http://ibm.com/redbooks/residencies.html)

**Comments welcome**

Your comments are important to us!

We want our Redbooks™ to be as helpful as possible. Send us your comments about this or other Redbooks in one of the following ways:

- Use the online **Contact us** review redbook form found at:
Send your comments in an Internet note to:
redbook@us.ibm.com

Mail your comments to:
IBM Corporation, International Technical Support Organization
Dept. JLU Building 107-2
3605 Highway 52N
Rochester, Minnesota 55901-7829
Part 1

Why Migrate from Exchange 5.5

Part 1
Migrating from Microsoft Exchange 5.5 to Lotus Notes and Domino 6
Why migrate from Exchange 5.5 to Domino 6

This chapter covers the strategic and market factors that promote the benefits of Domino over Exchange, and the remainder of the book is devoted to the architectural planning and technical activities of your migration decision. For business or IT managers, this chapter provides essential information about the “what” and “why” of migration. The rest of the book is about the “how” of migration, and should give you the confidence that your organization will achieve the results you expect—and deserve—from this process.
1.1 Introduction

Since you are reading these words, it's likely that you are among the many customers who are re-evaluating their use of Microsoft Exchange. In these pages we document your options for “trading up” from Exchange to IBM Lotus Domino, as hundreds of organizations have already done.

Many benefits can be expected to result from this infrastructure upgrade: lower total cost of ownership; better security against viruses and worms; less downtime; more options in the type and pace of upgrades of ancillary software such as data stores and directories—to name just a few. But like any infrastructure modification, it's an activity that warrants careful attention from management and information technology (IT) staff alike. This redbook is designed as a comprehensive resource to ensure a smooth, predictable migration. The writers have collaborated here to share the benefits of their extensive experience in replacing Exchange with Domino, having managed cumulatively the migrations of tens of thousands of users, in organizations of all sizes and types. Our focus here is on the architectural considerations, real-world scenarios, best practices, and the “gotchas” that you may encounter along the way. In short, this redbook is written with a goal of ensuring the success of your Domino project.

As the title suggests, we focus specifically on migrations from Exchange 5.5 to Domino 6, since that is the path that most customers will take. However, if you have Exchange 2000, or other products such as Novell GroupWise or Netscape Mail, many of the same concepts will apply.

One important note: while many observers recognize Domino as a premier enterprise system because of its widespread use in the world’s largest multinational corporations, in fact it is equally appropriate to small and mid market organizations. Thousands of smaller organizations already run their critical messaging and collaboration systems on Domino. The primary redbook scenario is an organization of between 500 and 5,000 users, but even organizations of 50 users or fewer will find the content to be complete. Larger organizations will also find great utility in the book, but since those customers will likely have expert personnel available—internally or via contracted services—there is less concentration on such scenarios.

1.2 Why migrate?

Why is a discussion of business-oriented concepts essential in a technical redbook on the topic of messaging migration? Quite simply put, it's because this can be one of the most significant decisions your organization makes over the
next several years. It will directly affect many other decisions and opportunities available to you. Most notably, your options to exploit emerging enterprise architecture models—for example, Java 2 Enterprise Edition (J2EE), Microsoft .NET, and Web services—will be fundamentally defined by the choice you make in your messaging and collaboration platform.

Note that we do not assert, as do some vendors, that the migration activity is without effort, expense, or even risk. In fact, we emphasize throughout this book that, as with any “touch” of core IT infrastructure, detailed analysis, thorough planning, and clear and constant communication are the keys to success. However, a forthright and honest business-oriented discussion illustrates that the benefits are greater, and the risks far lower, in migrating to Domino rather than remaining on Exchange or continuing on the path that Microsoft has laid out for the future of Exchange.

1.2.1 What does migrating from Exchange to Domino involve?

As an Exchange user, you are familiar with the basic components of client-server messaging and scheduling. Domino offers all of the same capabilities, and many more, although those are outside the scope of this redbook. We’ll touch on the application and solution capabilities of Domino in the “why” section of this chapter, with pointers to more information, but for the purposes of this discussion we’ll stick to the equivalent messaging and scheduling capabilities of Domino and Exchange.

The migration process

Both Domino and Exchange fall in the International Data Corporation (IDC) market classification of “integrated collaborative environment,” or ICE. An ICE system is comprised of messaging and scheduling server software and a matching client component. Microsoft offers Exchange as the server and Outlook as the client, and IBM Lotus offers Domino as the server and Notes as the client. Through evolution, both Exchange and Domino also support alternate client and server interfaces, such as Web (HTTP) for e-mail and scheduling, POP3 and IMAP for e-mail, and iCAL for scheduling. These are discussed later in this section. Domino also supports Outlook as a client, although Exchange does not support Notes as a client except through POP3 or IMAP.

The migration process itself involves some basic architectural and process choices, which are covered extensively in this book. The two primary options are: “flash” cut-over versus coexistence; and data migration versus “clean start” migration, where previous data is archived and new e-mail and scheduling starts over at the point of migration. For most moderately-sized organizations using basic Exchange e-mail and scheduling, it is reasonable to expect a seamless user experience; in these cases users will simply arrive at work one morning and
begin using the new system with all existing data and schedules intact. For larger organizations, or those with more sophisticated Exchange implementations, or organizations migrating as a result of a merger or acquisition, there will likely be a period of coexistence between the systems, where different users are on different systems. This is not as unwieldy as it sounds: the strategies and tactics covered in this book show how to achieve this with nearly 100% fidelity across the systems. However, this integration itself imposes setup and ongoing administration costs, so open-ended coexistence may not be a viable strategy for many organizations. This is covered in detail in the technical chapters of the book.

There are several options within the categories of migration and coexistence. Domino Upgrade Services (DUS) are free tools included with Domino to migrate Exchange mailboxes to Domino. Moderately complex implementations can be easily handled by DUS, either as an internal project or using contracted services. Larger or more complex migrations would probably benefit from using one of the excellent third party tools on the market; in this redbook we discuss some of them, with a complete discussion of Common Migration Tool (CMT) from Binary Tree. There are also options for coexistence, ranging from simple SMTP-to-SMTP connections, to free “connectors” from Microsoft, to third party tools such as TFS Gateway from TenFour, which is also covered here.

Domino runs on virtually every major hardware and operating system platform, including Windows, Linux, and Sun Solaris on Intel processors; IBM pSeries™, iSeries™ and zSeries® on PowerPC® and RISC processors; and Sun Solaris and HP-UX on RISC processors. This is in stark contrast to Exchange, which requires specific versions of Microsoft Windows as its operating platform. Domino operation is very nearly identical on every platform, and in fact all platforms can be mixed and matched, and even clustered, without problems.

For customers migrating from Exchange, one of three strategies usually apply. Some customers choose to put Domino on their existing Windows servers, which is an attractive option because Domino typically requires less new hardware investment than Microsoft recommends for an equivalent Exchange 2000 upgrade. Similarly, some customers choose to convert those Windows/Exchange machines to Linux/Domino machines, gaining the openness and cost savings of Linux at the same time as the Domino migration. Lastly, many customers use the migration process as an opportunity for server consolidation, moving to one of the high-scalability platforms as a way to reduce the numbers of servers required to support the messaging function, and the administrative and licensing overhead associated with “wheat fields” of Windows servers.

An awareness of the multitude of migration options frequently leads to the question of in-house versus contracted migration services. In fact, this is one of the fundamental questions you will need to address. It is certainly possible to
migrate successfully using in-house staff and free or purchased migration tools, and many customers have done so. On the other hand, contracted services add a level of insurance and peace of mind that many customers are willing to pay for. Hundreds of IBM Lotus business partners are members of the “Move2Lotus” initiative, which requires demonstrated experience and expertise in just this type of migration project. As the saying goes, “There's no substitute for experience.” Since the overall goal is always for a smooth and successful transition, many customers conclude that it's a wise investment to hire skilled technology partners, even if it's necessary to dedicate part of the future cost savings to the task.

The migration components
Table 1-1 illustrates the equivalent products in your Exchange to Domino migration. We go into detail about the IBM/Lotus pieces following the table, but the overview will help you to create a “mental map” of how they compare.

<table>
<thead>
<tr>
<th>IBM Lotus product/offering</th>
<th>Microsoft product/offering</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domino Messaging Server</td>
<td>Exchange Standard Edition</td>
<td>Basic messaging and calendar server software</td>
</tr>
<tr>
<td>Domino Enterprise Server</td>
<td>Exchange Enterprise Edition</td>
<td>Advanced messaging and calendar server software</td>
</tr>
<tr>
<td>Notes client</td>
<td>Outlook client</td>
<td>Integrated collaborative environment client software</td>
</tr>
<tr>
<td>Domino Web Access</td>
<td>Outlook Web Access</td>
<td>Rich Web access to messaging and calendar</td>
</tr>
<tr>
<td>Domino Access for Microsoft Outlook</td>
<td>Outlook 2002 Connector for Lotus Domino</td>
<td>Connector to support Outlook against Domino</td>
</tr>
<tr>
<td>POP3/IMAP4</td>
<td>POP3/IMAP4</td>
<td>Internet standard access to e-mail</td>
</tr>
<tr>
<td>WebMail</td>
<td></td>
<td>Basic Web access to messaging and calendar</td>
</tr>
</tbody>
</table>

- **Domino Messaging Server**: This software supports messaging, calendar, discussions, and teamrooms. It is technically the same software as Enterprise Server, but restricted by license terms to essentially the same functionality as Exchange server, meaning no access to custom collaborative applications created using Domino Designer®. Messaging server supports partitioning, to
run multiple instances of Domino on one machine, but not clustering, which provides failover and load balancing. The equivalent to this would be an Exchange Standard Edition product, which technically differs from the Enterprise Edition in that it has a 16 GB limitation on the information store on the server. In contrast, the Domino Messaging Server is not limited in any technical way.

- **Domino Enterprise Server**: This software supports messaging, calendar, discussions, and teamrooms, as well as packaged solutions or custom applications based on the Domino application platform. Enterprise Server supports both partitioning and clustering. This is by far the most popular version of Domino because of its scalability and flexibility.

- **Notes**: The client software in the Domino family includes the same “runtime engine” as Domino. What this means is that messaging (and other applications) run the same on the client as on the server. Therefore, Notes is 100% functional even when disconnected from the server, a factor which is the basis for its legendary mobility. It even supports disconnected access to corporate directories and other users’ calendars, when configured appropriately by the user or administrator. Notes 6 features a classic e-mail interface which is intuitive for Outlook users and anyone who has used Netscape Mail, Outlook Express, Eudora, and so forth.

- **Domino Web Access**: Formerly called iNotes™ Web Access (iWA), this is a rich dynamic HTML (DHTML) interface to the full range of Domino messaging and calendar features. It runs on all “5+” level browsers and includes an option for offline usage via Domino Offline Services (DOLS), which is available to all Domino applications including messaging and calendar.

- **Domino Access for Microsoft Outlook**: This open standards-based connector software sits between Domino and Outlook, allowing users an option to continue in their familiar interface during a migration or coexistence project. While its function is very good and scheduled for continued enhancement, it is not recommended for permanent usage. IBM Lotus worked with Microsoft to create a Microsoft version of a connector. Based on proprietary MAPI and Notes technology, it is highly functional and endorsed by IBM Lotus. Its drawbacks are the requirement for Outlook 2002 and above, and Windows XP (the Lotus connector also supports Outlook 2000 and above, and Windows 98/200/XP), and the requirement that a full Notes client be installed on the user workstation. IBM Lotus will be providing a targeted install that eliminates the Notes requirement, sometime in 2003.

- **POP3/IMAP4**: The Internet standards for e-mail are supported by both Domino and Exchange.

- **WebMail**: Basic Web access to e-mail and calendar are provided by the new WebMail offering. While less feature-rich than Domino Web Access, WebMail
Chapter 1. Why migrate from Exchange 5.5 to Domino 6

Acquiring Domino

Domino is sold in the classic client-server model, as well as a Complete Enterprise Option (CEO) offering that charges on a per-user basis.

In the client-server model, a customer acquires licenses equivalent to the number of CPUs on its Domino servers, and a Client Access License (CAL) for each user. Once a user has a CAL, he or she can connect to any Domino Server without any additional requirements. The exception is that some CALs come in two varieties: Messaging and Collaboration. Messaging CALs, like Domino Messaging Server, only entitle the user to messaging, calendar, discussions, and teamrooms. Collaboration CALs, like Domino Enterprise Server, also include access to packaged and custom applications based on Domino. Collaboration CALs are by far the most popular option.

There are a few different ways to acquire CALs:

- Basically, a Lotus CAL is required to access Domino for messaging, even with third party client software. The Notes client software contains an “embedded” CAL, so further CAL purchases would not be required.
- Other client types based on open standards-based (that is, HTTP, POP3/IMAP4) or third party software (for example, Outlook) require a separate CAL.
- It is important to note that Outlook is included with Office, and/or with an Exchange CAL. If neither of these license types is valid, the software would have to be purchased separately.

1.2.2 Why migrate to Domino from Exchange?

Your reasons for moving from Exchange to Domino may be proactive, reactive, or both. Perhaps you are proactively seeking to upgrade your messaging and collaboration infrastructure to a more open and scalable messaging platform, one that delivers a lower cost of ownership and increased reliability. You may be seeking to “uncouple” your messaging decision from your operating system and directory decisions to retain flexibility. You may be reactively looking for options to avoid the effects of restrictive and expensive licensing policies, the December 31, 2003 end of mainstream support for Exchange 5.5, the steady stream of Exchange-targeted viruses and worms, or future “rip and replace” Exchange upgrades. Or you may simply be seeking the best product, and best value, for your organization.

Whatever your reasons for exploring alternatives, IBM Lotus Domino 6 will likely be at the top of your list. Domino is the market leader in enterprise messaging.
and collaboration, with thousands of customer of all sizes and types running their businesses on Domino infrastructure. The Domino 6 version is a significant improvement on earlier Domino releases; its proven multi-platform architecture has been refined in the theme of total cost of ownership (TCO), delivering the full functionality of enterprise messaging at a cost comparable to basic e-mail.

But why migrate at all? In today's economic environment it is difficult to justify any IT project that doesn't deliver measurable, positive return on investment (ROI). One option would be to simply remain with Exchange 5.5 and defer any move until it is necessary. While possible, for many organizations that is not a viable option. Most organizations will elect to undertake a migration anyway, due to two factors discussed in the following sections.

**Microsoft is phasing out Exchange 5.5**

First, the approaching end of mainstream service for Exchange 5.5 and Microsoft Windows NT (upon which most Exchange 5.5 implementations are built) poses a challenge for organizations that have a policy of using only supported software. Many publicly-traded companies will not employ unsupported software because bug fixes are not available, and the use of software with known flaws can raise issues of liability. Note that, as of this writing, the end of mainstream support for Exchange 5.5 and Windows NT is scheduled for December 31, 2003. Windows NT mainstream support has been extended by a year already in response to customer demands, and it's certainly possible that Exchange will be extended as well, although that would extend past the end of mainstream service for Windows NT. Also note that Microsoft makes paid support contracts available past the end of mainstream support, so that's an option for customers that cannot, or elect not to, migrate.

It's clear, however, that Exchange customers will continue to be subject to pressure to "upgrade" to Exchange 2000, or to Exchange 2003, which is scheduled for release sometime in 2003. Analysts estimate that only a minor percentage—less than 20% by most reports (InternetNews.com, “Lotus Domino - Should You Upgrade or Migrate, Now or Later?”; October 25, 2002)—had moved to Exchange 2000 by the end of 2002, nearly three years after release of the product. Most observers view the complexity of the upgrade, which is really a major migration, as the reason for the slow uptake of Exchange 2000. For example, a full implementation of Windows 2000 and its Active Directory user management system is required before Exchange 2000 can be run in “native mode;” until that is achieved the entire system is essentially still an Exchange 5.5 implementation. This activity has been reported to cost as much as $700 US per user, with an average of $400 US per user in typical organizations (Ferris Research White Paper, April 2002). Throughout this book we cite examples of activities in migrating from Exchange to Domino that are actually less complex and expensive than the equivalent activities in the Exchange 5.5 to Exchange 2000 “upgrade.”
Domino offers major TCO and functional benefits

The second factor that will cause most organizations to migrate in 2003 is the improvements available—both in functionality and in cost—from the latest technology as demonstrated by Lotus Domino. Domino 6 was released in September 2002, and was the first leading messaging system to embrace the TCO theme. This has proved to be a timely and powerful strategy. A Radicati study, “Messaging Total Cost of Ownership 2003” shows that Lotus Domino 6 has 47% lower TCO than Exchange 2000; administration costs alone are more than three times higher for Exchange.

As noted previously, few IT projects will be funded in 2003 unless they can provide measurable and positive return on investment. While Domino has been widely hailed for its TCO focus, Exchange 2000 offers few improvements over Exchange 5.5; in fact, mostly it just addresses shortcomings in the previous version. This is also a factor in the slow uptake of Exchange 2000. Exchange 2003 is positioned as the “TCO” release for Exchange, with improvements in scalability, administration, and data management; it is designed to offer relief from the high ownership costs of Exchange 5.5 and Exchange 2000. However, it will still require an all Windows 2000 or 2003 infrastructure.

Why has TCO become so important to messaging customers? Throughout the period from 1995 to 2001, many organizations were motivated by competitive pressures to adopt Internet technologies including e-mail. The driving force was to get as many users as possible up and running with e-mail, and to keep downtime to a minimum. The ability to do these things well propelled Domino to the front of the market, a position it retains despite furious assaults from Microsoft and others. Over time, e-mail (and, later, enterprise scheduling) came to be regarded as essential utilities. Like other utilities such as light, heat and transportation, it became clear that e-mail is an expense that needs to be managed and controlled.

Hundreds of individual improvements in Domino are focused on TCO. For example, new compression algorithms for file attachments reduce the cost of disk storage up to 40%, and network compression technology reduces bandwidth requirements up to 50%. Communication between clients and servers is up to 60% faster, saving in network costs and helping users be more productive. Highly optimized code in Domino 6 delivers faster response time and lower CPU utilization, and increases scalability up to 400% for some messaging protocols. Building on existing strengths in multi-platform support, Domino 6 server consolidation can cut the number of machines drastically; for example IBM reduced its European, Middle East and Africa (EMEA) Domino infrastructure from 28 servers to two servers, and cut its data center requirements in half.
Numerous improvements in Domino 6 dramatically lower the requirements for administrative support. Profile-based administration allows for highly flexible and maintainable user management.

**Messaging futures are key**

Future upgrades are another problem facing Exchange customers. The same Radicati study cited earlier shows that Exchange customers can also expect more than three times the expense for “migration and upgrade costs.” Microsoft has announced that future Exchange versions will be based on its SQL Server relational database, replacing the non-relational data stores in versions up to and including Exchange 2003. Positioned as a natural evolution for messaging storage, in fact this is needed by Exchange to address one of its most troublesome design elements: shared data storage. Because all users on a given Exchange 5.5 server actually share a single database, corruption of a single message or user mailbox can bring everyone down, necessitating complex and lengthy restoration from backup systems.

In contrast, Domino is based on proven non-relational database technology that has been refined and optimized through six full releases, with the last two benefiting from the expertise of the IBM DB2® relational database team and IBM Almaden research labs. In fact, IBM Lotus has announced that DB2 will be supported as an optional data source in the next major release of Domino 7, scheduled for release in 2004. However, both data stores will be supported, even for the same user, and will continue to be based on the same robust “one user, one mail file” model as all previous versions of Domino. (Domino has offered a “single mail store” option for several years, but very few customers elect to implement it, preferring the administrative simplicity and inherent redundancy of the standard model.)

**Messaging architecture impacts all IT plans**

Business and technology managers are wise to pay special attention to the impact that the messaging system plays in overall IT architecture. Once regarded as a “point” solution to a specific communication need, messaging has become a core element of a collaboration platform that includes portals, instant messaging, online meetings, team workspaces, and electronic learning. Moving forward, elements of all types of collaboration, from inbox and group scheduling, to awareness and chats, to Web conferencing and workplaces, will be delivered as modular components that can be integrated anywhere and everywhere in an IT infrastructure. In fact, IBM already delivers market-leading offerings in all of these collaboration categories. The concept of using these capabilities pervasively, defined as “contextual collaboration” by leading analysts including Gartner and IDC, represents a fundamental evolution of collaboration from application “silos” separate from other important technology systems, to a set of core capabilities that can be exploited anywhere they add value to an application or process.
The purpose of this book is not to delve into the underpinnings of the IBM Lotus strategy for Workplace and contextual collaboration; there is already a great deal of information available in other places, including the Lotus Web site at: http://www.lotus.com

However, it's important to understand how both Domino and Exchange will play in this emerging model, particularly in regard to the implied or assumed dependencies that will be required to gain the promised benefits.

Exchange, like all Microsoft products, is evolving to participate in an overarching strategy dubbed "Microsoft.NET." Like nearly all Microsoft offerings, it works only on the Microsoft Windows operating system. One element of .NET is that, since it assumes that only Windows and Microsoft products will be used, it allows Microsoft to treat all its products as a holistic system and apportion functionality in different places. One good example is Active Directory, which is part of Windows and acts as the central user repository and management system for all .NET applications including Exchange. Another is the SQL database, especially in its forthcoming “Yukon” iteration sometime in 2005, which is slated to become the underlying data store for .NET elements including the Windows file system and Exchange.

In fact, many features and functions that had previously been part of Exchange or other applications are being broken out as separate offerings, and/or built into the Windows platform. For example, Exchange 5.5 and 2000 were initially positioned as application platforms in the Domino model, but that capability was later deprecated in favor of other parts of the Microsoft portfolio including SQL Server and Internet Information Server (IIS), using Visual Basic and Visual Basic .net development tools. (Most observers agree that Exchange application development never approached the equivalent Domino capabilities, and in fact an IBM Lotus-sponsored study [Sytel, A Comparison of Exchange and Domino Application Development, January 2001] showed Domino to be 44% less expensive and 42% faster than Exchange 2000 for a similar application, with the Domino version being of superior quality.) Similarly, instant messaging was initially a component of Exchange, but Microsoft has announced that future versions will be part of Windows.

What does this all mean to business and IT managers? In pieces it's really just a set of tactics that address shortcomings, or exploit opportunities, in the Microsoft product line. That's both the prerogative and expectation of any software vendor. In sum, however, it's an inexorable march toward a single proprietary platform, and each implementation of a component serves to make it harder to make a non-Microsoft choice somewhere else. For organizations that have consciously made a .net decision, of course, that is not an issue. If you believe in the .net architecture and its benefits, particularly in the area of integration, there's nothing wrong.
But in fact most organizations run mixed environments, with hardware and software platforms from a number of vendors. There are many reasons for this, including the widespread popularity of the Java platform, greater scalability and reliability of UNIX-based operating systems, and the explosion in open-source software such as Linux. IBM has earned a leadership position in many of these areas, and IBM Lotus is an important participant in such initiatives. The philosophy underlying the IBM strategy—in fact the strategy embraced by every leading vendor except Microsoft—is to adhere to open standards and protocols that permit integration and interoperability among disparate products from a universe of vendors, with the result being increased choice and the benefits of true competition for every customer dollar.

IBM Lotus has embraced open standards support in Domino since its inception. The Domino 6 release contains deep support for the Java 2 platform, Enterprise Edition (J2EE) model, including rich Java interfaces and support for many leading directory and database systems, including those from Microsoft. This preserves customer choices because it integrates with everything in the IT environment, while exploiting benefits specific to each. For example, while Exchange requires Active Directory, Domino supports it with its ADSync tool for bidirectional user and group management. But Domino also includes its own enterprise-grade directory, and supports open standards-based LDAP directories as well. All of this makes it easy to develop contextual collaboration into applications throughout the enterprise, interfacing with multivendor workplace and portal metaphors.

Going forward, IBM Lotus has announced a Workplace strategy that surfaces all of the collaborative elements in a single user interface—including all Lotus product offerings and those from other vendors—and will continue to enhance support for J2EE in future versions of Domino. Customers can own Domino with confidence that it will continue to deliver the capability to play well in open architectures, and even in less-open architectures such as .net. At the same time, IBM Lotus has announced new initiatives that build upon its expertise as collaboration leaders to create a set of pure J2EE components that offer individual collaboration elements—such as e-mail, inbox, awareness, instant messaging, and e-meetings—that can be “dropped in” whenever and wherever appropriate. While separate technology from Domino’s integrated application approach, the new “next generation” offerings are designed to fully complement and integrate with Domino; in places supplementing Domino capabilities through Web services integration, and in other places providing capabilities for users who do not need the full range of Domino features.

The first example of a next generation offering is IBM Lotus Workplace Messaging™ (LWM), released in May 2003. Built upon IBM WebSphere® J2EE technology and IBM DB2 database technology, it is able to provide low-cost e-mail capability to under-served user populations in Domino accounts. Studies
show that large user populations such as factory workers and retail staff can benefit from electronic communications, but do not need the full features of enterprise e-mail. LWM delivers a way to serve those users within the same domain and administrative interface, but without the overhead required by a knowledge worker.

In summary, the less visible benefits of Domino may be as important as the visible ones, and should be factored into the Domino versus Exchange decision. For maximum flexibility, and the ability to preserve choices in emerging architecture models, Domino is not only better but safer for your organization.
Messaging options for organizations using Exchange 5.5

If your organization runs Microsoft Exchange 5.5, as discussed in the previous chapter, now should be the time to carefully evaluate your messaging infrastructure. In this chapter we describe the following four messaging options available to current Microsoft Exchange customers, and the pros and cons of each one:

- Remain on Exchange 5.5 and NT
- Remain on Exchange 5.5 and upgrade to Windows 2000 without Active Directory
- Migrate to Exchange 2000 and Active Directory
- Migrate to Lotus Domino on a platform of your choice

This material is not intended to be a definitive guide to the nuances of migration and operation of the options included. Instead, our purpose is to demonstrate the requirements and to give the reader an objective overview of what may be required to either stay with or move off of Exchange 5.5.
2.1 Remain on Microsoft Exchange 5.5

So, why “fix” something that is not broken? At the time of this writing, Microsoft has indicated that they will provide standard support for Exchange 5.5 until December 31, 2003, and extended support until December 31, 2005 (which means that support calls between the product end of life and the extended support end date will be charged on a per-call basis and does not necessarily mean a code fix will be available).

The overall impression of not migrating to Exchange 2000 is that it will be less costly. This may be true in the short term, but in the long run there are certain consequences. The operating systems will move on, as will the messaging systems. Microsoft has already announced the end of support and extended support dates for Windows NT, along with the launch of Windows 2003 and Exchange 2003, which will provide better mobile and Outlook Web access, along with better back up tools. Unfortunately, it is not currently possible to migrate directly to Exchange 2003; the messaging and directory infrastructure must first migrate to Windows 2000 with Active Directory and Exchange 2000. The consequences have already grown, and when the time comes to migrate—and it will—the further behind you are, the less control of the direction and costs you will have.

**Pros for not migrating**

- There are no additional licensing costs.
- You do not have an immediate requirement to retrain your Messaging and NT Administrators.
- You can retain current applications and utilities, and no additional reprogramming for in-house written software or repurchase of 3rd party software is required.
- No need to experience the risks or delays of moving to Active Directory.

**Consequences of not migrating**

- Eventually you will be running unsupported software. For some organizations this can be a problem.
- Your messaging infrastructure will be based on NT architecture. If you choose to remain on NT, then hardware upgrades or even replacements may not have supported drivers, and new and more cost-effective, reliable, and scalable options will not be supported.
- Applications and utilities will eventually be out of support as well. This could have serious consequences since necessary updates (for example, virus protection updates) may no longer be available.
If you run on old software, eventually there will be fewer and fewer experts available, since they will have moved on. This may result in increased administration and training cost.

- Running on NT and Exchange 5.5 leaves you vulnerable to security breaches.

## 2.2 Upgrade to Windows 2000, remain on Exchange 5.5

Here we look at the option of migrating to Windows 2000 without Active Directory deployment. This would involve a level of risk, with little to no gain, since you would still be running Windows 2000 in an NT environment. An organization might decide to do this to be on a supported operating system, and to take advantage of the scalable file directory architecture, and the network and security enhancements Windows 2000 offers.

Many of the pros and cons for remaining on Exchange 5.5 would still exist. However, a project would need to be undertaken and the downtime incurred for the upgrades taken into consideration if this option is selected.

### Pros

- The operating system is up to date and supported.
- You can take advantage of the increased security options of Windows 2000 over NT 4.0.

### Cons

- Costs of upgrading.
- The extensive downtime for server migration.
- The possibility of hardware upgrades due to the increased resource requirements of Windows 2000.
- Increased operating systems licensing costs.
- You are still running Exchange 5.5, so you still have all the “cons” mentioned in the previous section, such as security problems and running unsupported software in the near future.
- The migration of Exchange 5.5 to Windows 2000 is a multi-step process. If not done correctly it can lead to many problems.
2.3 Migrate to Exchange 2000 and Active Directory

Here we examine the difficult road ahead for Exchange customers if they opt to migrate to Exchange 2000 and Active Directory. Then in the following section we show why an upgrade to Lotus Domino makes more sense and can be accomplished more easily than migrating to Exchange 2000.

Pros

▶ Supported platform
   With the advent of end of life for Exchange 5.5 and NT 4.0, migrating to Windows 2000 and Exchange 2000 will ensure you remain on a supported platform.
▶ Increased scalability
   Depending on the edition installed, Exchange 2000 is not constricted to the single information store that Exchange 5.5 was. It is now possible to have multiple storage groups and databases.
▶ Increased security
   Many of the flaws with NT and Exchange 5.5 have been addressed with Windows 2000 and Exchange 2000.
▶ Increased reliability
   Improved clustering over Exchange 5.5 in conjunction with multiple information stores means reduction in outages due to data recovery.
▶ Integrated directory
   Exchange 2000 is integrated into Windows 2000 and Active Directory, so they have a single enterprise service.
▶ No additional end user training
   The Outlook client reduces deployment, training, and support costs that would be associated with a client. Exchange 2000 supports all Outlook versions from 98 onwards.
▶ Improved Outlook Web access
   Exchange 2000 has improvements on the features and performance compared with Exchange 5.5.

Cons

▶ Security
   Exchange 2000 is heavily integrated with the Windows 2000 and Active Directory. Although many of the vulnerabilities with Exchange 5.5 have been addressed, many new ones have been opened.
In addition, remaining on Outlook as a client choice still leaves the end user vulnerable to virus attacks.

- This option requires a complex and time-consuming migration project.
- Exchange 2000 requires the Active Directory; thus it is a complex migration project, not a simple upgrade.

Microsoft Exchange 2000 shares very little in common with Exchange 5.5 and is a product built on top of Windows 2000 and Active Directory. Microsoft Exchange customers migrating their messaging infrastructures to Exchange 2000 face a difficult and time-consuming migration process. Depending on the methodology used, many of the required migration steps are one way, and no tools are provided to “roll back” if necessary. In fact, proper migration could be seen as extremely difficult due to the interdependence of Exchange with the operating system and directory of Windows 2000.

- Multi-step migration process

There are a number of ways to migrate to Exchange 2000. An *in-place* migration follows many of the same steps as running Exchange 5.5 on Windows 2000. Other than additional planning for the deployment of Active Directory and the upgrade/migration of Exchange 2000, you need to deploy Active Directory before deploying Exchange 2000. Incorrect planning of the Windows 2000 and Active Directory deployment can lead to problems when deploying Exchange 2000.

- New skills are required, so retraining of messaging administrators is needed.
- Selecting the correct server to migrate first can lead to increased hardware requirements.
- Upgrading an existing Exchange 5.5 environment means additional planning and more downtime.
- Incorrect preparation of Windows 2000 means, you need to do it again.

Exchange 2000 can only be installed on Windows 2000 servers which meet specific criteria, meaning IIS and NNTP must be fully installed. You must architect Active Directory properly and have it up and running, and the server must already be part of a Windows 2000 domain.

- Additional hardware may be required.
- When you install your first Exchange 2000 server you must ensure the organization is in mixed mode. Like Windows 2000, which needs a mixed mode to support Windows NT, Exchange 2000 has a similar switch to coexist with Exchange 5.5. Once you go to “native” there is no going back and native coexistence with Exchange 5.5 systems will no longer be possible.

- Active Directory Connector needs to be installed before the migration.
In-place upgrading of Exchange 2000 has risks and results in more downtime. Changing the operating system and migrating the Exchange server on a single server box holds significant risk. If you plan to migrate your existing Exchange 5.5 servers to Exchange 2000, your migration options are very limited. All data in the Exchange message store must be modified during migration. So, rather than convert the data during installation, Exchange 2000 will run a background conversion process once it is started. If a user attempts to access their mailbox before it has been converted, the server will be forced to convert the user’s mailbox on-the-fly.

“Greenfield” / parallel migration means more hardware

An alternative method of migration, recommended by Microsoft’s own documentation as well as industry publications, is to deploy a parallel Windows 2000/Exchange 2000 infrastructure (often referred to as “Greenfield”). This method of migration requires significant additional hardware resources and migration steps.

Additional coexistence and Directory planning is required. However, in this setup, user mailboxes are migrated in a one-at-a-time sequence, rather than converted as part of the software installation, thus reducing risk but increasing costs.

Converting to “native mode” will lock out future native coexistence with other Exchange 5.5 sites

The last step of an Exchange 2000 migration is to enable “native mode.” A native mode Exchange 2000 environment has additional capabilities over a mixed Exchange 5.5/Exchange 2000 network. Unfortunately, once you go to native mode there is no going back. Once an Exchange 2000 environment is in native mode, it can no longer interchange with Exchange 5.5 servers natively. In an instance where a company either merges with another or a division operates independently and wishes to interoperate with another company/division that is on Exchange 5.5, they will not be able to coexist as one Exchange network. Although message transfer can be enabled using SMTP, there would be no real security between the two separate mail systems, and functions such as calendaring/scheduling and public folder distribution would not be possible.

The uncertain future

We have already discussed the option of not changing your messaging system. But if you do take a “wait and see” approach, or even if you choose to migrate to Exchange 2000, Windows 2000 and Active Directory, what does the future hold? Microsoft has already acknowledged some of the limitations of Windows 2000 and Active Directory and the next release, Windows 2003 is set to address many concerns and issues with Active Directory, including group size limitations, group replication, and global catalog latency. Since Exchange 2000 is built upon
Windows 2000 and Active Directory, customers will be forced through yet another Windows and Exchange upgrade sometime in the near future. End of life for Exchange 2000 is already set at December 31, 2005, and a direct move from Exchange 5.5 to 2003 is not currently possible—a move to 2000 is required first.

The 2002 version of Outlook is required to access many parts of Exchange 2000. Customers planning an Exchange 2000 migration must factor in the cost of also upgrading their desktops, since many may still be on Outlook 98, and many of those features have been removed from Exchange 2003.

In summary, Exchange customers choosing to migrate to Exchange 2000 have a risky, long and complex project, at the end of which the return on investment could be seen as minimal on the whole since they still only have a messaging system.

### 2.4 Migrate to Domino 6

Upgrading to Exchange 2000 requires a significant effort, and may not provide all the capabilities you need, especially collaborative features. Migrating to Lotus Domino is easier than an Exchange upgrade. In addition, Domino delivers superb collaborative applications. Exchange customers evaluating their messaging infrastructure decision and considering an upgrade or other options should seriously consider migrating to Lotus Domino 6. Domino 6 not only has a lower TCO than Exchange 2000, it provides a simpler upgrade path within the customer's existing computing environment, with a gradual, manageable process of infrastructure and data conversion.

**Pros**

Upgrading the operating system to Windows 2000 and Active Directory is not necessary. Lotus Domino runs on any Windows 2000 server, as well as Windows NT, Windows 98, Windows 95, Linux, Sun Solaris, IBM iSeries, IBM AIX®, IBM zSeries, IBM OS/2®, and HP/UX. Domino does not dictate operating system configuration—it simply runs within your environment. So if customers do decide to deploy Windows 2000 and Active Directory, they can comfortably utilize Domino in that environment without the overhead of keeping the operating system in sync with the applications running on it.

Domino 6 also has additional tools to reduce the administration overhead on Windows often perceived with having to manage both an operating systems infrastructure directory and separate messaging directory.

Migration or retraining for end-users is not required. Organizations can choose when, if, and how to support any one of the clients available in the Domino environment. Domino is the most open collaborative server available today, and
supports a range of clients including Notes, Web browsers, POP, IMAP, Microsoft Outlook, and Windows networking users.

Migration does not mean a messaging downtime. The process of converting Exchange mailboxes to Domino is done on one or more administrative workstations, not loaded on the server, and the migration process itself is non-destructive.

There is no requirement to change the operating system. Lotus Domino provides key architectural services independent of any operating system. As a result, Domino servers can be moved across various operating platforms without any reconfiguration or change to the underlying infrastructure.

**Cons**

The Exchange administrators would need training on Domino administration. Domino administration is entirely different from Exchange; however, as already mentioned, many new features in Domino 6 have been implemented to simplify the messaging administration.

End user training may be needed as well. The full Notes client, although now very intuitive, includes many additional features that Outlook does not have, and these new features can be a bit overwhelming at first. Furthermore, the operation of some comparable features is different.

Some applications and some third-party software specific to Exchange may have to be repurchased and deployed or developed again in Domino.
Planning for the migration

In this part we introduce/provide/describe/discuss...
Migration project overview

This chapter was written to help project managers and IT architects develop an overall migration project plan. It covers some standard project management topics, as well as very specific information on what will be needed to get the project running.

Since no two migration projects are alike, we strongly recommend that the information in this book be used as input for the project, not as the final word on how the project should be run.

We discuss several project scenarios and high level considerations for the project plan. We also address migration as well as a possible coexistence scenarios.

The steps and activities described in this chapter, along with the detailed guidelines and technical examples for migration and coexistence provided in later chapters, will assist the project team in migrating from the Microsoft Exchange 5.5 environment to Domino 6. Additional reference material to help with a migration project is identified in Appendix D, “Additional material” on page 465.
Attention: This chapter is not meant to be a complete project management handbook, even for a migration project. Every organization, environment, and project is different, and expert project management skills are needed to manage the project successfully. The goal of this chapter is to increase your awareness of the topics you should consider and act on when planning and implementing the project.

For information about project management, refer to the Project Management Institute Web site at:

http://www.pmi.org

3.1 The key steps in a coexistence/migration project

The following high-level steps are the keys to successfully planning and implementing a migration project:

- Have a project sponsor that is involved in the project
- Define the project vision
- Assemble the right project team
- Develop and maintain the project schedule
- Project scope management
- Document business requirements
- The communication plan
- Set project expectations
- Document the current Microsoft Exchange messaging environment
- Develop the training plan
- Plan, design, and document the new Domino and Notes environment
- Risk analysis
- Pilot the new environment
- Develop a coexistence and migration strategy
- Pilot the coexistence and migration strategy
- Implement the coexistence and migration strategy
- Final phase - project closure

An overview of each step follows; thorough discussion of these topics is in later chapters.
**Project sponsor involvement**
The importance of high-level sponsorship must be strongly emphasized for a project such as migration.

**Project vision**
The project vision is a high-level, unbound view of the future.

**Assemble the right project team**
Putting together the right project team is a critical factor in ensuring a successful migration. This type of project requires a group with the right technical and management skills to ensure an accurate, high-quality design and a realistic, manageable project schedule.

**Develop and maintain the schedule**
There is a lot at stake in any coexistence and migration project. Things must occur in a certain order, within a set time frame, to ensure a successful migration. Therefore, realistic, achievable schedules must be established for the project.

**Project scope management**
The project scope defines the boundaries of the migration project. The scope statement should enumerate the functionalities of the new environment.

**Document the business requirements**
The first task the migration project team must tackle is fully documenting the business requirements and the scope of the migration. This exercise involves expanding on the requirements laid out in the messaging evaluation study and detailing any additional requirements. The result of this step is a set of clearly defined, realistic goals for the project.

**The communication plan**
The objective of a communication plan is to educate, inform, energize, and engage all parties of a project. Without adequate communication throughout the migration project, you run the risk of creating an excellent plan that never has the opportunity to be implemented. Developing a communications plan can be regarded as a internal marketing campaign, and will help keeping the amount of “FUD” (fear, uncertainty, and doubt) to a minimum.

**Set project expectations**
Setting expectations requires open, honest communication throughout the life of the project. From the top on down, all people involved need to have a realistic picture of what they will receive and when they can reasonably expect to receive it. Everyone should understand the project and the progress being made on it. Unrealistic expectations and perceptions can be deadly, causing a successful
project to be perceived as a failure. You can avoid this by keeping everyone's expectations in sync.

**Document the current Exchange messaging environment**

This phase of the project involves gathering specific and detailed information about:

- The infrastructure
- e-mail metrics
- Applications
- Services

This information defines the current messaging environment. It includes such things as the network topology and the current naming scheme.

Additional documents to help you with this step of your migration project are available through the redbook Web site. See Appendix D, “Additional material” on page 465 for details.

**Note**: Being very thorough here avoids unpleasant problems later, as “forgotten” or neglected functionality may escalate to be a showstopper.

**Develop the training plan**

New skills might be required for the new messaging system. Training everyone involved with and affected by this project will be a key factor in its success. In addition to the technical training necessary to enable IT staff to design, test, deploy, and support the new environment, all those who will use the new system should be trained on its features, functions, and any new or migrated applications.

Training should be an ongoing activity throughout the course of the project. Communicating the reasons for the migration can be a part of the training, and developing the training plan can actually begin concurrently with the documentation of the current environment. The plan can then be updated during subsequent steps.

**Plan, design, and document the Domino environment**

In this step, the project team designs the new environment, one which reflects the company's strategic infrastructure plans, meets current needs, and provides opportunities for future enhancements. The team must design a well researched and carefully conceived messaging infrastructure, to support not only end user's e-mail needs, but a variety of other messaging applications.
The activities in this step of the project include:

- Planning the new environment
- Designing the new environment
- Documenting the new environment

**Develop a coexistence and migration strategy**

The coexistence and migration strategies are the plans that define how to join the old and new messaging systems, and describe the steps in which users stop using the old system and begin using the new system. These strategies are dependent on:

- Business requirements and the scope of migration
- Setup of the old system or systems
- The design and implementation of the new Domino and Notes environment

**Implement the coexistence and migration strategy**

At this point the design of the new environment has been validated, as well as the coexistence and migration strategies for the company. Now the actual migration of users to the new environment can take place. Key activities in this step are:

- Training
- Publishing the migration schedule
- Announcing the kickoff of the migration
- Starting the coexistence/migration

**Close the project**

When the migration is done, there are still a few tasks necessary to close out the project. They are discussed in a later section.

### 3.2 The sponsor

High-level sponsorship is crucial to a large-scale project like messaging migration.

In addition to making major changes to the IT infrastructure, the migration project can affect the way the company does business, as well as causing cultural changes within the company. The cultural changes can be very difficult to "sell" to the users, and even more so to a company being migrated into another. For that reason, the sponsors must come from high enough in the organization to have the power to drive and effect those cultural changes.

The sponsor should preferably be of executive level, have a clear and complete understanding of the business reasons for the project, and be committed to the vision.
The sponsor's full understanding of the business reasons helps both the sponsor and the project team to provide clear and precise communication about the project and its goals. This enables the sponsor to emphasize the importance of this project and help ensure the project team gets the cooperation they need from all areas of the company. It is recommended that the project sponsor work with the project manager to hold an initial kickoff meeting for company management.

The goal of the kickoff meeting is to gain the needed management cooperation to build the project team and the advisory panel. Further into the process, having the project sponsor acknowledge the work of the test users and participants in the pilot will foster a positive attitude about the migration throughout the company.

3.3 The project vision

The "project vision" is a high-level, unbound view of the future messaging and collaboration system that is to be created by migrating to Notes and Domino 6. The project vision should be aligned with the overall business vision of the company. Such a vision helps to establish both long-term goals and short-term objectives to ensure the success of the migration project.

Example of a vision statement:

*The vision of the migration project is to replace our multiple existing divisional-based messaging systems with an enterprise-wide messaging and collaboration system that uses Lotus Notes and Domino. This upgrade will enable all our business units to interoperate seamlessly while adding user functionality and reducing administrative and operational costs. The new system will be deployed in each of the company's locations and for all employees worldwide. Deployment will commence within 3 month, and will be complete within 9 month.*

3.4 The project team

Assembling the right project team is the key factor in ensuring a successful migration project. It is mandatory to assemble a group with the right technical and management skills to ensure an accurate high-quality design and a realistic, manageable project schedule.

The team will most likely consist of employees from your company along with subject matter experts and consultants from IBM or its business partners. While
the subject matter experts may participate for only limited periods of time, it will be crucial to know whom to call and when to call them in.

The team may consist of one or more persons in each of the following roles (and multiple roles may be filled by a single individual):

- Project manager
- Sponsor (does not have to be a member of the team, but needs to be kept informed regularly)
- Domino architect
- Exchange administrator
- Domino administrator
- Domino application developer
- Network administrator
- IT/IS manager
- Migration specialist
- Support team representative
- Specialists (these individuals may be on call)
- Users from key interest groups

Some training may be required for members of the project team, or for those designated as part of the initial support team. Allow sufficient time for this training at the beginning of the project.

Experienced users from the organizations being affected by the change should be involved. They can help communicate the progress of the project and assist with choosing appropriate test users. They could also provide early feedback on plans and schedules, as well as ensuring any requirements unique to their areas are accounted for in the design of the new environment.

Special care should be taken on handling the Exchange administrators and others who have been involved in the administration of the Exchange environment. Those people will most likely be the first and most powerful resisters to be encountered. However, since they have precise knowledge of how the old messaging infrastructure works, the Exchange administrators can be great advocates for the upcoming migration if they are handled right. This involves a lot of communication, retraining, and assuring them that they will not be obsolete after the migration.

Getting access to the right personnel for the project team and the panel will require buy-in on the project from all levels of management.
3.5 The schedule

A realistic, achievable schedule must be created for the project. This schedule should not only consist of a target date for completing the project, but should identify important milestones, deadlines, and the resources needed along the way.

To help you explain the basis of the established schedule to a sponsor or management team, be certain to:

- Educate management on the steps involved in this type of a project
- Explain the processes involved
- Lay out a reasonable, achievable high-level timeline
- Explain the risks involved in delays in any of the steps or processes

The goal is to gain acceptance from the project sponsor for a realistic, achievable timeline.

3.6 The scope

The project scope sets the boundaries for the migration project. The scope statement should define the functionalities of the new environment that you can implement within the time given and the resources allocated. The scope should differentiate between what the migration must have and what is non-essential.

Example of a migration project scope:

When migration is completed, our new system will:

- Provide a functional implementation for 5000 users and accommodate 8% expected yearly growth over the next 5 years
- Replace the existing messaging systems: Microsoft Exchange and POP mail servers
- Coexist with the Exchange system until migration is complete
- Be a highly available system that fulfills the requirements specified by the SLA of the company
- Take advantage of the collaboration features presented in Domino

3.7 Documenting the business requirements

There are many reasons why a company might want to improve and expand their messaging infrastructure. Among these motivations are changes in corporate
structure brought about by a merger or acquisition, changes in the company’s business model, or the constant shifts in focus necessary to keep up in today’s fast-paced business environment. The need to deal quickly with change, and to communicate efficiently with employees, customers, and business partners can also be motivating factors.

The use of a messaging infrastructure need not be confined to just sending and receiving simple messages and attachments. It can be a whole collaborative environment supporting e-mail, instant messaging, group discussions, team workspaces, corporate intranets, quick publishing to the Internet, and custom applications—all within a reliable, scalable, secure, integrated framework that is manageable and cost-efficient.

Documenting the business reasons for the migration project and the business uses of the new functionality that will be provided is one of the first tasks the migration project team must undertake. The project sponsor and the project manager must communicate the reasons and goals of the migration project to the project team. The project team must then communicate the reasons, goals and other project information to the end-user community. Open communication will facilitate cooperation and help ensure success.

### 3.7.1 The basic requirements

Many of the basic requirements for migration may have already been presented at a high level in the migration study. The team must now expand on those requirements and detail specifics on each, to ensure they are incorporated into the design of the new messaging environment.

The basic requirements include such things as:

- Additional client functionality.
- Greater messaging server scalability, reliability, and manageability.
- Lower total cost of ownership (TCO). This refers to the company’s cost to run, support, and administer the new messaging environment. It does not refer to the costs associated with migrating from the old environment to the new environment.
- Improved interoperability with Internet standards.
- Improved throughput.

What is expected in each of these areas by the corporation should be detailed in the requirements. For example, the project sponsor might expect a specific delivery time for a simple mail message. The project team must ensure this is stated, and that the designers of the new infrastructure specify the right network topology and systems to meet that goal. Additionally, if the sponsor has a requirement that is unrealistic, this is the time to modify the expectation to be within the boundaries of what is possible or feasible.
3.7.2 Further requirements

After dealing with general requirements, the team must address the detailed requirements in the areas of:

- Features, functions, and applications that are part of the current environment
- Features, functions, and applications that the corporation wishes to add based on the capabilities of the new environment

The functionality of the current environment

Documenting the requirements for migrating existing functionality should be a very straightforward task. The key is to cover all the functionality. Users are more likely to be upset by being unable to do something they were used to, rather than about learning a new function.

Each existing feature, function, and application should be documented. This list should then be used by the designers to ensure that each item is built into the new environment. This list can also be input to the training plan, to ensure users know how to perform tasks in the new environment.

The functionality of the new environment

Documenting new features, functions, and applications that can be added to the messaging infrastructure is more complicated.

In the areas of features and functions, the project team needs to document those that are new, and ensure their usefulness is effectively communicated to the end users. This communication can take place through end-user training and through internal marketing, such as quick reference guides.

Promoting new applications is more involved. The job of the migration team may be to build a “wish list” of the applications that various individuals and groups would like to see incorporated into the new environment. The specific applications should be identified as “must have,” “should have,” or “nice to have,” and be evaluated against the implementation cost. The project migration team then details the requirements for each of these applications, reviews the requested priority, obtains approval (or modification of the priority), schedules the development work, and adds this work to the scope of the migration project.

Review, prioritization, project approval, and funding should be done by the management group.

Depending on the number and complexity of these applications, separate workgroups may need to be established to complete these applications within the timeline of the migration project. It may be the case that only one or two key applications are considered important enough to be part of the overall migration project, and the remaining applications could be placed outside the scope of the project.
migration project, to be handled separately at a later time, or selected to be discontinued.

At this point it is necessary to realign the expectations. After studying the current environment and making plans for what functionality will be available in the new environment initially, at a later stage, or not at all, the revised expectations should be communicated to the sponsors and the user community.

3.8 The communication plan

The objective of a communication plan is to educate, inform, energize, and engage all parties of the project. Without adequate communication throughout the planning process, you run the risk of creating a fabulous plan that never has the opportunity to be implemented. The communication should begin at the beginning—at the point where you assemble your project team and begin the planning process.

To create your communication plan:

► Identify who to inform about the project (key individuals, decision makers, and strategic groups).

► Decide who is responsible for reaching each person or group.

► Determine when, what, and how communication will take place. That is, try to identify each communication step.

► Identify the communication vehicles you have available and any communication vehicles you may want to create.

► Pay attention to any feedback you receive.

Reach everyone who will play a role in implementing the project. If you identify additional players part of the way through the planning process, don't hesitate to include them in your communication from that point forward, being sure to catch them up and include them on the process.

Some of the topics you should consider communication about:

► Migration project in general
► Goals set for the project
► Implementation schedule
► Pilot project
► New environment
► Where and how the education is available
► How to contact support
► Progress of the project
3.9 Setting the expectations

Setting the correct expectations is crucial to the success of a migration project. If the expectations aren’t set correctly, you run the risk of having very low customer satisfaction from the end users.

Just because one migration approach worked in one environment does not mean that it will be successful in another. By assuming that a new migration project is identical to a previous one, there is a danger that significant differences in stakeholder expectations and requirements will be ignored or actively suppressed. Project outcomes must support the specific structures, processes, people, and existing systems in a particular organization, not some generic version.

One of the most powerful strategies for keeping a project on track is to set the stage properly. This means more than distributing the project plan. Complement the plan by stating the project vision and goals. Describe the final result and how the project team will conduct itself to get to that result.

It is important to set the expectations early in your project management activities. Incorporate these concepts in kickoff meetings and initial meetings with specific project teams.

Examples of expectations set for the migration:
- All mail present on servers will be migrated.
- Mail will not be coexisted.
- Calendar and scheduling information be migrated.
- Calendar and scheduling information will not be coexisted.
- Users will be trained within one week prior to being migrated.

Examples of expectations set for the new environment
- Delivery of messages internally: 90% < 5 sec, 5% < 20sec.
- Open mailbox view: 90% < 5 sec, 8% < 20 sec.
- Send file and store: 90% < 5 sec, 8% < 15 sec.
(Sums not equal to 100%; remainders are for special exceptions.)

3.10 Documenting the current messaging environment

This section was designed to help you gather and document specific, detailed information about the current Microsoft Exchange system. This is the foundation
which will help the project team to build a complete and accurate design for the new Domino environment, if one is not already in place.

A checklist to assist you in documenting your current messaging environment is in Appendix A, “Exchange Connector installation checklist” on page 449. Additional documents that might help you with your migration project are available through the Redbooks Web site. See Appendix D, “Additional material” on page 465 for details.

In this section we describe the steps for documenting the following:

- Microsoft Exchange environment
- IT profiles
- Administration support
- Risk assessment

### 3.10.1 Documenting the Microsoft Exchange environment

Whether you have a small, medium, or large Microsoft Exchange environment, it is important that you gather all the data recommended here. Having all this information will ensure nothing is missed in the design of the new Domino environment. Many of the details may already be documented, so this phase of the project may be just verifying the existing information.

**Microsoft Exchange server topology**

To document the Microsoft Exchange server topology, you need to know:

- The version/SP level of Exchange Software being used.
  
  If different versions are being used, then state why. There might be a very specific reason that a newer or older version/SP is used.

- The operating system/version/SP level the Exchange servers are running on.
  
  If different versions are being used, then state why. There might be a very specific reason that a newer or older version is used.

- The current Exchange topology.
  
  Is this a Single site/Single server, Single site/Multi server, or even a Multi site/Multi server environment? This information can affect other decisions (for example, server consolidation).

- The organization’s name (assuming a single organization).

- In case of multiple sites, the site names.

- Connections to other internal/external mail systems. (If there are none, go on to documenting the Microsoft client topology.)
– What Mail Transfer Agents (MTAs) and connectors are in use?
  In a multi-site environment, it is expected that site-to-site connectors will be in place. The connectors/MTAs we are addressing here could be CCMail, MSMail, SNADS (if so, state what system), Internet, X.400, Lotus Notes, Exchange 5.5 to Active Directory, Novell Groupwise, and others.

– Are calendaring and scheduling services/connectors provided across the connections?
  If this is the case, state what connections are being used for this functionality.

– With regard to multiple sites, is “free busyness” replicated across the connections?
  If this is the case, state between what sites.

– Are there any directory services provided over the connections?
  If there are, you will need to know what type (LDAP, Native Dirsync, Gateway, or third party), and finally, if the import/export process is automated or manual.

▷ List the server names, and determine which server is the first Exchange server.
  What is the server name; is it a bridgehead server; is it a Public folder server; where is it located (organization and site); and how many users are on this server?

**Microsoft Exchange client topology**
To document the Microsoft Exchange client topology we will need to know:

▷ What clients are being used and how many?
  Pre-Outlook (5.0 Clients), Outlook98 (for Windows, Macintosh or Web access), Outlook 2000, Outlook 2002, Other IMAP4 Client, POP3 client, or other? Can they use POP3 from any client?

▷ Are there mobile users?
  – List types and amounts of mobile devices.
  – How is access to mobile users provided (RAS, Wireless, Web, PDA, or other)?
  – Detail the functionality used with the mobile devices.

  Be detailed; loosing functionality will act as a showstopper to the mobile workers.

▷ List of users per locations (include mobile).
- Are personal storage (PSTs) and personal address books (PABs) being used, and if so, where is the user data stored?
  
  If PST files are being used, can this affect the use of Migration tool and the Migration strategy? How about mobile users and the OST file?
- Are mail rules used?
- Is voting used?
- Are there distribution lists?
- Who is allowed to create folders?

**Existing Exchange services**

Services, such as those in the following list, are also key elements of the messaging infrastructure and must not be overlooked when planning a migration. Be sure to document how each of these services is used in the existing environment and whether that use will change in the new environment.

- **Calendar and Scheduling:**
  - Is Calendar and Scheduling functionality used? If so, to what extent?
  - Are mailboxes assigned? If being used, is the management function for resources and conference rooms being used?
  - Are users scheduling meetings across the enterprise?
  - Are corporate holidays being maintained?
  - Is it general practice to look up free time prior to scheduling meetings?
  - Are there any applications based on the Calendar APIs?
    
    These might be plug-ins, third-party software, or in-house developed software. Maintaining this kind of functionality might involve the developers, or require a separate project.

- **e-Mail**
  - How many registered/active/concurrent users are there in Exchange?
  - How many peak time users are there? (Peak time, for example, during the beginning of a business day)?
    
    If possible, try to obtain statistics that show the peak number of users on an hourly basis for a full month. There might be very big variations in different companies. This information will be used for the design of the new infrastructure.
  - How many mail items, on average, are sent per day (average per user)?
    
    If there are variances in how the users act on different sites, then state this as well.
– What is the average size of a typical e-Mail?
  Are there “heavy” sites or user groups that needs special handling?
– What is the average size of the users’ mailboxes (PSTs)?
– Is mail quota being used? (If yes, state the limit.)
– Do users send attachments through the mail?
  If they do, are there any restrictions, and how are those restrictions handled? Are there restriction in size, file types, where they are being sent (intrasite, site-to-site, external)?
– Are there any procedures/applications using the mail APIs?
  These might be plug-ins, third-party software, or in-house developed software. Maintaining this kind functionality might involve the developers or other separate handling.
– Is message tracking being used?

► User Directory
– What type of information fields are kept in the Exchange Directory?
– How many documents are stored (per user; in total)?
– Where are forms stored?
  Are forms stored on the server (Organizational), in the user’s inbox (Personal) or in public folders (Folder)?

► Public folders
– Are public folders being used?
  If so, collect details on the folder names, describe the usage, access restrictions, number of entries, and so forth.
– Are there custom forms?
  If custom forms are being used, make sure to collect the details on usage, size, interaction with Exchange and with other applications (for example, embedded OLE).
– Is Outlook Web Access used for Web access?

► Applications
– Are Event Services used?
  Event Services are scripts running against items posted in a public folder.
  If Event Services are used, collect details on purpose, usage, the script itself.
– Are there any third-party or in-house applications that interact with Exchange?
Exchange Security (key management?)
- Is the Key management system being used?
  If yes, is Signing or Sealing (encryption) used? Encrypted documents cannot be migrated since the keys cannot be migrated. Therefore, it is crucial to know if this function is being used, and users should be informed about this. A solution is to decrypt the documents before migration.
- Is there any other form of e-Mail or Web security?

Other services:
- Is any form of instant messaging being used?
  If yes, what type (MSN Messenger, IRC, Sametime®, AIM (AOL), Yahoo or other)?
- Is there an e-Mail enabled fax solution?
  List the details of any e-Mail fax solution used: Send fax only, Receive only, Send/Receive, how faxes are stored (personal/public folders).
- Is any externally hosted e-Mail service being used?
  This might be Hotmail, AOL or other provider. Be aware of a potential security risk, mail sent/received through those channels may not be secure, on backup or accessible for later use.
- Are there other applications running on the Exchange Servers? If yes, list the applications and the servers those applications are available on.
- Is antivirus software being used? If yes, gather details on the antivirus software and where it runs (on server, on client, on firewall, or other).
- Is backup software being used? If yes, gather detail on the backup software and where it runs (on server and/or on client). Record the backup schedule for incremental and full backups.
- Is there a automated mechanism for software distribution (Tivoli®, SMS)

3.10.2 Documenting the hardware profile

This section describes the information you should gather about the physical characteristics of the environment. Check the Lotus Web site at http://www.lotus.com for the latest recommended specifications for servers and workstations running Domino and Notes.

Specifications of the servers in use:
Identify CPU, memory, storage (storage system) and function (which kind of server is this, does it have a special/dedicated function such as SAN, and so forth).
Specifications of the workstations in use:
Catalog the CPU, memory, available disk space, and operating system (Win95, Win98, NT, W2K, XP, Mac/OS or other) of all workstations. If any workstation has a special function, identify it.

3.10.3 Documenting the network infrastructure
You need to have a complete description of the network and an overview of the actual network configuration. This should include:

- Central/distributed location with number of users
- Type of communication lines mainly used (X.25, ISDN, Ethernet, Token ring and so forth)
- Type of connections (Leased lines, switched lines, and so forth)
- Bandwith of the lines
- Are lines shared with other functionality (phone or other)
- LAN configurations
- Available network protocols (SNA, TCP/IP, NetBIOS, IPX/SPX, or other)
- Connection to a public network provider (Internet)
- Routers
- DNS host files
- Firewalls and their open ports
- Quality of service supported
- Other essential functionality
- What are the most common types of information that the WAN transmits: text, data, images, graphics, voice, video, phone, or other? Are there future plans for the network that might need to get incorporated?
- Are there identifiable bottlenecks in the network? What are the problem areas and has a resolution been planned?

3.10.4 Administration and support infrastructure
You will need to know how the administration and support infrastructure is built. It is essential to make sure that, as a minimum, you keep the service on the level it is. If no SLAs are in place, those might be considered as well.
Support

- Has support been outsourced and, if so, can the new environment be supported?
- How many people are involved for user support in general:
  - Are they placed centrally or distributed?
  - Where are they placed?
  - How many are specifically involved in messaging service for:
    - Administration?
    - Training support?
    - Help desk?
    - Project implementation?
- Detail any specific applications for managing user requests and questions.
- Detail any specific training guide/program for Exchange users.
- What kind of education is provided to new users, and does this include e-mail usage training?
- Are there any automated archive policies or applications; if yes, list the details.
- What backup/restore and disaster recovery policies are in place?

Service delivery

- Are there Service Level Agreements (SLAs), and if so, what values do they specify for the following categories?
  - Message delivery internal
  - Directory latency
  - Message delivery external (only to Relay or IMS™)
  - Server response time
  - Network response time
  - Web page delivery
  - Max outage
  - Notice of outage
  - List any details on SLAs with ISP
- Are there specific rules to inform users about system management and reported downtime?
- Are there any statistics available for mail flow, network performance and downtime?
Administration procedures
You need to know if any of the following procedures are created and distributed to the users:

- Is there a Retention Management system in place for deciding how long you maintain your electronic documents, and what the users’ responsibilities are for each kind of document. This includes Archive and Backup.
- Is there a user guide with details about security, delegation, access authorization for messaging and office services (how to manage passwords, departmental user IDs for special needs, and so forth)?
- Are there standard definitions of specific structured forms for mail (that is, format for external letters, fax forms, internal communications, and so forth)?
- Is there a naming policy?
- Is there a procedure for users to request new or additional user IDs, resources, password changes, and so forth?

3.11 Developing the training plan

Training everyone who will be affected by the coexistence and migration project is essential. You need to ensure that the right people get the necessary technical training to enable them to design, test, deploy, and support the new environment. In addition, adequate training must be given to all end users who are going to use the new system.

Training will be an ongoing activity throughout the course of the project. Creating the training plan can actually begin concurrently with the documentation of the current environment. The plan can then be updated during subsequent steps of the project.

Depending on the size and scope of your project, you may want to dedicate one or more project team members to training to ensure it receives appropriate attention and focus.

Training requirements
Define your training requirements by answering the following questions:

- Who needs training?
- What features and functions must be presented?
- What applications must be presented?
- What services must be presented (fax, Internet, connections to other environments)?
Delivery of the training

Here are some questions related to the delivery of the training:

- Can standard courses be used or will customization be needed?
- What method of delivery is best for each type of training or group to be trained?
- Should training be held on-site or off-site?
- Should classes be private or public?
- At what point in the project does each type of training need to be delivered?

Who needs training?

Everyone affected by the migration project is going to require some type of training. The training may simply be a review of how to use the new Lotus Notes client or it may be in-depth technical training enabling someone to support and maintain the new Lotus Domino environment.

Here we have identified some of the parties whose training requirements you must address:

- Executives with a special training needs (time restraints, PDAs. and so forth).
- System administrators
- Application developers
- Help desk personnel (if applicable)
- Test and pilot users
- Standard end users

Evaluating and reevaluating the training plan

After the first users have completed a particular part of training, the project team members responsible for training should review the users’ evaluations. If users feel that the training is inadequate, or some parts of it require more attention, these issues should be addressed immediately and the training revised as necessary.

After the users have had the opportunity to apply their training in a “live” environment, they should be asked to do a second evaluation to gauge the effectiveness of the training and the relevance of the material covered. These reevaluations should be reviewed and any necessary changes made to the training.
Training resources

- http://www.lotus.com/education
  The Lotus site is a comprehensive education source that includes links to a variety of training locations, descriptions of selected courses, and many other materials.

- http://www.recor.com/
  This site has a full suite of learning product for Domino/Notes 6. Some of the Recor products will be able to integrate with the ADT tool for deployment.

3.12 Risk

The risk in not performing the activities described in this chapter is that key features of the existing environment will not be included in the planning and design of the new environment. It is much simpler to design all the features in at the beginning than it is to try to retrofit a feature after deployment of the system has begun. The latter will negatively impact the project schedule and the users’ perceptions of the viability of the new messaging environment.

The current environment has a dramatic impact on both the coexistence and migration strategies. The information collected during this phase is invaluable in designing the strategies. Also, this process highlights potential problems with the current environments that must be addressed before a successful migration to Notes and Domino can take place.

Risk management

Risk is a natural part of any system integration project, and its proper management can determine the success or failure of the project. You should begin risk management during the proposal process by identifying the foreseeable risks in the project and developing an associated Risk Management Plan, which quantifies the risk and includes your recommendations for handling it.

Here are some actions you can choose to take to deal with a certain risk:

- Avoidance: Eliminates the cause of the risk through clearly-defined actions/events/tasks.
- Mitigation: Acknowledges that the risk is not avoidable, but defines steps to mitigate the level of risk.
- Acceptance: Acknowledges the risk and documents the associated consequences.

If new or different risks are identified during the implementation of the project, they should be added to your risk management plan. The project manager...
utilizes this plan as an instrument to verify the progress against avoidance or mitigation plans, with the focus being to reduce the overall risk of the initiative.

### 3.13 Plan, design, and document the new environment

One of the prerequisites for a solid, scalable, and easily maintainable infrastructure is good design. Building a good design is strongly based on knowledge and experience. If you don’t have architects with strong Domino skills, it might be a good idea to have IBM or a business partner help you validate the new design.

Now that the project team knows what is needed, they must determine how to deliver it. This means establishing the design of the new Lotus Notes and Domino environment. The amount of effort spent on planning and designing directly correlates to the success of the implementation.

During the design process, frequent review sessions should be scheduled to keep the project team up-to-date and provide feedback on the developing design. At the completion of the design work, a final review should be held and sign-off on the design received from all project team members and the project sponsor.

Many of the key areas which must be considered when designing the new environment are discussed in the following sections.

#### 3.13.1 Determining the characteristics of the servers needed

Traditionally, the number one comparison made between different platforms has been performance. Competition among vendors can make it difficult to find objective comparisons. Manufacturers like to show the results of tests that make them look the best, but their data may not be relevant to the way you plan to use the platform.

**Is bigger better?**

One common stumbling block when choosing a platform is the bigger-is-better attitude. People so often get caught up in getting the biggest, fastest box, that they lose sight of what they need. If your organization will only consist of 100 mail users, and is unlikely to grow significantly, you probably do not need one of the large platforms. It will support growth for a long time, but the startup costs would be great.

However, maybe you have a large, powerful server which is under-utilized, and you also have lots of in-house expertise in that server platform. You may wish to add the Domino server to that machine rather than buying a new server and
training your staff in a new operating system. In this case, your 100 mail users may not take much of that particular server’s resources.

**Few versus many**

If you choose a smaller platform you will need to maintain many smaller machines. This is not necessarily a bad thing, but it can mean more effort is required to maintain control and consistency across a group of many machines.

However, another factor to consider is that with a larger number of smaller servers the overall impact is reduced if any one server goes down. With the larger platforms, more attention needs to be paid to planning with regard to the impact of a server being down.

**Number of Domino servers**

The other major consideration when talking about performance and scalability is the number of actual Domino servers. One of the main advantages of using the larger platforms is that it reduces the number of physical machines to manage.

However, you should bear in mind that this does not necessarily reduce the number of logical Domino servers. On the smaller platforms, such as NT, you would typically have one logical Domino server per physical machine.

On the large platforms, such as pSeries, iSeries, and zSeries, you would typically run one physical machine with several logical Domino servers on that machine, using Domino partitioning.

So in the end, you may have the same number of logical Domino servers.

**Scalability**

Characteristics of a highly scalable system include, among other factors:

- Ability to support the processing of large applications.
- Ability to manage the resource requirements of multiple applications (that is, mixed workloads).
- Large file systems support.
- Ability to accommodate from one user to thousands of simultaneous users.
- Hardware scalability, meaning from a single CPU to SMP configurations with up to 64 processors.
- Large I/O subsystems that can support a lot of controllers and large volumes of data and files. Supporting higher numbers of controllers means you can distribute your I/O more efficiently. Storage capacity and bandwidth can be further extended with high-speed RAID boxes.
With Domino 6, changes have been made to improve the way Domino scales to take advantage of the larger platform architecture. Table 3-1 shows examples of platform scalability features, and how Domino exploits those features.

**Table 3-1 Platform scalability features utilized by Domino 6**

<table>
<thead>
<tr>
<th>Platform scalability feature/metric</th>
<th>How Domino utilizes the scalability metric</th>
</tr>
</thead>
</table>
| Ability of platform to support large I/O subsystems (large number of controllers and volumes of data/files). Means that I/O can be distributed more efficiently. | 1. Optimization of the database format (the on-disk structure or ODS) to minimize I/O contention. Writes to disk are fewer and more efficient.  
2. Transaction logging: Database operations are recorded sequentially, which reduces I/O activity while increasing data integrity and significantly improving server restart time. |
| CPU scalability: Scaling application performance across multiple processors, using single version of the operating system. | Thread pool model: Results in less memory and CPU utilization. |
| Support for large memory configurations. | More efficient memory utilization through:  
   ▶ Improved memory management via Unified Buffer Manager  
   ▶ Better use of RAM for internal caches and buffers, which boosts performance  
   ▶ The ability to use higher than 500MB means faster throughput. |
| Inherent scalability features of, for example, UNIX operating systems means:  
   ▶ Journaled file system for faster recovery following server crash  
   ▶ Support for very large memory configurations to process large applications  
   ▶ Large file system support provides more scalability  
   ▶ Application resource management, meaning the ability to support mixed workloads | Cumulative effect of Domino 6 performance / scalability enhancements with underlying platform scalability features means:  
   ▶ Lower memory and CPU utilization  
   ▶ Faster response times  
   ▶ More efficient use of I/O  
   ▶ Lower network traffic |

**Different types of servers needed**
There are several types of servers you can deploy in your Notes and Domino environment. These include:

▶ Mail servers  
▶ Database servers
Remote service servers
Passthru servers
Gateway servers
Hub servers
Backup servers

**Determining the number of servers of each type needed**
Which types of servers and how many of each you will need depends on the physical topology and the e-mail metrics that have been determined for your messaging environment. Those metrics include the number of users, the levels of e-mail traffic both during normal hours and peak usage hours, the number and types of applications being supported, and the messaging-based services available for the users. You also need to consider such things as geographic locations and balancing of usage loads.

**Choosing a platform for each type of server**
Lotus Domino servers can run on a variety of platforms, each of which has strengths and weaknesses. You must work closely with knowledgeable technical personnel to choose the appropriate type and size of hardware platform for each type of server in your new environment. Some of the factors which the project team should consider are:

- **Cost**: This includes not only the hardware cost but the total cost of ownership.
- **Company policy**: Does a company’s standard vendor have the right hardware or will you need to go outside the standard for it?
- **Footprint**: How much floor space is available to house the various servers?
- **Scalability**: Choose hardware with the view that expansion will most likely be needed in the future.
- **High availability**: Review your availability needs and ensure your hardware and network topology design will meet these needs.
- **Disk space**: The amount required depends on the kind of server and the number of users.
- **Processor**: The more speed, the better for performance.
- **Memory**: The amount needed depends on usage.
- **Skills**: Do your support personnel have the necessary skills to work with the platforms you choose?
- **Protocols**: Will the chosen platforms support the network protocols already in use within your company?
Domino 6 is currently supported on the following operating system platforms:

- **Windows**
  - Microsoft Windows 2000 Intel (Server and Advanced)
  - Microsoft Windows NT4 Intel
- **UNIX**
  - IBM AIX 4.3.3x, 5.1
  - Sun Solaris/SPARC 8
  - Sun Solaris/SPARC 9
  - Linux (Intel) - Red Hat 7.2, SuSE 8.0
  - IBM iSeries, V5R1 and later
  - IBM zSeries, z/OS® V1R2 and later

Further platform support might be added, so be sure to check with your local representative or the IBM Web site for the most up-to-date information.

### 3.13.2 Client selection

The first major step in designing a client infrastructure is choosing the client that your organization will use. The four choices available for Domino 6 are the Notes client, Domino Web Access (formerly iNotes Web Access), Domino Access for Outlook, or a Web browser. The best choice is different for each organization. Our purpose here is to give an overview of the differences between the clients and discuss some of the issues to consider when choosing a client.

This section covers the following topics:

- Single desktop client policy
- Web browsers
- User training
- Platform support
- Cost considerations
- Offline usage
- Standard browsers
- Performance considerations
- Security considerations
- How do I decide?

**Single desktop client**

A goal for many organizations is to have only one desktop client that can access all of their different data sources. The Web browser is a good candidate for becoming that client. Many software vendors are working on a way to make their
data available to a Web browser. Some are building direct interfaces while others are developing ways for the data to connect to the back end.

The other thing to consider is the amount of tools being developed and attention currently being given to the Web browser. This will give you different options and possibilities for the future.

Lotus has been looking for a way to build to the best of two worlds. As explained in the following sections, there are several options available:

- The Notes Client, where the Microsoft Explorer integrates seamlessly
- The Domino Web Access mail and C&S usage via the browser
- The Domino Access for Outlook client
- Domino WebMail

**Web browsers**

If Web browsers are already installed on all of the machines in your organization, this could be seen as an argument for choosing a browser. The main advantage would be that there is little or nothing to install on the client workstations.

However, even when using a browser, there will still almost always be the need to install something on the client machines. For example, maybe the browsers on the workstations are an older version. For a modern-day intranet you want to be using at least a version 5 browser. Often you need to install some type of plug-ins as well.

If you will need to install anything extra to make the browser work, then this choice may not be a real advantage compared to installing a Notes client.

Through a browser, you can accomplish tasks like the following:

- General tasks, such as working with folders, working with public and private documents, changing the user password.
- Mail tasks, such as reading/composing/sending messages, creating URL links with text, creating/editing/deleting rules to filter new messages.
- Calendar tasks, such as creating appointments, reminders, events, anniversaries, and meeting invitations; performing free time searches; and rescheduling, confirming, and cancelling meetings.
- To Do tasks, like creating and tracking to do items, assigning to do items to others, and accepting, declining, and delegating to do items.

**Important:** Be sure that the Person document has an Internet password specified on the Basics tab.
IBM Domino Web Access 6

The client of choice for Web access could be Domino Web Access, a next-generation Web client which allows you to utilize the most popular Domino functionality with a Web browser, such as working on your mail, using your calendar for personal and group scheduling, and doing some advanced task management. In addition, you have access to your contact information and a journal-like notebook. Domino Web Access utilizes the key features of the underlying Domino server environment, such as:

- Lotus Sametime integration (instant messaging)
- Welcome page customization
- Off-line usage (DOLS)
- Full calendaring and scheduling
- Spell checking
- Out of the office notification

Domino Web Access is based on the existing Domino database architecture, which makes it possible for users to switch between the Domino Web Access client and the Lotus Notes client, in case this becomes a requirement, to access their designated mail file.

From a deployment perspective, the choice of the Domino Web Access client offers some benefits over the Lotus Notes client, most notably in the areas of:

- Licensing model: Domino Web Access Client Access License is less expensive than the Lotus Notes client.
- Administrative costs: Domino Web Access is a server-based, centrally deployed client model, with no workstation footprint, making it cost-effective to administer.
- No use of personal digital (Notes IDs) certificates, eliminating the complexity of certificate administration

**Note:** To offer encryption capabilities, digital signatures, and off-line use (including replication), digital (Notes ID) certificates are required.

- Access to the Notification Service from a shared device, meaning one workstation to many users, thus saving money and time by simply providing a URL to the users for access.

Domino Web Access 6 is built upon the groundwork laid by the previous-generation WebMail in its use of Domino Off-Line Services. With Domino Web Access, users can work from a disconnected Web session to
manage e-mail messages, contacts, calendars, and to-do items from the rich user interface that Domino Web Access provides. Domino Web Access can optionally work in conjunction with the Notes client, or independently of the Notes client, while offering many Notes core messaging features. Users can move seamlessly between Domino Web Access and the Notes client, using Notes when at their desks and using Domino Web Access when they only have access to a Web browser, all of which is supported by a single Domino infrastructure.

It is possible to integrate other applications into the Domino Web Access welcome page. However, once you launch some other application, you are using that application and not the Domino Web Access user interface and feature set.

**The Domino Access 6 for Microsoft Outlook client**

Domino Access 6 for Microsoft Outlook lets users take advantage of Domino server functionality with their supported Outlook client. Aside from the familiar Outlook features, they can perform full-text searches in their mailboxes and leverage the offline support of Domino technology, including disconnected access to e-mail, calendaring, and scheduling through Domino Off-Line Services (DOLS). Interoperability capabilities are also supported between Notes and Outlook, including the ability to send and receive e-mail, and perform free time and busy time lookup and basic calendar functions.

Be aware that using the Outlook client compromises the security realized by using the full Notes client. The Domino Access for Outlook client is as vulnerable to viruses as Outlook. This is because it is based on the Outlook client.

For further information about Domino Access for Outlook, refer to the product homepage at:

http://www.lotus.com/products/inotes

**The Lotus Notes 6 client**

The Notes 6 client offers more functionality than any other client discussed previously. The Notes 6 client provides access to non Web-enabled applications, has the possibility of failover in clustered configurations, accesses a large number of servers at a time, and has the full security of Notes/Domino available. A wide range of applications are available for the Notes client, and your developers can create highly customized, feature-rich applications as well.

The Internet Explorer is fully integrated into the Notes 6 client and can appear as another window, which means that the user will only have to see the Notes 6 client (this does not prohibit the Internet Explorer having its own session).
The Notes client has a lower bandwidth footprint than Domino Web Access, since the Notes client is optimized for NRPC and the Domino Web Access client uses HTTP.

Unlike a Web browser, the Notes 6 client does not use page caching, and the eventual hazard of having multiple users on one machine is minimized. This problem can, however, be minimized in Domino Web Access using Logout, setting the Internet Explorer to clear its cache on browser close, and having ActiveX controls switched on.

**User training**

Many organizations have been using Web browsers for a while and their users have become familiar with them. Also, a lot of people are now connected to the Internet at home and are becoming proficient and comfortable with a Web browser.

However, this does not mean that no user training is required for the browser. Because of the open nature of the Web browser, every site on the Internet has designed its own user interface. Some sites use a graphical toolbar and place it in a frame on the left, right, top, or bottom of the screen. Others use text-based links or some new tool that no one has ever seen before.

It is very important to compare the need to educate on the browser to the need to educate on the actual Notes client.

**Platform support**

The Notes 6 client is supported on the Win32 platforms as well as the Macintosh, and Domino Web Access 6.5 is announced to be available for Mozilla browsers, which means you could use it on machines running Linux. There are Web browsers available for just about every client platform on the market. If you are using a client platform other than Win32 or Macintosh in your organization, and you have no plans currently to implement one of those platforms, the browser may be your only choice.

**Cost considerations**

A number of companies look to using a Web browser because they believe it will be cost effective to implement. This might be true in some cases, but not necessarily in all, and will depend on your organization. Be aware that some important functionality your users need might not be available or easily implemented for browsers.

If you already have a Web browser on the workstations that will not need to be customized, installation costs could perhaps be saved. If there is a need to
update or customize the installed browser, the potential cost savings may very well be minimal or nonexistent.

Other possible cost savings with a browser come from reduced training requirements for the users. If the users are already familiar with a browser, they will not need to have training on the browser. Users will usually still need training on any customization you may have performed. The amount of training, and therefore cost, might then not be lower than the cost associated with training the users on a Notes client.

Maintaining the Notes client may be easier than maintaining the browser since Notes 6 includes the AutoUpgrade feature, which automatically installs new versions and updates on the client.

**Offline use**
One of the major benefits of Domino/Notes is replication. Replication allows users to work offline by copying data down to local hard drives. It provides tools for synchronizing the data when needed.

Replication is now available when using a Web browser for the client, in the form of DOLS (Domino Off-Line Services). This is, however, a modification and extra installation to the client, and it is not necessary if the Notes client is deployed rather than the browser. Refer to the Administration manuals provided with Domino for more information on replication.

**Performance considerations**
The Web browser relies on the server to do most of the processing for it, and only needs to be able to display a text document. The Notes client is designed to do a lot of processing by itself. This means that a Domino server needs to do much more work to communicate with a Web browser than with a Notes client. On the other hand, a computer running a Notes client will need to do more work than a computer running a Web browser.

It is, of course, possible to build an infrastructure that will support both browser clients and Notes clients. In all likelihood, more servers will be required to support browser clients than will be needed to support the same number of Notes clients.

Example: It is possible to do mail with Notes clients, or a combination of POP3, IMAP, and/or HTTP-based mail with a Web browser could be used. If you want to minimize the load on the server in order to maximize the number of mail clients that can be supported, using the Notes client is the best option. Using POP3 is next best, IMAP is third best, and using HTTP, while sometimes appropriate, will support the fewest mail users of any of these four options.
Security considerations
One of the core aspects of Notes is the built-in security, which satisfies the most stringent security requirements a company may have.

Domino uses ID files to identify users and to control access to servers. The ID file sits on the client workstation and is protected by a password.

Web browsers do not use ID files. They are proprietary to Notes, which requires the ID files to be on the client workstation. If Domino required browser users to have an ID file on their local machine it would impact the advantages of using a browser. These include such things as being able to use any browser from any machine, or allowing users outside the organization to browse pages without any special software, to name just a few.

Instead of ID files, browsers typically use user names and passwords for security. Most sites on the Internet pass user names and passwords between the client and server in clear-text format. This means that anyone can intercept the message and easily read the user name and password. While this may not be of much concern in a closed, private network, it is definitely a big issue when opening up Domino to outside users.

To enhance security on the Web, Domino also allows the use of SSL (Secure Sockets Layer) and X.509 certificates for Web browser authentication. The main point here is that authentication and other aspects of security are different in a Web browser and a Notes client. You should look carefully at the differences between the two when making a client decision, especially if security is a top concern in your organization.

For details on Web browser security, see the Lotus Domino 6 Administrator Help database or the IBM redbook Lotus Notes and Domino R5.0 Security Infrastructure Revealed, IBM SG24-5341.

How to decide
The “best” client choice will differ for each organization. Use the information you have gathered, combined with the points described in this section, to help you decide which client will work best in your organization.

1. Check to see if your desktops are ready to use the Notes client. If you are not running Windows 32 or MacOS on your desktops, the Notes client is not an option. If some of your clients can run Notes while others cannot, decide if you will allow a combination of clients.

2. Can the required features be made available for Web browser users?
3. Determine if the browser will be used for other things. If the Web browser is going to be on the desktop anyway, it might be more practical to use the browser than to run the browser on some desktops and the Notes client on others. Also, if you already have Web developers in-house, they might feel more comfortable developing for the browser.

4. Try both of them out. Set up both a Web browser and a Notes client and test their functionality. Maybe the client offers some functionality you really like, or maybe the browser suits you more.

5. Determine if there is any feature of either of the two clients that you must have. If you must have replication, or your databases must be Web-capable, the decision is in favor of the Notes client.

6. Make a list of pros and cons for the Notes client, and one for the Web browser, and compare the lists. The client that turns out having the most pros and the least cons could be the winner.

Many companies have decided to use a combination of the two clients. A common setup is to use the Notes client inside the building and the Web browser outside the building. “Outside the building” could be either another company, or an employee working from home. You are then using the advantages of both clients where appropriate. Domino is unique in that it can gracefully handle this dual client setup.

There might be some initial development overhead to make your Notes applications work in both clients, but it may be a good investment. It will give you a lot of flexibility for the future, and it takes less time in the end to make your applications dual-client capable at the start than to go back and change them later.

3.14 Developing a coexistence and migration strategy

Coexistence between the Exchange and Domino environments plays one of the most critical roles in ensuring seamlessness of the migration process for both administrators and end-users. Unless instantaneous migration of users from Exchange to Domino can be accomplished, users will be migrating gradually over a period of time. During that time, users in both environments must be able to continue communicating with one another as well as with users external to both environments. Failure to provide this ability to users will have an adverse effect on any migration project.
In this section we discuss the following topics:

- The levels of coexistence
  Several options are available for establishing coexistence between Exchange and Domino. Coexistence solutions usually provide one or more of the following levels of functionality:
  - Messaging: Ability to exchange mail between Exchange and Domino users as well as with external users
  - Directory: Ability to exchange directory information between Exchange and Domino
  - Calendar & Scheduling (C&S): Ability to exchange scheduling information between Exchange and Domino users.
  - Application: Ability to access common application data by Exchange and Domino users

- Overview of the migration progress
- Introduction to the migration tools
- Acquiring the necessary information for migration

When migrating, there are areas other than mail and C&S to consider. The available migration tools will not migrate applications and backend interfaces. The discussion in earlier sections demonstrated the need for awareness of any development work that must be undertaken before starting the migration.

- Hardware profile
- Software profile
- Network

### 3.14.1 Levels of coexistence

Several levels of coexistence between Exchange and Domino are possible. The functionality provided by the selected coexistence approach normally depends on the functionality presently utilized by Exchange users and existing Domino users, if any. The following list describes coexistence functionality from the simplest to the most complex. Refer to the technical sections later in this book for comparison of the different coexistence and migration tools.

- No coexistence
  Users are migrated instantaneously, for example, during the weekend.
- **Messaging only**

  This coexistence method uses SMTP to exchange mail messages between Exchange, Domino, and the Internet; and requires manual entry of addressing information for some or all recipients.

  This method is fairly easy to establish; however, it imposes a burden on end-users to know exact addresses of all recipients, some of whom they had previously been able to select from the directory. End-user addressing questions subsequently increase the load on the end-user support personnel, dramatically increasing the overall cost and decreasing satisfaction with the coexistence solution. This method is only recommended for brief coexistence periods.

- **Messaging with Directory Synchronization**

  This coexistence method uses SMTP or other protocols for exchanging mail messages between Exchange, Domino, and the Internet; and allows selection of all Exchange and Domino recipients from the appropriate mail directory. Depending on the mail exchange approach selected, directory synchronization may be performed manually or automatically.

  Manual directory synchronization requires periodic updates to Domino and Exchange directories initiated by an authorized individual. The process may consist of executing custom programs, performing manual data entry, or a combination of the two.

  Automated directory synchronization is a process that automatically performs directory updates either instantly or based on a pre-defined schedule. Automated directory synchronization can be achieved by using Microsoft's Domino Connector for Exchange, TenFour's TFS Gateway, or by creating automatically invoked custom programs.

  This method requires a fair amount of effort to establish; however, it enables end users to continue e-mail communication in a familiar way regardless of the sender's or recipient's migration status. This method is recommended for extended coexistence periods.

- **Messaging with Directory Synchronization and cross-platform Calendar and Scheduling support.**

  This coexistence method uses SMTP or other protocols for exchanging mail messages between Exchange, Domino, and the Internet; and allows selection of all Exchange and Domino recipients from the appropriate mail directory. Depending on the mail exchange approach selected, directory synchronization may be performed manually or automatically. Also, depending on the mail exchange approach selected, cross-platform Calendar and Scheduling support may be provided in a transparent or manual fashion.

  In the manual approach to cross-platform Calendar and Scheduling, Domino and Exchange users include users of the opposite platform in the scheduling
notices, which are translated into simple mail messages when delivered to such recipients. Recipients have to manually add scheduling notices to their calendars and manually respond to invitations. Cross-platform schedule check is not possible with this approach.

In the transparent approach to cross-platform Calendar and Scheduling, Domino and Exchange users are able to perform all Calendar and Scheduling functions, such as sending scheduling notices, accepting invitations, checking schedules, and so forth, regardless of the recipient's platform. Transparent cross-platform Calendar and Scheduling support can only be achieved by using the Calendar Connector portion of Microsoft's Domino Connector for Exchange.

This method requires a great deal of effort to establish; however, it enables end users to continue all of their e-mail and Calendar and Scheduling communication in a familiar way regardless of the sender's or recipient's migration status. This method is recommended for extended coexistence periods.

- Messaging with Directory Synchronization, cross-platform Calendar and Scheduling support and uninterrupted Application access.

This coexistence method uses SMTP or other protocols for exchanging mail messages between Exchange, Domino, and the Internet; and allows selection of all Exchange and Domino recipients from the appropriate mail directory. Depending on the mail exchange approach selected, directory synchronization may be performed manually or automatically. Also, depending on the mail exchange approach selected, cross-platform Calendar and Scheduling support may be provided in a transparent or manual fashion. Finally, depending on the nature of applications, application access can be achieved via universal application access, or manual or automatic application synchronization.

Universal application access is achieved for applications that are Outlook client-independent, for example Web-enabled applications accessed via a Web browser. Users continue to access such applications regardless of their migration status. For Outlook client-dependent applications, continuous application access can be achieved by retaining the Outlook mail client on users' workstations, possibly along with the Notes client, and continuing to access applications that so require it using Outlook client.

Manual application synchronization requires that periodic updates to applications be performed by an authorized individual. The process may consist of executing custom programs, performing manual data entry, or a combination of the two.

Automated application synchronization is a process which automatically performs application updates, either instantly or based on a pre-defined schedule. Depending on the nature of an application, automated application
synchronization can be achieved by using a third-party product or by creating automatically invoked custom programs.

Depending on the nature of applications, this method may require a great deal of effort to establish; however, it enables end-users to continue accessing applications regardless of their migration status. This method is recommended for extended coexistence periods.

### 3.14.2 Pros and cons of migrating

Messaging data migration from Exchange and Outlook to Domino and Notes plays a critical role in ensuring that the migration process is completely non-disruptive for end users. The ability to access old messaging data in the new environment, in a similar way as in the old environment, is of great benefit and comfort to a user migrating from Exchange to Domino. Additionally, retaining old messaging data is sometimes mandatory due to certain legal and industry regulations covering data retention.

In some cases, however, a clean cutover to the new environment is preferred. In this case, the old system may live on as a reference for a period of time. This approach is very cost-effective in terms of migration and coexistence, but its success is heavily dependent on how the old system was used.

Example: A company uses mail and mail storage for project communication and documentation. Large amounts of the company's project documentation and communication is stored in the mail files. If this documentation is lost or not easily accessible, severe problems could be encountered.

### 3.14.3 What to migrate

Before determining what messaging data to migrate from Exchange and Outlook to Domino, one must clearly understand what types of data end users access, and how they do this. Exchange and Outlook data accessed by end users may include any combination of Exchange Mailboxes, Outlook Personal Folders, Public Folders, Contacts, and Personal Address Books. The characteristics of the data types are as follows:

- Exchange Mailboxes are located on Exchange Servers and usually include system- and user-created mail folders, calendar, tasks, journal, and so forth. Sizes of Exchange Mailboxes are usually limited by the server quotas. Exchange Mailboxes can be accessed in a connected or, if synchronized, an offline mode.

- Shared Exchange Mailboxes are located on Exchange Servers and resemble regular Exchange Mailboxes, except they may be shared by a number of
users without any specific user owning them. Shared Exchange Mailboxes can only be accessed in a connected mode.

- Personal Folders are located on users’ workstations or network file servers and may include data similar to that of Exchange Mailboxes. Sizes of Personal Folders are usually not limited. Personal Folders located on users’ workstations are accessed in an offline mode; however, ones located on network file servers require network connectivity.
- Personal Address Books often have the same information as Contacts, but may have additional information.
- Public Folders are located on Exchange Servers and usually represent structured or unstructured collections of documents shared between users.

Determination of what data and how much data to migrate is often dependent on several of the following factors:

- Data importance: How valuable is data from personal, professional, corporate, and legal points of view?
- Data retention: What mailbox cleanup policies and activities are in effect?
- Server mailbox limitation: What are the differences in quota policies and enforcement in Exchange and Domino environments?
- Archiving policy: Where and how frequently will data be archived?
- Migration Tools selection – Which migration products will be used for data migration and what are their capabilities?
- Migration duration: How much time is allocated for data migration?

The final decision on what data to migrate may result in multiple alternatives applicable to different groups or categories of users.

### 3.14.4 Overview of the migration process

When considering a migration from Microsoft Exchange to Lotus Domino, there are a couple of different strategies available:

- The single step or straightforward process
- The coexistence and migration process

**Single step process**

Single step migration can be defined as a complete migration from a Microsoft Exchange environment to a Lotus Domino environment without a transitional period of coexistence (also known as the “rip and replace” method). In this scenario, there is no need for gateways to interconnect Microsoft Exchange and Lotus Domino.
The single step migration process is ideal when an organization meets these criteria:

- Limited number of users to migrate on a single server.
- Users are typically located close to each other.
- Enough migration resources can be engaged in the migration effort to complete the tasks at hand over the shortest period of time.
- The migration process can be performed in a single event.
- The organization has a simple mail topology, for example, consisting of a couple of Exchange mail servers that need to be consolidated onto a single Domino 6 server.

In general, if the organization meets these conditions, the single step migration process can be used effectively.

**Coexistence and migration process**

Any mid-term or phased migration process requires the coexistence of both the old Microsoft Exchange servers with the new Lotus Domino environment. The coexistence period can vary from a few weeks to a couple of months. During this coexistence period, use gateways or connectors to provide message transfer between the two environments.

Mid-term coexistence planning is practical for organizations that meet these criteria:

- A large number of users in the Microsoft Exchange environment in a distributed environment.
- An organizational unit in multiple locations where it would be difficult to migrate all locations at the same time to Lotus Domino.
- An organization that has a complex Microsoft Exchange topology with multiple sites, servers, and gateways.

**3.14.5 Migration tools**

Migration tools provide a smooth and easy way to migrate the server and related data from an existing mail server to the new messaging environment. There are various tasks involved when migrating from an old mail server to a new one. These tasks include the conversion of users’ mail data and calendaring and scheduling information stored on the server, directory propagation and, in some cases, the client. A separate chapter includes information on the coexistence and migration of Public Folders. A good migration tool should be able to perform these basic tasks successfully with the least amount of effort. In addition, migration tools should also support the most possible messaging environments.
This section briefly covers the Lotus Domino Upgrade Services and Common Migration Tool (CMT) from BinaryTree.

For detailed information about using these tools, as well as migration results, refer to Chapter 9, "Migrating users using Domino Upgrade Services" on page 253 and Chapter 10, "Binary Tree Common Migration Tool for Lotus Notes" on page 277.

**Domino Upgrade Services**

Domino Upgrade Services (DUS), a part of the Domino Administrator client, lets you easily upgrade your existing messaging and directory system to Lotus Notes and Domino 6. DUS automates the entire process of upgrading, creating users, and converting mail for one user at a time or for your entire existing environment. DUS supports all popular LAN mail systems with the same upgrade procedures for each of them. And best of all, DUS is integrated into the normal user registration process of the Domino Administrator.

DUS provides the smoothest migration path from Microsoft Exchange to Domino 6. With the Microsoft Exchange migration tools, you can migrate users and convert their mail and calendar information to Domino 6, with full fidelity. Best of all, mailbox conversion runs on any administrator workstation, which leaves the Domino server free to serve the users. Like all Domino Upgrade Services, the Microsoft Exchange DUS is built right into the Domino Administrator client.

**Common Migration Tool from BinaryTree**

The Common Migration Tool (CMT) builds on years of proven e-mail and calendar/schedule migration solutions from BinaryTree.com. The individual product solutions have now been integrated into one: CMT. Apart from Microsoft Exchange, CMT allows you to migrate from Novell Groupwise and Netscape Mail servers to Lotus Domino. It also has utilities that migrate data at the client level. These include migration from Microsoft Outlook, Netscape Messenger, Microsoft Outlook Express, Qualcomm Eudora, and Lotus Organizer® to Lotus Notes.

### 3.14.6 Acquiring the necessary information for migration

Prior to creating the migration plan, you should consider the various migration scenarios, client deployment options, data migration options, and the coexistence options. With the questions in the prior sections in mind, discuss what is to be migrated, what can’t be migrated and what will have to be redeveloped in Domino. Along with all this, consider the Domino deployment and pay particular attention to client selection and deployment.
So before deciding what and when to migrate, we have to consider these questions:

- What is the main purpose of the migration (move to Domino, consolidate servers, security, and so forth)?
- How many users are to be migrated?
- How many locations do you have to migrate?
- What is the time frame for migration?
- Is information stored in Exchange or the Client needed?
- Are there other mail systems connected to Exchange?

With those questions in mind, think about the following issues.

Consider the training requirements and Client deployment issues, then decide:

- What Client are you migrating to (this will determine what data can be migrated):
  - Notes client
  - Domino Access for MS Outlook
  - Domino Web Access
  - Web browser
  - Mixed environment

- Available training resources:
  - Rooms
  - Materials
  - Personnel
  - Availability (the company)
  - Cost

- Post migration support/Helpdesk

Consider what information should be migrated:

- Data on server - server migration only (technically the only option for Domino Web Access)
- All data - server and local
- Locally saved data - local only
- No data
- Calendar information
- Distribution lists
- Directory information
Public folders and forms. Consider the following:

– Not migrating redundant forms
– Development work required to provide the same facilities
– Complexities of public folders/NSF coexistence

With regard to client migration, what type of information has been added to the personal address books:

► Entries copied from Global Access List (GAL)
► Custom entries
► Entries added from received mail
► No PABs used or allowed

It is important to review this information because the Client migration tools are not always able to resolve some addresses added via extraction from the GAL or recipient information.

With regard to physical infrastructure, consider the resources available:

► Hardware reuse:
  – Is it reusable?
  – Will you need to consolidate on same or new platform?
  – Is it redundant?

► With regard to the physical infrastructure, review the reuse/redeployment of any storage architecture in place.

► Internal IS support and Helpdesk.

► Network bandwidth. This issue needs to be considered in terms of both Server and Client data migration and deployment.
  – With regard to server migration, assuming all Exchange servers are accessible from one location, consider bandwidth usage for each user migration from remote servers.
  – With regard to Client deployment, specifically for Domino Access for Outlook, consider the bandwidth available for all connections (WAN, LAN Dialup, and so forth). The Domino Access for Outlook deployment requires you to download both code and a replication/synchronization of the user’s mail file.

    A similar situation may evolve with a remote client deployment and local replication of users migrated server-based mail files.

► Network support and future plans for the network.
With regard to actual migration, consider the following in terms of timing and planning of the deployment:

- Number and types of other mail connections to Exchange
- Address resolution, internal and external
- Support of coexistence tools
- Mailflow restrictions
- Directory management
- Mailflow performance
- Scalability of coexistence tool
- Public folders/Workflow
- Calendars
- Instant messaging
- Internet addressing and message flow
- Facilities that will no longer be available, regardless of the Client selection (for example, voting, resource scheduling, and others).

With regard to the actual migration, consider the following:

- Number of users to be migrated
- Grouping of users to be migrated at the same time (this could reduce the mailflow over connectors)
- Number and size of documents present in public folders
- Access restrictions on public folders
- Amount of developers work required to emulate forms and integration with backend applications
- Selection criteria for documents to be migrated (if not all documents)
- Whether all directory information must be migrated
- Reliability of coexistence tools
- Other mail systems - migration or gateway support
- Should directory structure/naming be emulated in Domino
- Internet connection migration
- Helpdesk retraining
- User training
- Methods of client deployment
- Server and client locations
With regard to coexistence, consider the following:

- Coexistence duration
- Number of users on either system at the mid-stage of the migration
- Calendar and scheduling requirements
- Internet coexistence requirements
- Expected message throughput of the gateway at the mid-stage of the migration
- Support personnel training
- Cost
- Post-migration cleanup

All the migration tools available are non-destructive. This means that a migrated users NT/Exchange account would still be online. It is therefore necessary to remove his account from the Exchange system, or if there is a need to access data, to restrict the user sufficiently (no creation of new mail, not listed in the Exchange directory, and so forth). Be sure to back up all accounts before removing them.

### 3.15 Realigning the expectations

An original set of success criteria were defined for the pilot project, and you should review them now. Are they still appropriate, in light of lessons learned during the previous sections? If so, include them in your deployment planning. If not, discuss the success criteria with senior management and update the criteria so they continue to be relevant. The success criteria should also be included in the final deployment plan document.

Have the expectations realigned and communicated. This part of the communication is the most crucial part since these will be the expectations the users are measuring the results against. Deviations from the expectations can impact your project in a negative way.
3.16 Deploying the coexistence and migration strategy

There are basically two methods used to roll out Domino: staged or instantaneous. Variations on these methods are called different things, but pretty much every strategy is a variation of these two, in technical projects.

The important thing to remember is that the strategy’s success will depend on good planning more than the method you choose. As always, you should be prepared for unforeseen events.

Meeting the prerequisites
Before you can roll out Domino, you need to be certain that all the prerequisites of the Domino rollout have been completed. Be sure that servers, network cabling, and other infrastructure is in place prior to beginning implementation. It will be difficult to install and configure clients if there is a problem with network connectivity, for instance.

It may be the case that all of this is handled by another area of the IT department, but it is critical the project manager understand what needs to happen, so that he or she can ensure it has been completed.

Staged rollout
In this type of rollout, the rollout team takes a step-by-step approach. This approach is quite common in smaller companies, where person power may be limited. For example, if you have just two people to handle the rollout, there are limits to the number of machines they can get ready in a day.

The staged rollout is also used in larger companies, if the rollout can be subdivided neatly. This is supported by coexistence during the actual migration.

The major advantage to this approach is that the risk if any given step goes wrong is minimal since it is only a fraction of the total project. The biggest disadvantage is that the total migration project can take a long time. Be aware that there tends to be a short span of time left between steps to determine if the one step has been successfully implemented before performing the next step.

Instantaneous rollout
This refers to a methodology where the entire rollout is done all at once, in one major step. Several underlying or background steps may have been performed prior to the rollout, though.

The biggest advantage with this type of rollout is that there is no period of coexistence. Be advised that for this type of rollout, management needs to be prepared for downtime. The downtime is needed to perform several steps all at
once. If you choose an instantaneous approach, management needs to be prepared for the possibility that there will be problems encountered along the way (like an operating system that refuses to install in a stable manner) that can cause the project to take a long time.

Most instantaneous projects are scheduled to run over a weekend or long weekend, and if there are problems, the rollout may run into Tuesday or even Wednesday. Management needs to know this is possible.

**Reality check**
In the real world, you rarely have the luxury of taking a system down during production hours. At the same time, management will not want to have a project which drags on interminably. Therefore, most rollouts end up falling somewhere between the extremes of instantaneous and staged.

Consider performing whatever you can separately, in controllable steps, to minimize risk. Do as much as you can at a time, after office hours. In this way you will benefit from doing big chunks at once, time-wise, but without the required production downtime a big bang requires.

**Distributing client software**
Depending on the platform you use, there are different tools available for software distribution. More appear on the market regularly; we recommend that you search Web automatic client deployment software.

Some of the tools available are architected for Notes client deployment, for example Automated Deployment Toolkit from Wolcott Systems Group and InstallPump from SoftQuest. You can also use Microsoft Active Directory for distributing Notes clients. The basic idea behind automated software distribution is to make installing multiple clients more efficient. This is generally done using some kind of template file, or a profile, which is set up once and then “pushed” to the user’s desktop. Then, the only tasks left in the client installations are the user-specific setup items.

Automated Deployment Toolkit (ADT) from Wolcott Systems Group is an automated, managed system for deploying, upgrading, or migrating an existing messaging system to Notes R5 and Notes 6. ADT centrally manages and automates the client deployment process and integrates with industry-leading data migration and training tools, saving companies significant time and expense.

Another option is to use one of the software products that are architected for distributing any software to the workstation. The most commonly used tools include IBM Tivoli Configuration Manager, Microsoft SMS, and ZenWorks.
Unless you work in a fairly small company, we recommend strongly that you consider using some kind of automated installation for the client installation.

For further information about distributing Notes clients automatically, refer to the Web sites and product documentation from the deployment software vendors, or to the IBM Redpaper *Distributing Notes Clients Automatically*, REDP3693.

**Backup and disaster recovery**

One of the most common errors made in Domino rollouts is not beginning backups until after the entire rollout is complete. We cannot stress enough that this is a bad idea. If you need to back out of changes that were made on a particular day, you will need a good backup from the day before to accomplish this.

**Recovery planning**

The concept of recovery planning is to save the organization from losing data. The type of disaster you are trying to be prepared for does not matter. If you’re prepared for the worst, you can get back to normal much faster.

Make sure, as a minimum, to have a rollback plan in place.

### 3.17 Final phase: Closure

This phase will close the migration project, transitioning the new system to ongoing operations and support. You should begin as soon as all migration-specific issues have been resolved. This phase should include:

- Acceptance report from the sponsor.
- Finalization of all project documentation.
- Completion of all technical documentation for the new system.
- Completion of a post-migration review and analysis of lessons learned.
- Closing down or securing the Exchange environment. (Refer to Chapter 16, “Removing the Microsoft Exchange environment” on page 437 for details.)
- Disposal or reallocation of any hardware or software remaining from the replaced system.
Part 3

Coexistence
Using the Microsoft Exchange Connector for coexistence

This chapter shows you how to install, configure, and use the Microsoft Exchange Connector for seamless coexistence with Lotus Notes 6. Although the Exchange Connector for Lotus Notes may not always be the best coexistence option for your environment, it is easy to set up and, properly managed, it is a useful and inexpensive coexistence option. The following topics are included in this chapter:

- Installing the Connector
- Configuring the Connector
- Customizing the Exchange Connector for Lotus Notes
- Running and monitoring the Connector
- Customizing the Directory Mapping
- Customizing the Connector for SMTP
4.1 Preparation

Before you begin to install and configure the Exchange Connector for Lotus Notes, you need to verify that you have a supported setup, and gather some specific information about your current environment that will be needed during the installation and configuration of the Connector.

4.1.1 Supported environment

To run the Microsoft Exchange Connector for Lotus Notes, your environment must meet the following prerequisites:

- A Microsoft NT Server 4.0 with Service Pack 6 or later running:
  - Microsoft Exchange Server 5.5 Enterprise Edition with Service Pack 4
  - Microsoft Exchange Connector for Lotus Notes with Service Pack 4

- Later, you will also need to install:
  - Lotus Notes Client Release 5.0.8 or later, connected to a Lotus Domino Server

Depending on the actual server load, we recommended that you do not install the Connector on a current Exchange mail server: either install on the bridgehead server or install a new server for the sole purpose of connectivity to Notes.

We have tested in our lab with both a Notes 6.01 client and Domino 6.01 server. Microsoft does not, at the time of writing, support the Exchange Connector running with a Notes 6 client, but will support on a best endeavours basis only.

Tip: See the following Web site to read the Microsoft Knowledgebase article about Microsoft-supported Connector and Notes client versions:

4.1.2 General setup information

To install and configure the Exchange Connector for Lotus Notes you will need to gather information on the following:

- From the Domino side:
  - The server names for mail and registration and Connector location
  - The Domino administrator ID and password
  - Client and server versions
4.2 Installing the Exchange Connector

To successfully install the Exchange Connector for Lotus Notes, the following tasks need to be accomplished:

1. Install a Notes Client on the Microsoft Exchange Server.
2. Install the Exchange Connector for Lotus Notes.
3. Register the Exchange Connector on the Lotus Domino server.

The following sections describe each task in detail.

4.2.1 Step 1: Install the Notes Client

In order for the Exchange Connector for Lotus Notes to access the Domino server, it requires access to several of the DLLs from Lotus Notes. You will be required to install a Lotus Notes client on the Exchange Server. Although we have tested and have not identified any problems using a Notes 6 client, Microsoft support has not yet verified that using a Notes 6 client with the Connector is a supported environment, and any problems reported will be treated on a best endeavours basis. Therefore, if you wish to remain in a Microsoft-supported configuration during the period of coexistence, we recommend that you use a Notes 5.0.8 client on the Exchange server rather than a Notes 6 client. IBM does support a Notes 5 client connecting to a Domino 6 server.

From the Exchange Server, perform the following steps to install the Notes client:

1. Launch the Notes client Setup utility.
2. At the Welcome screen click OK.
3. Accept the terms in the license agreement and click Next.
4. Enter the required information on the user and organization and click Next.
5. Unless otherwise required, do not change the Path names for the Notes program and data files.

**Tip:** We do, however, recommend that you install the data on a separate drive/partition.

6. Select the Install Notes Client button and select install to hard drive (see Figure 4-1). This will install all the subcomponents necessary. Click Next.

![Figure 4-1 Notes installation - setup selection](image)

7. Click Install.

8. When the installation is complete, ensure that the Lotus Notes directory is in the server's system path. If you need to update the system path, do so using the following steps:
   a. To get to the Systems Properties box, click Start → Settings → Control Panel. Double-click the System icon.
   b. Select the Environments tab and select Path in the Variable Field.
   c. Add the Lotus Notes directory at the end of the Value Field, for example, c:\Lotus\Notes; (This entry must terminate with a semicolon (;), for example c:\Lotus\Notes\Notes.ini;)
d. Click Set.
e. Click Apply.

9. Click OK.
10. Close all Windows.
11. Reboot the system.

**Important:** To ensure this change takes effect, it is necessary to reboot the system after the update to the Environment tab; failing to do so will prevent the Connector from working.

### 4.2.2 Step 2: Install the Exchange Connector for Lotus Notes

The NTSCONN program is found in the SP4_55XI.EXE download from the Microsoft FTP site (ftp.microsoft.com) for Service Pack 4 for Exchange.

Extract the Connector from the Exchange service pack (SP4_55XINTSCONN1) and store the extracted files in your temp directory on your Exchange server.

![Figure 4-2 extracting the Connector from service pack 4](image)

To install the Exchange Connector for Lotus Notes, run the NTSCONN program as follows:

1. Double-click NTSCONN.exe to launch the install program. Assuming you extracted to c:\temp, you will find it in the directory c:\temp\eng\exchconn\setup\i386\ntsconn.
2. Click Next at the Welcome dialog box.

3. Once you have read the Licensing Agreement, click Yes.

4. Select Microsoft Exchange Connector for Lotus Notes and click Next. (See figure Figure 4-4 on page 83.)
The Connector and the E-Mail Addressing Component are both installed when you select the option to install the Connector.

5. You are now asked to supply the Exchange/NT Administration Service Username and Password (Figure 4-5). Enter the Exchange Server's user account and password (confirm the password), then click Next.
Migrating from Microsoft Exchange 5.5 to Lotus Notes and Domino 6

Figure 4-5  Enter Exchange Administrator username and password

Figure 4-6  Enter the Foreign Domain name for Exchange

6. The screen shown in Figure 4-6 is probably the most important part of the install. If you get this wrong, you will probably have to reinstall the Connector to resolve it!
At the Install Notes E-Mail Addressing dialog box, accept the default Lotus Notes Domain Name of “Exchange.”

**Important:** This is the Foreign Domain Name used for routing to Exchange on the Lotus Domino server, *not* the Lotus Notes Domain.

Verify your Exchange Organization, Site, and Server names, and ensure that you have selected “Yes” in the “Generate e-mail addresses for existing Exchange users” field. This will create Note address aliases for all the Exchange users on this site.

If other Exchange sites are to be connected to Domino via this Connector, then the Notes address generator must be installed and run on each of the downstream sites.

Click Next to proceed.

7. You will be prompted to install both the Connector and the e-mail address generator. Click Yes to proceed (Figure 4-7).

![Figure 4-7 Start the installation](image)

8. The installation begins to copy the files to your hard drive. When the installation is complete you will be presented with an information dialog box stating that the setup is complete. Click OK.

9. You will return to the Explorer screen. Close the program folder created after the installation of the Exchange Connector for Lotus Notes, then close all windows since they are no longer needed.

**Verifying the Microsoft Exchange Connectivity installation**

You can view the new services added by selecting **Start → Programs → Microsoft Exchange Connectivity**. (See Figure 4-8.)

You will notice that when the Notes connector was installed, the Exchange Connectivity Administrator was also installed.
4.2.3 Step 3: Registering the Connector with Lotus Notes

As the Lotus Domino Administrator, you will need to create an ID file for the Exchange Connector for Lotus Notes.

From the Domino Administrator's Notes desktop, follow these steps:

1. If you have not already done so, create a link to the certifier ID (CERT.ID). If not, when prompted for the certifier ID later, you will have to ensure a network path is available to the Domino server to access it. We generally do not recommend copying the CERT.id to a local workstation, as this might compromise security.

**Restriction**: You will not be able to run the Notes Configuration Utility at this time because further steps are required, specifically creation of an ID file for the Exchange Connector and configuration of the Notes client to access the Domino server.
2. Launch the Notes client for the Domino Administrator on your administration workstation.

3. From the workspace, select the Servers Domain button and select your registration server. In our example the server name was itsosrv1/itso, which is also our mail server; in your Domino infrastructure this may not be the case, so be sure you select the correct server.

4. Select the People & Groups tab. This will display the People view of the Domino Directory (Figure 4-9).

5. Select People in the Tools pane and click Register, as shown in Figure 4-10.
6. After clicking the Register link, you may be presented with the “Select Certifier ID” box. Select your CERT.id and if necessary change the registration server. Once it is selected, click OK and enter the certifier password when prompted. If you have not set up a Recovery ID process, a message pops up that warns you that the certifier does not contain recovery information. Click Yes to continue.

7. You will be presented with the Register person new entry screen (Figure 4-11 on page 89). Select Certifier ID.
8. Use the following steps to create a Person document for the Exchange Connector.
   a. Select the **Advanced** checkbox to see more options.

**Figure 4-11  Register person - new entry**
In the First Name field, type Exchange.
In the Last Name field, type Connector.

We used these values because they are descriptive; you can use any values you like. However, at the least, you will need a last name for the Connector person document.

b. Click the Password Options button and move the scale to Weak, setting a minimum password length field of 0 (optional).

This is required so that you can allow the Microsoft Exchange Connector for Lotus Notes to run in unattended mode, with no password prompt.

c. Select the Mail Navigator tab and for the Mail type field, select None. All remaining options will be removed, as can be seen in figure Figure 4-13 on page 91.
d. Select the ID Info tab. You will be presented with the certifier screen (Figure 4-14 on page 92).

- Select the level of security for your region: North American or International.

- Depending on the expected length of time for the coexistence, set the expiration date of the certifier at a safe point beyond your planned contingency. Setting it too early will stop the functioning of the Connector at the specified date, whether you are ready or not.

- In the Store User ID field, select to store the ID in a file, and have the user ID stored in the default directory D:\Lotus\Notes\Data\ids\People.
Figure 4-14 Setting security options

e. Click the green check box on the right side to complete. Your person will be put in the Registration queue.
f. Click the Register button on the bottom left of the screen. The Exchange Connector will be registered, and a person document added to the directory. The ID file will be created and stored in the specified directory.

g. When you receive the Register person window, click OK.

h. Click Done. This will return you to the People & Groups view in the administration client.

You have now created the Exchange Connector's ID file.
4.3 Configuring the Connector

Setting up the Connector is a multi-step process. At a high level, the steps are:

1. Set up the Notes Client
2. Switch to the Admin ID
3. Verify access
4. Run the Notes Configuration Utility
5. Verify the Domino Server configuration
6. Modify the Foreign Domain document
7. Switch to the Exchange Connector ID

Each of these steps, in turn, consists of several smaller tasks. In this section we describe the tasks in detail and provide step-by-step instructions for performing the required configuration.

To run the Notes Configuration Utility, you need to be on the Exchange Server where the Notes client and Exchange Connector are installed.

**Step 1: Set up the Notes Client on the Exchange Server**

To set up the Notes client for the Exchange Connector, you need to use the ID file created to represent the Exchange Connector for Lotus Notes. In our example we created the user “Exchange Connector” with an ID file of econnect.id (Figure 4-14).

We placed the ID file in the D:\Lotus\Notes\Data\ids\People directory on the Domino server. The ID file needs to be copied to the Exchange Server's \Notes\data directory, or when requested specify a path to the location of the ID file on the Notes server.

1. To set up the client you need to first launch it. Double-click the icon on the desktop.
2. At the Notes Workstation Setup dialog box, select the office network as the location and click OK.
3. You will be presented with the welcome screen shown in Figure 4-16 on page 95. Click Next to proceed.
4. You are now requested to enter your username and server address. In our example this was Exchange Connector. Due to the lab environment and setup, we used the IP address instead of the Domino server name. Using the Domino server name should be the preferred method and should work as long as the Network and DNS have been set up correctly. See Figure 4-17.
5. Check the box “I want to Connect to a Domino server” and click Next.
6. Since we selected to *not* save the ID file in the Domino Directory, we are presented with the screen shown in Figure 4-18. Here we are required to provide the location of the Exchange Connector’s ID file. If it was copied to the local data directory the location is d:\Lotus\Notes\data\econnect.id; if not, click Browse, locate the ID file, and click OK.

   ![Lotus Notes Client Configuration](image)

   *Figure 4-18 Specifying the location of the ID file*

   Click Next.

   **Note:** This ID file has no password so we will not be prompted for an authenticating password.

7. The Exchange Connector does not require any of the additional services. Click Finish.

8. When you are presented with the Notes dialog box, click OK.

   The setup of the Lotus Notes client code is complete.

**Step 2: Switching to the Administrator ID**

To continue with the setup and configuration of Domino for the Exchange client, you need to run the Configuration Utility as the Domino Administrator.
Remain at the Exchange Server with the Notes desktop open. Either copy the Domino administrator's ID file (user.id) to the 'Notes\data' directory or locate it on the Domino server.

1. From the Notes client, choose File → Security → Switch ID.

![Figure 4-19  Specifying the admin ID](Image)

2. Select the Domino Administrator's ID file. (Figure 4-19) (If you did not copy the ID file to the local machine, you will have to specify the path.) Click Open.

3. You will be presented with the dialogue box requesting the Domino Administrator's password. Type the password and Click OK.

The Administrator's ID will now be used to complete the customization.

**Step 3: Verifying Access**

In order for the Administrator to run the Notes Configuration Utility, the Administrator's ID will require the following access rights:

- Manager access in the Access Control List (ACL) for the Domino Directory (NAMES.NSF) with the roles of NetModifier and NetCreator.

  This level of access is required to update the ACL of the Directory for Exchange Connector access, create a foreign domain document for the Exchange Connector with the name used in the install, and update the server document for the Exchange Connector access to the server.

- The ability to create new databases on the server in order to create a mailbox on the server.
Manager access in the ACL of the router's mailbox (MAIL BOX).

This level of access is required to update the ACL of the router's mailbox.

The Notes Configuration Utility requires that the Administrator be explicitly defined in the Access Control List of both databases. You will receive an error if the ACLs are not established correctly.

1. Add the database icons for the NAB and router's mailbox to the Administrator's workspace.

Because the router's mailbox does not have an .nsf extension, it will not appear in the list of databases in the Open Database dialogue box. Enter the Domino server name in the Server box and type mail.box in the Filename field (see Figure 4-20). Opening the database will cause it be added as an icon to your workspace. You can also create a bookmark to it by clicking the Bookmark button.

```
Figure 4-20   Open database dialog box
```

2. Open the access control list of the Domino Directory (Names.nsf) on the server and verify that the Administrator is listed with the access levels described earlier.

3. Edit the ACL if necessary. It should look similar to Figure 4-21.
Figure 4-21  Access control in the Domino directory

Make any required changes and click OK.

4. Edit the server configuration security to ensure that the Administrator and Exchange Connector can create and edit databases on the server. To do this, open the directory (select File → Database → Open, or double-click the icon), and select and edit the Server document for your server using the following steps:
   a. Select Configuration → Servers → All Servers; select your server from your domain.
   b. Click Edit Server as shown in Figure 4-22.
5. Once you have the configuration document open, click the Security tab.

6. Ensure the Administrator is listed in the Create new databases field, or that the field is left blank, indicating that anyone can create databases on this server. In our example, shown in Figure 4-23, the field remains blank.
7. Save and Close the document.

8. Select the router's mailbox and verify that the Administrator is listed in the ACL with the access levels of Manager and specified as a Person.

Select the admin ID from the access control list, and verify it has access as Manager and is specified as a person. In our example the ID type was unspecified and had to be modified. See Figure 4-24 and Figure 4-25.

![Figure 4-24 Router mailbox acl admin ID type not specified](image1)

![Figure 4-25 router mailbox acl corrected](image2)

Now the Administrator has the appropriate rights on the Domino server to proceed.

**Step 4: Run the Notes Configuration Utility**

While still switched to the Administrator's ID, configure the Connector. We used the Notes Configuration Utility (a LotusScript application) provided with the Microsoft Exchange Connector for Lotus Notes. We used the second method and performed the following steps:

- Verified the access rights.
- Ran the Notes Configuration Utility.
- Modified the foreign domain.
– Switched to the Lotus Notes user ID for the Microsoft Exchange Connector for Lotus Notes.

**Important:** The Domino server must be running in order to run the Notes Configuration Utility successfully.

If you closed the Notes client, the connectivity utility can be launched by selecting Start → Programs → Microsoft Exchange Connectivity → Notes Configuration Utility. This will start the Notes client, prompt for a password, and open the client configuration database.

If you did not exit the Notes client, you can simply select the database from the workspace, and open it with File → Database → Open, or use Ctrl+O to open it.

Press Esc when the “About Lotus Notes Configuration Utility” document is displayed.

From the main view of the database:
1. Click the New Configuration Document button.

![Figure 4-26 Notes Connector configuration utility main screen](image)

2. You may be asked to cross-certify with the organization /Microsoft (Figure 4-27). Click Yes to proceed.

If you have previously cross-certified with Lotus, you may encounter a problem. To resolve this, open your local names.nsf database, select the Advanced tab and then Certificates, and delete the /Microsoft certificate. Exit and try to create the documents again.
3. Since the database has not been signed, and depending on the client version being used, you may be requested to acknowledge a trust relationship for each of the tasks the database is going to undertake. In each case, select “Start trusting the Signer to execute this action” and click OK.
4. When you open the New Configuration Document, you will find that several of the fields already are completed for you by default. The following steps assume that you need to fill in the fields in the New Configuration Document, although some fields will need to be changed, some not.

During this step you will need to scroll down through each of the fields.

– The only non-editable field is the Administrator name, and this should be already completed with the current user name (your administrator ID).

– In the Notes Bridgehead Server Name field, you should find the name of the server you selected during the installation. If this is incorrect, type the name of the Domino server where the Exchange Connector was installed.
For the following fields see Figure 4-30.

- In the Connector’s Notes User Name, click Browse. Find the name of the Exchange Connector's name, highlight it, and click OK.

- Let the Allow Connector to be Administrator field default to Yes. This will enter the Exchange Connector in the administration group.

- In the Path to Connector’s Notes.ini field, click Browse. Locate the Notes.ini file, highlight it, and click Select.
In the Foreign Domain Name of Exchange field, type the foreign domain that you entered in the Notes domain field on the Connector installation (see Figure 4-6 on page 84). In our example, we used Exchange. (As you may recall, the name of Exchange was provided when we installed the Connector by default).

In the Connector Mail File Name field, type the default name of Exchange.BOX. This will be the repository where all Exchange-bound e-mails will be sent for the Connector to collect.

In the Source Name & Address Book(s) field, click Browse. We will use the default Domino Directory (names.nsf). Highlight your Domino Directory (names.nsf) and click OK.

In the Target Name & Address Book field, click Browse. You will receive an option dialog box asking if you want to create a new target name and address book. Click Yes, then enter Exchange.nsf (Figure 4-32).

Attention: The default entry of c:\winnt\Notes.ini is incorrect. If you do not change this value to point to the correct location the Exchange Connector will fail to operate.

Note: It is possible to synchronize the Exchange addresses into the names.nsf. We found that this can cause some complications when migrating and it is simpler and cleaner to synchronize with a secondary directory and set up directory assistance. For instructions on how to set up directory assistance, see the Lotus Domino 6 Administrators Help database.
You have completed the document.

5. Click the Configure button to proceed.

As the configuration starts, you can watch the Notes message pane for information on its progress. Before the configuration completes, you will be presented with a view of the Foreign Domain document created for the Exchange Connector. If this does not close on its own you will need to close it once the configuration is complete.

6. On completion, you will receive the Finish the Notes Server configuration dialog box shown in Figure 4-33, which prompts you to start the Notes Connector. Click No; you should verify that the configuration is correct first.

```
Finish the Notes Server configuration

Notes Server configuration has completed successfully. You can now go to the property page of the Lotus Notes Connector to finish the configuration, or you can start the Lotus Notes Connector now.

The original exchange has been backed up to:
C:\Exchange\CONNECT\Exchange\exchcomm.exm

Do you want to start the Lotus Notes Connector now?

Yes  No
```

Figure 4-33  Configuration complete dialogue box

7. Review the configuration events. The checked boxes should reflect the settings you specified during the configuration. If the wrong boxes are checked, redo that part of the configuration.
8. Once you have reviewed the configuration events and verified the correct access and documents have been created, click Close. When prompted, click Save to save your configuration document.

9. When you return to the main view of the database, there is a green check mark (indicating a successful configuration) beside your newly created Configuration Document.

10. Click Esc to close the Notes Configuration Utility database. You are returned to the Notes desktop.

The Notes Configuration Utility is now complete. In the next step we check what has been done on our behalf.

**Step 5: Verify the Domino Server configuration**

When the Notes Configuration Utility completes successfully, you should have the following:

- A mailbox (Exchange.BOX) created with manager access to it for the Exchange Connector.
- Editor access to the Domino Directory with the option to delete documents in the directory for the Exchange Connector.
A foreign domain document created called Exchange (Note: it is not visible now, we have included instructions how to fix this.)

Depositor access to the router's mailbox (MAIL.BOX) for the Exchange Connector

To verify the setup, follow these steps:

1. Verify that the ACL for the Exchange.BOX includes the Exchange Connector with Manager Access and Delete Documents checked (see Figure 4-35).

![Access Control List to MS Exchange Outgoing Mailbox](image)

Figure 4-35 Checking the access control of the Exchange.box

2. Check the ACL of the Domino Directory database to ensure that the Exchange Connector has been given the required level of access.

   **Tip:** Editor access with the Delete Documents option specified will be required only if you selected to synchronize the Exchange Global Address list to names.nsf (that is, a single directory).

   In our testing, the Connector was given Reader Access to the Domino Directory, as we are synchronizing the Exchange users to a secondary address book.

3. Check the Server Configuration Security document to verify that the Exchange Connector has been added to the Administrators field. To do this, open the Domino Directory.

   To open and edit the Server document for your server, select Configuration → Servers → All Servers; select your server from your domain and click Server Document.

   Verify that the Exchange Connector is included in the Administrator's field. (See Figure 4-36.)
4. Close the document, but do not exit the directory.

**Step 6: Modify the Foreign Domain Document**

Use the following steps to check the Foreign Domain Document.

1. Select Configuration → Messaging → Domains (Figure 4-37).

2. At this point the Domain Document is not visible. This is because when creating the Domain Document, the Exchange Connector uses a Notes R4 form template called “Gateway Domain.” This form is not supported in R5 and above, so you need to edit and save the document.
First you need to create a view to see the document using these steps:

a. Select Create View.

b. Change the name from Untitled to something more relevant; we used All Domains.

c. Click Server and then click Copy from (Figure 4-38).

![Figure 4-38 Creating a view](image1)

Figure 4-38 Creating a view

d. Select the Domains view as shown in Figure 4-39.

![Figure 4-39 Selecting a view to copy style from](image2)

Figure 4-39 Selecting a view to copy style from

e. Edit the View selection formula and remove the text & form = "domain" as shown in Figure 4-40.

![Figure 4-40](image3)
f. Click the green check box to accept the change to the formula.

g. Click OK; the view is now created.

3. Open the view using the following steps:

a. Select View → Go To.

b. Select the view you just created (in our example this was All domains).

c. This will show you a new Domain View, and the Foreign Domain Exchange is now visible. (See Figure 4-41 on page 114.)
4. You now need to change the form used by the Domain document. The easiest way to do this is to edit and save the document. Since you need to check the details of the document first, do the following:

   a. Select the document in the view and click Edit domain.

   b. Select the Mail Information tab.

   - The Domain type field should specify Foreign Domain.
   - The Foreign Domain name should be Exchange.

   b. Select the Mail Information tab.
The Gateway server name field should specify the Domino server you will be using to connect to the Microsoft Exchange Server running the Exchange Connector for Lotus Notes.

The Gateway mail file name field should specify Exchange.box.

Save and close the document. You have now also changed the form name of the document.

c. Select the Domains view; the Domain document will now show up as a foreign domain, as shown in Figure 4-44.

5. Verify the router's mailbox:
   a. Open the ACL of the MAIL.BOX file.
   b. Ensure that the Exchange Connector is listed with Depositor access.
   c. Close the document.
Step 7: Switch to the Exchange Connector ID

With all the modifications verified, we are ready to switch to the Exchange Connector's ID using the following steps:

1. To switch to the Exchange Connector ID, choose File → Security → Switch ID. (refer to “Step 2: Switching to the Administrator ID” on page 97 for detailed instructions).

2. Select the ID file you created for the Exchange Connector. In our example this was econnect.id.

3. Click Open.

4. Close the Notes client.

4.4 Exchange Connector for Lotus Notes customization

Before you start the Microsoft Exchange Connector for Lotus Notes service, you must first configure the Connector's properties. You will modify the following:

▶ The Domino directories you want to synchronize with the Microsoft Exchange server and any Domino groups you may want to exclude from directory synchronization

▶ The Microsoft Exchange server recipient containers you want to export to a Domino directory

▶ Microsoft Exchange server distribution lists you want to synchronize

▶ The recipients container in which imported addresses from the Domino Directory are to be saved

▶ The schedule of the synchronization

▶ An initial directory load

4.4.1 Defining import and export containers

Just as we created a secondary directory for the Exchange users on the Domino server to be used during the directory synchronization process, we recommend you have a separate Exchange recipient container for the Domino user entries. In addition to customizing the property pages for the Exchange Connector for Lotus Notes, you will need to access the Exchange Administrator on the Exchange Server.
To create an Exchange recipient container, follow these steps:

1. Launch the Microsoft Exchange Administrator by choosing Start → Programs → Microsoft Exchange → Microsoft Exchange Administrator.

2. Select Recipient Container.

3. From the Microsoft Exchange Administrator window, select File → New Other → Recipients Container. (See Figure 4-45.)

4. Type in the Display name and the Directory name of the new container. In our example, we chose Notes Recipients and Domino Directory respectively. Click OK to save this recipient container (Figure 4-46).
Next, you need to customize the Connector configuration.

**Tip:** Whenever you click Apply during the customization of the property pages, you may receive a dialog box directing you to inactivate the Exchange Connector for Lotus Notes. As we have not yet started the Connector, you can simply click OK and proceed.

1. On the Exchange Administrator console, double-click the Connector for Lotus Notes. (Figure 4-47). This opens the Connector for Lotus Notes Properties window (Figure 4-48).
2. Click the Import Container tab. Here you can specify the container in Exchange to which the addresses from the Domino Directory will be added during directory synchronization. Click the Container button to select the Import container. In our example, we selected the container Notes Recipients that we created in the preceding steps. See Figure 4-49.
3. Click OK to return to the Connector for Lotus Notes Properties window.

4. Click the Export Containers tab. This window allows you to specify the Exchange recipient containers that have the addresses you want added to the Domino Directory during directory synchronization. See Figure 4-50.
5. From the list of available Exchange Recipient containers that appears on the left pane, select the container you want to export and click the Add button. The selected container now appears on the right pane in the Export these recipients list. In our example, we selected the Recipients container. The Site and Trust level fields can remain as defaulted.

6. Click the Notes Address Books tab. You will be presented with the screen shown in Figure 4-51.
The "Notes server" field defaults to the name of the Domino server which will connect to Exchange Server via the Connector. It should default to your Domino Server's name as specified in the configuration utility.

The "Default name and address book" field under "Target name and address books" section specifies the address book into which the Microsoft Exchange user names will be propagated, we set this field during the configuration utility and therefore should be left as is. In our example this was set to exchange.nsf.

The "Source name and address books" field specifies the address book from which the Domino user names will propagate into the Exchange directory. Leave this field set to names.nsf.

The "Propagate groups" checkbox specifies whether or not you will propagate Domino groups to Exchange. Unless you do not wish to synchronize Notes groups, leave this box checked.

The "Exclude following groups" field allows you to restrict groups from being propagated into the Exchange directory. Accept the defaults. If there are any additional groups you have created that you do not wish to propagate, add them now.

If you have made any changes, click Apply.
7. Select the Advanced tab (Figure 4-52).

![Connector for Lotus Notes (EX...)](image)

**Figure 4-52  The Notes Connector advanced tab**

- The "Propagate distribution lists" checkbox specifies whether or not to propagate Exchange distribution lists to Domino. Check this box unless you do not wish to synchronize the distribution lists to Domino groups.

- The "Notes letterhead" field specifies the letterhead style used for Exchange e-mail messages. Leave the default of Plain Text.

- The "Convert Notes DocLinks to" field specifies the manner in which Document Links will be translated. We left this as the default of RTF Attachment. However, you can set this to convert to either OLE document links or URL shortcuts.

- The "Notes.INI file location" field specifies the location of the Notes.INI file. Verify the location and ensure it is documented correctly.

- The "Run Notes database maintenance at (hh:mm)" field specifies whether or not to schedule compacting the Connector's mailbox (Exchange.BOX). We would recommend, if set, that this runs at a time when low mail usage is expected.

- The "Run Connectivity Administrator" button allows you to launch the Microsoft Exchange Connectivity Administrator. For now, do not click the button.
Click Apply if you have made any changes.

8. Select the Options tab (Figure 4-53).

![Connector for Lotus Notes (EX...)](image)

**Figure 4-53  The Notes Connector Options Tab**

- In the Exchange connection section, verify the organization, site, server and address type (it should be Notes). These fields are not available for modification.

- In the Notes connection section, verify that the Notes server is correct. The Exchange domain name in Notes should be Exchange (our foreign domain name), the polling interval can remain at the default of 15 seconds, and the Notes server language defaults to English.

If you have made any changes, click Apply.

9. Click the Routing tab (Figure 4-54).
Chapter 4. Using the Microsoft Exchange Connector for coexistence

Figure 4-54   The Notes Connector Routing Tab

- The "Notes mail router" field should specify the Domino router's mailbox, MAIL.BOX. This is where all Notes-bound messages from Exchange will be placed.
- The "Connector mailbox" field should specify the Connector's mailbox, Exchange.BOX. This is where the Connector will collect any Exchange-bound messages from Domino.
- The "Routable domains" field is used to define downstream Lotus Domino domains. Since we did not have any in our lab, we left this field blank.

Click Apply if you have made any changes.

10. Click the Dirsync Schedule tab (Figure 4-55).
Select the "Enable Scheduled Directory Synchronization" check box. You should aim to synchronize the directories during a low usage time period. In our example we chose 1 AM.

In the "Exchange to Notes directory synchronization" section, we have two options: Immediate full reload and Immediate update. A full reload will remove all the Exchange recipients from the specified NSF and then reload them again. The Immediate update will check the recipients containers for any changes since the last synchronization and add them to the specified nsf.

Important: Prior to running a full reload of the Exchange user to Domino, consider the implications that the number of directory changes for replication may have on remote/mobile users. That is, for each recipient, the user will replicate two changes, one for deleting and one for adding a document.

Since the Connectors are not running, we will come back to this property page when we synchronize the directories later in this chapter.

Under the "Notes to Exchange directory synchronization" section, we have two options: Immediate full reload and Immediate update. The full
reload will remove all Notes recipients from the specified Container (see Figure 4-49) and reload them again.

**Important:** Before considering a full reload, consider the latency of the directory replication between Exchange sites.

The immediate update option will poll the Domino Directory for any changes since the last synchronization.

11. You have completed the configuration of the Connector at this time; click OK to close the property pages.

### 4.5 Operating and monitoring the Connectors

In this section we show you how to:

- Start the Connectors
- Operate the Connectors
- Run Directory Synchronization
- Monitor the Connectors
- Stop the Connectors

#### 4.5.1 Start the Connectors

For operation of the Exchange Connector for Lotus Notes, you have two related services:

- Microsoft Exchange Connectivity Controller
- Microsoft Exchange Connector for Lotus Notes

If you start the Connector for Lotus Notes, it will start the Connectivity Controller.

To start the Connectors on the Exchange Server manually:

1. Choose Start → Settings → Control Panel.
2. Double-click the Service icon and scroll down to Microsoft Exchange services (Figure 4-56).
3. The two services to be started are:
   - Microsoft Exchange Connectivity Controller
   - Microsoft Exchange Connector for Lotus Notes

4. Select both services to start and click Start.

You now have all services and tasks started and can continue to operate the Connectors. After you have verified the operation of the Connectors, you may wish to have them started automatically. To do this, click Startup and change Startup type from Manual to Automatic.

### 4.5.2 Operate the Connectors

Once you have started the Connectors, they are ready for use. In this section we describe how to use the Connectors to:

- Synchronize the directories
- Verify the directory synchronizations

**Directory synchronization**

Before you begin the directory synchronization, review the directories for both Exchange and the Domino server, noting the user names listed in Exchange and those in the Domino Directory. You will use these names to verify the directory synchronization. Use the following steps to synchronize the directories:

1. Open the Exchange administration program.
2. Expand your site's configuration container and select the Connections container.
3. Double-click the Connector for Lotus Notes. Go to the Dirsync Schedule tab. You can see that the buttons on this tab are now active.
4. From the Dirsync Schedule tab, click the Immediate full reload button in the Exchange to Notes directory synchronization section.

5. At the dialog box, click OK to acknowledge the full reload request.

6. Click the Immediate full reload button in the Notes to Exchange directory synchronization section.

7. At the dialog box, click OK to acknowledge the full reload request.

8. Close the property pages.

Since you have just requested an immediate full reload, the actual directory synchronization may take some time. Be patient!

**Verify the synchronization**

To verify the directory synchronization from the Exchange Administrator program:

1. Select the Notes Recipients container.

2. Locate any custom recipients (the ones with a globe in front of their names).
3. Double-click the custom recipient representing a Notes user. In our example we used "Sean Long."

4. Note the e-mail fields and their address (see Figure 4-59) should show something like "NOTES: Sean Long/ITSO@SMBNotes."
Figure 4-59  Sean's Exchange recipients entry

5. Click OK to close the custom recipient property pages.

To verify the directory synchronization from the Domino Administrator:

1. Open the Domino Directory.
2. Select the People view and locate a person document for the Exchange user; we used Graeme Povall.
3. Double-click the Person document.
4. Note that the Mail system field states Other and the Domain field states Exchange.

5. Check the Miscellaneous tab; the Calendar Domain field should state Exchange.

   Note: If the Calendar Domain field is empty, you must perform a new directory synchronization to update the field. If you later install the Calendar Connectors and the field is left empty, you will not be able to query the free/busy time of an Exchange user.


Site addressing

If you have multiple Exchange servers, you need to synchronize the Site Addressing scheme within all the Exchange servers so that Domino addressing information is updated across the Exchange site. If this procedure is not done, e-mail from and to the Exchange servers, other than the one running the Microsoft Exchange Connector for Lotus Notes, will not flow until the next scheduled replication. To perform an immediate routing recalculation, perform the following steps on every Exchange server.
In our example, we did this on Exch55_1, since Exch55_2 is running the Microsoft Connector for Lotus Notes.

1. From the Exchange Administrator window, select Configuration and then select Site Addressing, as shown in Figure 4-61.

2. In the Site Addressing Properties window, click the Routing tab. On the Routing page, click the Recalculate Routing button. See Figure 4-62.
Your Exchange servers are now synchronized to send and receive Domino mail.

Testing the message flow
To test message transmission from Exchange to Domino log on to the Exchange Server using an Outlook client. In the lab we signed in as Graeme Povall. Then conduct the following simple test:

1. Click the Mail Message icon.
2. Click the To: button to access the Global Address List.
3. Select a custom recipient representing a Notes user you will send the message to. In our example we selected Kurt Nielsen.
   - Click the To button.
   - Click OK.
   - Compose a message using rich text and attachments.
   - Click Send.
4. Now, to check the inbox of the Notes user:
   - Log on to Notes user. For our test we signed on as Kurt Nielsen.
   - Open Kurt's Inbox.
   - Double-click the message from Graeme Povall and review it.
– Click Reply, and reply using rich text and attachments.
– Click Send and check the details.

4.5.3 Monitor the Connectors

This section explains how to monitor the Exchange connector.

1. From the Exchange Server, choose Start → Programs → Microsoft Exchange Connectivity → Microsoft Exchange Connectivity Administrator.

2. Select (local) as the server and click Logon.

3. Double-click the Process Manager. You will see (in a few moments) the processes for the Connector. All the processes should be idle (Figure 4-63).

![Figure 4-63 Browse Processes](image)

Additional information on the status of the process can be viewed by double-clicking a process name.

4. Close the Process Manager panel.

5. Double-click the Log Browser.
6. Double-click an entry for more details. You can see the level of detail kept for each action in Figure 4-65.

7. Click OK and then close the Browse Log panel.

8. Close the Exchange Connectivity Administrator program.

4.5.4 Stop the Connectors

From the Exchange Server:
1. Choose Start → Settings → Control Panel.
2. Double-click the Services icon.
3. Stop the services (Microsoft Exchange Connectivity Controller, Microsoft Exchange Connector for Lotus Notes) by:
   – Selecting the service(s) to stop.
   – Clicking the Stop button.

Congratulations! You have successfully completed the installation and testing of the Exchange Connectors.

4.6 Customizing the Microsoft Exchange Connector for Lotus Notes tables

The Microsoft Exchange Connector for Lotus Notes provides a component that synchronizes one or more Domino directories with the Exchange directory. Synchronization is bi-directional and can include custom recipients and mailboxes. The names and addresses of distribution lists (referred to as “groups” in Domino) can also be synchronized. However, the membership of the distribution list or group is not carried in the shadow entry, and all mail routing must be done on the system where the distribution list or group is maintained.

The Microsoft Exchange Connector for Lotus Notes synchronizes a useful subset of the many attributes supported by the Domino and Exchange directories. The purpose of this section is to explain how attributes are synchronized, and how you can customize the process to meet local requirements. Through customization, you can do either of the following:

- Change the list of attributes that are synchronized between Domino and Exchange, adding or removing attributes.
- Change the way attributes are mapped between the Domino and Exchange environments.

The synchronization process uses four control files, which are located in two subdirectories of the Microsoft Exchange Connector for Lotus Notes root directory `\<servername>\connect$\exchconn`.

**Important:** If you intend to edit these files, save backup copies of the files before you make changes.

**Attention:** Do *not* use the Tab key when making changes. All whitespace characters should be entered using the space bar.
Before you edit these files, ensure that directory synchronization is not active. (You can do this, for example, by shutting down the Microsoft Exchange Connector for Lotus Notes.) If you add attributes to the synchronized schema or change any mapping rules for existing attributes, you will most likely need to do a full directory reload.

The Microsoft Exchange Connector for Lotus Notes maps Exchange and Domino attributes this way:

1. It reads the attributes from the directories, which is controlled through a configuration file called the AMAP.TBL.
2. It passes the attributes through a set of mapping rules to transform them into a readable format for the corresponding directory. For example, mapping rules change the Notes Full Name format (Last_Name, First_Name) into Exchange format (First_Name Last_Name).
3. Once the mapping rules are complete, the attributes are inserted into the corresponding directory using its AMAP.TBL. For example, the AMAP.TBL file for Exchange is used to read/write the attributes from the Exchange Directory.
4. The attributes are passed to the mapping rules (MAPMEX.TBL) and transformed into a Domino format, and then are written into the Domino directory using the AMAP.TBL for Domino.
5. In the opposite direction, the attributes are read using the Notes AMAP.TBL and passed to the mapping rules (MAPNotes.TBL). Afterward, the attributes are written into the Exchange directory using the AMAP.TBL for Exchange.

Not all fields are, by default, synchronized between Exchange and Domino. If you require additional fields, you must first set the mapping rules for them. These mapping rules must include the real field names, not the display names.

### 4.6.1 Customizing the synchronization

Perform the following steps to customize the fields that are synchronized between Domino and Exchange directories.

To see the real field names in Exchange, you must launch the Exchange Administrator in raw mode. To run in raw mode, which allows you to see additional information, follow these steps:

1. Click Start → Run and type `c:\exchsrv\bin\admin /raw`
2. Select any Custom recipient (indicated by a globe icon) and press Shift+Enter. In our example we chose our Binary Tree support user.
3. From the Properties window, select a field name under the Object attributes section. On the right side of this window, you will see the real field name listed next to the Common name parameter.

4. To see the real field name for documents in the Domino Directory, open any existing person document in the Domino Directory and view the document properties. Select the Fields tab and check the real names of the fields. This is shown in Figure 4-67.

5. Write down all the required real names of the fields that need to be populated in the person records when synchronizing them from Exchange to Domino, and vice versa.

6. Edit the table files `dxamex\amap.tbl`, `dxaNotes\amap.tbl`, and `dxaNotes\mapmex.tbl` to include the additional fields as desired.
7. If you want to synchronize custom recipients, click the Export Containers tab. Select the container that contains the custom recipients and click the B button. This adds the container to the Export these containers field. Make sure to select the Export custom recipients checkbox.

8. Click Apply and then OK to save these settings. A pop-up window appears and asks you to shutdown and restart the Microsoft Exchange Connector for Lotus Notes services. Click OK in this window since the services have already been stopped.

9. Start the service for the Microsoft Connector for Lotus Notes from the Windows Control panel.

10. From the Microsoft Exchange Connector for Lotus Notes Properties window, select the Dirsync Schedule tab. Perform an Exchange to Domino directory synchronization immediate full reload by clicking the Immediate full reload button under the Exchange to Notes directory synchronization section.

4.7 Customizing for SMTP mail

There are a number of considerations for SMTP traffic between Notes and Exchange. We have discussed in other chapters a number of possible scenarios.

First would be using SMTP for mail coexistence between Exchange and Domino. When using this method, one of the considerations would be Directory management. With a few modifications to the mapping tables, the Connector can be used for Directory synchronization only.

The second option would be name resolution when more than one Internet gateway is used (that is, IMS on Exchange and native SMTP routing in Domino).

The following sections describe the customization that is necessary to facilitate these two scenarios.

4.7.1 Customizing for SMTP as the mail transport

Note that if you use SMTP as the mail transport, you will lose some functionality that the Exchange Notes Connector and TFS provides (for example, DocLink conversion).

To synchronize the directories using Exchange Notes Connector, you need to modify the mapping tables to ensure that Exchange recipients appear as SMTP recipients in Notes, and Notes recipients appear as SMTP contacts or custom recipients in Exchange.
1. Install and configure the Connector to synchronize between the relevant Domino directories as discussed earlier in this chapter.

2. Stop the Connectors.

3. Edit the Amap.tbl in the dxaNotes directory (Figure 4-68).

<table>
<thead>
<tr>
<th>SMTPAddr</th>
<th>128</th>
<th>InternetAddress</th>
</tr>
</thead>
<tbody>
<tr>
<td>MailAddr</td>
<td>128</td>
<td>MailAddress</td>
</tr>
<tr>
<td>MailSys</td>
<td>4</td>
<td>MailSystem</td>
</tr>
</tbody>
</table>

4. Edit the Mapmex.tbl in the dxaNotes directory and add the following:

   MailAddr = Trim( SMTPAddr, "B" )
   MailSys = "5"

5. Edit the Amap.tbl in the dxamex directory and add the following:

   SMTPAddr   256 Proxy-Addresses(SMTP:)

6. Edit the MapNotes.tbl in the Dxamex directory and replace the existing line beginning with “TA=” with the following:

   TA = "SMTP:" ISEQUAL( MailAddr, "", ISEQUAL( SMTPAddr, ",", Replace( Strip( FullName, ",", "L", "R" ), ",", "_" ) \" Replace( Strip( MailDomain, ",", "L", "R" ), ",", "_" ) \"legacydomain.com" SMTPAddr ), MailAddr )
Modifying exchconn.ini for SMTP messaging

SMTP name resolution

If you send external SMTP mail from the Internet to a Domino user through the Microsoft Exchange Connector for Lotus Notes, it appends @SMTP@Connector_for_Lotus_Notes_Domain to the From field when it receives the message from the Exchange Server Internet Mail Service.

In our lab, when the external mail was received, the mail sender appeared to be normal, for example, external_user@external.domain.

This issue shows up when a reply to the external user is done. The reply destination address looks like:

external_user@external.domain@SMTP@Exchange_Foreign_Domain

This address format cannot be resolved, and an error message is received.

To resolve this problem, obtain the latest service pack for Exchange Server 5.5, and add the following parameter to the [LME-Notes-MEXOUT] section of the exchconn.ini file:

INCAPSULATESMTP=NO

According to Microsoft, the default value of this parameter is set to Yes. But in our example with Exchange SP4, the parameter didn’t exist at all. To add this parameter to the exchconn.ini file, perform the following steps:

1. Stop the Microsoft Exchange Connector for Lotus Notes.
2. Edit and save the exchconn.ini file. See Figure 4-69.
Chapter 4. Using the Microsoft Exchange Connector for coexistence

Figure 4-69  Exchconn.ini file

For new incoming SMTP mail, the reply address should now be displayed correctly.

SMTP address synchronization

We have already seen how to modify the directory mapping tables. By default, SMTP Addresses are automatically created by the directory synchronization. This is a problem when you send to the Internet and copy Notes users, or vice versa, when you have an Internet connection on either side of the mail system.
To ensure during a coexistence phase that internet addresses match, do the following:

1. Add a new field to Exchsrvr\Connect\Exchconn\Dxamex\Amap.tbl.
2. Add a second field (the length).
3. Add Secondary-Proxy-Addresses(Type:)
   
   Some examples are:
   
   SMTPAddr1 64 Proxy-Addresses(SMTP:)
   SMTPAddr2 64 Secondary-Proxy-Addresses(SMTP:)
   SMTPAddr3 64 Secondary-Proxy-Addresses(SMTP:)

5. Restart the Exchange Lotus Notes Connector and reload the directories.

Now the Internet addresses should be synchronized.
Using the TFS Gateway for coexistence

This chapter provides instructions on installing and configuring the TFS Gateway for connectivity between Lotus Domino and Microsoft Exchange.

The objective of this chapter is not to show the full functionality of the messaging server, but to merely demonstrate its usage as an alternative coexistence option, and to show the functionality related to it.
5.1 TFS Gateway

TFS Gateway, from TFS Technology Inc, acts as a messaging gateway allowing connectivity between disparate e-mail systems. Among the key features that TFS Gateway delivers are the ability to:

- Connect disparate messaging systems quickly and seamlessly, allowing all end users to communicate with each other. It makes communication transparent when supporting multiple e-mail systems in your company or across multiple Microsoft Exchange organizations.
- Provide reliable high-speed directory synchronization to streamline communication between disparate e-mail systems.
- Support multiple Internet protocols, including POP3, SMTP, and UUCP using modem dial-up, ISDN, or leased lines.
- Keep e-mail running when upgrading or moving to a new e-mail system.
- Deliver a suite of e-mail management tools, including centralized virus scanning and intelligent archiving and tracking capabilities.
- Scan for viruses. The gateway supports many of the popular virus scanning programs.

We are interested in TFS Gateway because it provides components offering connectivity to both Domino and Exchange servers, and therefore we can use it for coexistence.

TFS products are designed around a central server containing all the code for converting mail and attachments between the different formats. For message translation and fidelity, the TFS Gateway changes the format of an e-mail message into a generic TFS file format and then into the format of the destination e-mail system.

5.1.1 Coexistence-related features

The following list describes some of the TFS Gateway features that may be of benefit in the coexistence environment. It is not a complete list of the TFS Gateway features and benefits. For a complete list of the functions of the TFS products, refer to the company's Web site at: http://www.tfstech.com

The features pertinent to coexistence include:

- Directory synchronization: A configured option that allows you to automatically synchronize your directories on various e-mail systems. It allows you to synchronize the e-mail addresses in either SMTP or TFS format.
▲ Receipts: Supports both confirmation of read and confirmation of delivery receipts (COD/COR). In addition, you can use the AutoReply feature to automatically confirm mail delivery at the gateway level.

▲ Remote Administration: An HTML administration interface that allows administrators to log in from anywhere.

▲ Tracking/Archiving: This feature logs e-mails and attachments based on sender, receiver, and destination. The archiving can be used to keep copies of messages.

▲ Usage Statistics: The gateway collects data and can report on throughput from the total mail system level down to an individual user level.

▲ LDAP: The gateway supports LDAP by providing Internet Access to the local TFS Directory. However, the service is limited to providing full name and e-mail addresses only.

▲ Location Filtering: This is the anti-spam filtering feature of the TFS Gateway. It prevents mail from being received from specified IP addresses and/or Internet domains.

Figure 5-1 on page 148 shows the TFS Gateway installed in our lab environment.
5.2 Installing the TFS Gateway

There are a number of options for where to install a TFS Gateway. We opted, for management reasons, to install the gateway on a machine separate from both the Domino and Exchange servers.

We used the following steps to install the TFS gateway:

1. Set up Notes
   - Install Notes client on the gateway machine
   - Create a foreign domain for message routing
   - Create a router mailbox for message routing to the foreign domain
   - Create a foreign address book for TFS names
– Create an ID for the TFS gateway
– Set TFS gateway access rights on the Domino server

2. Set up Exchange
– Install Outlook
– Create an NT account for the TFS gateway
– Create an Exchange Account for the TFS gateway
– Set permission levels for the TFS gateway account
– Reboot and log in as TFS gateway

3. Install the gateway component of TFS secure messaging server
– Install components
– Configure the Exchange component
– Configure the Domino component

4. Set up Directory Synchronization and test the mailflow
– Set up Directory Synchronization and synchronize the directories
– Test the mailflow

The remainder of this chapter provides details about the installation, setup and use of TFS gateway

5.2.1 Prerequisites

**Hardware**
Intel PII 350 MHz Processor, 128 MB RAM, 1 GB available disk space

*Tip:* We recommend a machine with at least a Intel PIII 700 MHz processor, 256 MB RAM and 2 GB available disk space.

**Software**
- Windows NT V4.0 SP6a
- Microsoft Exchange Server 5.5 SP3
- Lotus Domino/Notes 4.5 or above
- Microsoft Outlook 98 or above

5.2.2 Setting up Notes

In this section we describe the order in which we set up Notes.
Step 1: Create a router mailbox for message routing to the foreign domain

The first step in preparing Domino for the TFS gateway is to create a mailbox in which the messages routed to the TFS gateway and onward to Exchange can be deposited. We named our mailbox TFS.nsf.

Create a new database from the Domino Administrator. (See Figure 5-2.)

- For the server name, enter the server that the gateway will connect to. In our example this is itsosrv1/itso.
- Enter tfs for the title.
- The filename will be created as tfs.nsf.
- Select the same server for the template server and select the Show advanced templates field at the bottom of the New Database dialog box.
- Select Mail Router Mailbox (6) [mailbox.ntf] as the template.
- Click OK to create the database.

You will be presented with the Mail Router Mailbox database’s About this database document. Press the Esc key twice to exit the document and the database.
Step 2: Create a foreign domain for message routing

The next step in preparing Domino is to set up a Foreign Domain for routing messages to the TFS gateway.

1. From the Domino Administrator, first click the Configurations tab.
2. In the navigation pane, expand Messaging by clicking the twistie and open the Domains view (Figure 5-3).

3. Click the Add Domain button to create a domain document.

Fill in the fields in the Basics tab as follows (see Figure 5-4 on page 152):

- Domain type: Foreign Domain
- Foreign domain name: This is an alias that will be used for the connectivity between TFS Gateway and Domino. We used Exchange as the name.
- Domain description: You do not need to fill in the description, although we advise you to do so for clarity.
4. On the Mail Information tab, shown in Figure 5-5, enter the name of the server on which you created the mailbox earlier, and the file name of the mailbox. In our example these were itsosrv1/itso and tfs.nsf.

5. Click Save & Close.

You have now created the foreign domain, as can be seen in Figure 5-6 on page 153.
Step 3: Create an ID for the TFS Gateway

The third step is to create an ID for the TFS Gateway using the Lotus Domino Administrator. If this is the first time you have used the administration client and if you have not already done so, create a link to the certifier ID (CERT.ID). If you skip this step, when prompted for the certifier ID later you will have to ensure a network path is available to the Domino server to access it.

1. Using your Domino Administrator, click the Servers Domain button and select your registration server. In our example the server name was itsosrv1/itso.
2. Select the People & Groups tab. You are now presented with the People view of the Domino Directory.

Click the People button under Tools on the right-hand side of the screen. Click Register, as shown in Figure 5-8.

![Figure 5-8 Select register person](image)

3. You may be presented with the Select Certifier ID dialog box (Figure 5-9). Select your CERT.id and, if necessary, change the registration server. Click OK and enter the certifier password when prompted.
Chapter 5. Using the TFS Gateway for coexistence

If you have not set up a Recovery ID process, a message pops up to warn you that the certifier does not contain recovery information.

4. Click Yes to continue.

5. You are presented with the Register Person - New Entry screen and can now create a person document for the TFS Notes Connector.

   Select the Advanced check box to see more options. (This box is located at the bottom left side of the window, and is shown in Figure 5-10 on page 156).

   In the First Name field, type TFS

   In the Last Name field, type NOTES

   We used these values because they are descriptive; you can use any values you like. However, as a minimum, you will need a last name entry.
6. Click the Password Options button (in the middle of the screen, see Figure 5-10) and move the scale to the Weak setting, so that the minimum password length field is 0 (optional).

This is required so that we can allow the gateway to run in unattended mode, meaning with no password prompt. Once set, click OK.

7. Select the Mail tab, and for the Mail type field, select None. All remaining options will be removed, as shown in Figure 5-11.
8. Select the ID Info tab. You will be presented with the certifier screen (Figure 5-12 on page 158). Make the appropriate selections for your installation.

- Select the level of security for your region: North American or International.
- Depending on the expected length of time for the coexistence, set the expiration date of the certifier at a safe point beyond your planned contingency. Setting it too early will stop the functioning of the TFS Notes Connector before you are ready to relinquish it.
- For the Store User ID field, select to store the ID in a file, and specify storing it in the default directory (D:\Lotus\Notes\Data\ids\People).

**Important:** You will need to copy this ID to the TFS Gateway machine’s Lotus\Notes\Data directory.
9. Click the green check box on the right-hand side of the window shown in Figure 5-12 to complete entering data for registration. Your person will be put in the Registration Queue.
Figure 5-13  Register the person

10. Click the Register button found in the bottom left of the window. The ID for the TFS Connector will be created, and a person document added to the directory.

11. When you receive the Register person window, click OK.

12. Click Done. This will return you to the People & Groups view in the administration client.

You have now created the ID file for the TFS connectivity and should copy it to the TFS Gateway machine in the Notes\Data directory.
Step 4: Create Foreign Names Directory

Use the following steps to create a foreign address book from the Domino Administrator client. This step is optional.

1. Select File → Database New (or Ctrl+N). A New Database dialog box, similar to the one shown in Figure 5-2 on page 150, will appear. Make the following entries and selections:
   - Server name: The server that the gateway will connect to. In our example this was itsosrv1/itso.
   - Title: TFSUsers
   - The filename will then be tfsusers.nsf
   - Select the same server for the template server.
   - Select the Show Advanced Templates check box at the bottom of the dialog box.
   - Select Domino Directory [pubnames.ntf] as the template.
2. Click OK to create the database.

Step 5: Install Notes client on the gateway machine

The next step is to install the Notes client on the gateway machine.

Note: For the installation of the Notes client see 4.2.1, “Step 1: Install the Notes Client” on page 79.

Once the client is installed, you will need to launch the client and set up Notes.

To set up the Notes client for the TFS gateway, you need the ID file created earlier. We placed the ID file in the Lotus\Notes\Data directory on the gateway machine.

1. Launch Notes by double-clicking the icon on the desktop. The Notes Workstation Setup dialog box appears.
2. Select the office network as the location and click OK.
3. You are presented with the Welcome screen shown in Figure 5-14. Click Next.
4. Enter your username and the server address when requested. In our example the user was TFS NOTES and the server name was itsosrv1/itso.

Check the I want to Connect to a Domino server box and click Next.

5. You will be presented with the ID Location screen. Here you need to provide the location of the TFS gateway ID file. In our case this was D:\lotus\notes\data\tnotes.id. Click Next.

6. The TFS gateway does not require any of the additional services. Click Finish.

This completes the setup of the Lotus Notes client code.

**Step 6: Set TFS gateway access rights on the Domino server**

The TFS gateway needs certain access rights on the databases in the Domino Directory. The ID needs manager access with delete rights to the TFS.nsf database we created earlier for the gateway routing.

1. Using the Domino Administrator client, go to the Files tab. Select the TSF.nsf file and right-click.

2. Select Access control → Manage, as shown in Figure 5-15 on page 162.
3. Click Add to add the TFS Notes user. Set the user type to Person, Access level to Manager, and select the Delete Documents check box. (Figure 5-16).

4. Click OK to approve your changes and to close the dialog.
The TFS Notes user also requires manager access to the MAIL.BOX.

1. In the Files tab of your Domino Administrator client, change the files that are shown in the view. Select Mailboxes only (Figure 5-17).

![Figure 5-17 Setting acl](image)

2. Right-click the main mailbox (ITSOSRV1 Mailbox in our case); the file name of it is mail.box. Select Access Control → Manage.

3. Add the TFS NOTES user, set the user type to Person, and set Access to Manager.

4. Click OK to approve your changes and to close the dialog box.

In addition, add the TFS Notes user ID to the ACL of the Foreign Directory created in “Step 4: Create Foreign Names Directory” on page 160 with Manager access with Delete rights.

Notes and Domino are now ready for the TFS gateway.

### 5.2.3 Set up NT and Exchange

We found the key to running the connector successfully to be in setting up the account for the TFS gateway correctly before installing the connector.

To add a user to NT, perform the following steps:

1. Start the User manager for domains by selecting Start → Programs → Administrative tools → User manager for Domains.

2. Create the NT use account. We specified the following characteristics:
   - Username: TFSGATEWAY
   - Fullname: TFS Gateway
– Description: TFSGateway Service Account
– Password: we set it to passwords
– We set all other parameters as shown in Figure 5-18.

![Figure 5-18  TFS gateway users properties]

3. We added the ID to the following groups (Figure 5-19):
   – Administrators
   – Domain Domains
   – Domain Users

![Figure 5-19  Adding to group permissions]

4. After we added the users to NT we created an Exchange account. (Note that this would normally be set to create an account automatically).
5. We then added the user to Exchange and gave him the properties shown in Figure 5-20.

To start the Exchange Administrator from the machine with the Exchange administration programs installed, select Start → Programs → Microsoft Exchange → Microsoft Exchange Administrator.

![Figure 5-20  TFS Gateway Exchange account](image)

6. We then set the properties of the domain to allow administration access for the gateway. See Figure 5-21 on page 166.
166

Migrating from Microsoft Exchange 5.5 to Lotus Notes and Domino 6

Figure 5-21  Selecting the domain

- Select the domain from the top of the Exchange tree.
- Select File → Properties to open the Domain properties.
- Click the Permissions tab. You will see the domain permissions dialog shown in Figure 5-22.

Figure 5-22  Properties of smbdomain
7. Add the TFSGateway with admin permissions by performing the following steps:
   a. Click Add.
   b. Select TFS gateway from the list and click Add.
   c. Click OK to close the dialog box.
   d. In the Roles drop-down list, select Admin.

The Exchange user is now ready.

5.2.4 Installing TFS Gateway

This section will walk you through the installation steps of the TFS Gateway. To install the TFS gateway, first of all download the code from:
http://www.tfstech.com

1. To install the TFS gateway launch the setupgw47.exe from the directory you saved the downloaded files from TFS. Click Yes to the installation prompt shown in Figure 5-23 on page 167

![Figure 5-23 Launch the TFS Gateway installer](image)

2. Click Next on the installation Welcome screen (Figure 5-24 on page 168).
3. Enter your username and organization and click Next (See Figure 5-25).

4. We used the default directory (c:\TFS47). Click Next.
5. Click Next at the copy files screen.
6. On the screen shown in Figure 5-27, select New installation and click OK.
7. The install wizard is launched. You will need to enter registration codes and selection of components.

8. Click to accept the licence information.

9. You will be presented with the module selection screen shown in Figure 5-28.
   a. From the Select module drop-down list, select the Connection Module Lotus Notes.
   b. Enter the License code or select the As an Evaluation Copy option.
   c. Click Next.

![Figure 5-28 Installation module selection](image)

10. As shown in Figure 5-29, make the following exchange component selections:
    a. From the Select module drop down list, select the Connection Module MS Exchange.
    b. Enter the License code or select the As an Evaluation Copy option.
    c. Click Next.
Chapter 5. Using the TFS Gateway for coexistence

11. Click Next. The TFS gateway will now bring you to the install software screen shown in Figure 5-30. Click Continue.

When the installation program has finished copying the files, it will bring you to the setup wizard.
The configure wizard shown in Figure 5-31 allows you to select the installed gateways and will guide you through the simple steps of configuring the wizard for each gateway component.

12. Ensure that both Lotus Notes and Microsoft Exchange are selected and click Start Wizard.

![Figure 5-31 Configure gateway wizard](image)

**Installing the Lotus Notes Connector**

1. You will be asked for the path for the Lotus Notes ini file. If you are not sure what it is, click Browse and search. The ini file should be in the notes programs directory; in our lab this was c:\lotus\notes\notes.ini.

![Figure 5-32 Enter Notes ini path](image)
The tool will scan the ini file for all the information it requires for the rest of the setup.

2. The screen shown in Figure 5-33 is returned. Enter any password you may have set up; in our testing we left the password blank. Click Next.

![Figure 5-33](ID password request)

3. The Notes Domain screen shown in Figure 5-34 will appear. Enter the Domino Domains that the gateway will route to. In our example this is smbnotes. Click Add, then Next.

![Figure 5-34](Notes Domain list)
4. You will be presented with the confirmation screen shown in Figure 5-35. If everything is OK, click Finish. Otherwise, click Back, and correct as necessary.

Installing the Exchange connector

The wizard for Exchange configuration starts next.

1. You will be prompted to provide the name of the Exchange Organization, as shown in Figure 5-36. Enter your exchange organization name and click Next.
2. The next screen requests the Exchange Organization Unit. Actually, it is requesting the site name. In our example this was Headquarters. Click Next.

![Figure 5-37  Exchange Organization Unit / Site]

3. Regardless of whether or not you want TFS to handle SMTP domains, it requests the smtp domain names from Exchange.

   **Important:** Do not enter any domains.

4. Click Next.

5. You will be presented with the configuration confirmation screen. If everything is OK, click Finish.

![Figure 5-38  Exchange connector setup summary]
You will return to the install wizard. Click Finish.

**TFS Exchange Gateway installation**

There is an additional step required on the Exchange Connector installation.

1. Verify that a supported copy of Microsoft Outlook has been installed—the TFS Gateway requires this for its MAPI interface to Exchange.

2. Run the exchinst program as follows:

   Start → Run → browse → c:\tfs47\exchinst.exe

3. You will be presented with the gateway installation selection screen shown in Figure 5-39. Click the Gateway button to start the TFS Exchange Gateway installation.

   ![Gateway installation selection](Figure 5-39)

   You will be presented with a screen to select the Exchange server. By default you are presented with the machine name you are currently logged on to.
4. If you are not installing on the Exchange server or the Exchange server name is different from the machine name, enter the Exchange server name and click Continue.

![Figure 5-40 Exchange server name entry](image1)

5. You will be required to select the Exchange Site that the connector will be configured with, as shown in Figure 5-41. Select your site and click Continue.

![Figure 5-41 Select Exchange site](image2)

6. Select the address type (Figure 5-42).

We selected TFS since we wanted to create a pure Domino to Exchange connection.
Gateway components are now installed, a MAPI profile is created and user settings are set on the Exchange server.

7. You will be presented with the Setup is complete dialog shown in Figure 5-43. Click OK.

The installation of the Exchange gateway is now complete.

**Modify the site addressing for TFS addresses**

By default the TFS e-mail addresses for the Exchange users will be created as:

firstname lastname @ Sites/Org

Since we cannot route to a domain in Notes of site/org, we need to change the site addressing. Use the following steps to do this:

1. Start the Exchange administrator.
2. Under your site, under Configuration, double-click Site addressing (Figure 5-44 on page 179).
3. Select the Site Addressing tab, highlight the TFS address line, and click Edit. (Figure 5-45).

Figure 5-44  Selecting Site Addressing

Figure 5-45  Select TFS site addressing
4. Change the address from @Sites/Org to @Domain. In our example this is from
@Headquarters/smbdomain to @Exchange (Figure 5-46).

Exchange is the name of the foreign domain we created earlier.

5. Click OK to accept the change.

6. You may received a notification on the addressing changes as shown in
Figure 5-47. Click Yes to verify.

**Directory Synchronization configuration**

Additional minor configuration is required for Directory Synchronization. We need
to change the addressing type for Exchange from SMTP to TFS, and set a
domain space for synchronization.

**Setting Exchange Address space and Gatename**

1. Start the TFS administrator by selecting Start → Programs → TFS
Gateway → TFS Administrator.

2. Click Connection Modules.

3. Double-click MS Exchange connection (Figure 5-48 on page 181).
Chapter 5. Using the TFS Gateway for coexistence

Figure 5-48  Select the exchange connector

This will launch the properties page for the Exchange connection (Figure 5-49).

Figure 5-49  Properties page for Exchange connector
4. Click the Advanced tab and change Address Type to TFS instead of SMTP (Figure 5-50).

**Note:** Throughout our testing, regardless of the selection of addressing type that we chose during the installation and setup, the tab was always set to SMTP, so we needed to change it.

![Figure 5-50 Notes connector properties](image)

5. Click the General tab to return to the main properties page.

**Setting the Gatename**

We now need to enter a gatename for the Exchange connector to use for storing the directory entries from Exchange. This will be used by TFS to create the alias Domino addresses, so the gatename should match the domain name created earlier.

1. Click Add to add a new Exchange site.
Enter the Site/Organization alias described previously (see “Modify the site addressing for TFS addresses” on page 178). In our lab this was Exchange (Figure 5-51).

![Exchange Sites dialog]

**Figure 5-51  Setting the gateway**

2. Click OK to close the Exchange site dialog.
3. Click OK to close the TFS Exchange Connector Setup dialog.

You should be back at the main administration screen.
Setting Notes target address book

1. Double-click the Lotus Notes Connector (Figure 5-48 on page 181). This will present you with the properties page for the TFS Lotus Notes Connector setup, as shown in Figure 5-52.

![Figure 5-52](image)

**Figure 5-52  Notes connector properties**

2. Do not change anything in the General page.

3. Click the Domain/Organization tab. Here you can configure the source and target address books (Figure 5-53).
4. Enter the target address book name. We called ours tfsusers.nsf.

5. Click OK to accept the changes and to close the TFS Lotus Notes Setup dialog.

**Starting the TFS Gateway server**

You are now ready to start the server.

Select Start → Programs → TFS Gateway → TFS Gateway Server to start the server.

This will start 3 modules:

- **TFS Server**: The gateway server component
- **TFS4LN**: The Lotus Notes Connector component
- **TFS4EXUN**: The Exchange Connector component

**Note:** If all three modules do not start, there might be a configuration problem. Double check all settings and try to start the server again.
1. If all services have started from the TFS administrator, start the directory synchronization. Click Tools → TFS Directory Sync → Lotus Notes (Figure 5-54).

![Figure 5-54](image)

**Tip:** It is possible to have the server started as an NT service. To do this from a command prompt, start the server with the `/install` command.

```
C:\TFS47\Tfs4gvc.exe /install
```

**Importing Notes users to TFS Directory**

1. If all services have started from the TFS administrator, start the directory synchronization. Click Tools → TFS Directory Sync → Lotus Notes (Figure 5-54).

![Figure 5-54](image)

2. Select the Import Users from Lotus Notes to TFS Gateway option (Figure 5-55).

![Figure 5-55](image)

3. Click Start Dir-Sync.

The Notes synchronization will be requested.

**Importing Exchange users to TFS Directory**

1. Next run the import from Exchange. Click Tools → TFS Directory Sync → MS_Exchange.
2. Select the Import Users from Microsoft Exchange to TFS Gateway option (Figure 5-56).

3. Click Start Dir-Sync.

![Figure 5-56 Start Exchange Dirsync](image)

The Exchange synchronization will be requested and completed.

You now have a fully populated TFS directory.

**Verifying the user information import results**

If you want to check the users from the Exchange Administration screen, select one of the groups. In our example (shown in Figure 5-57) we selected the smbnotes group.

![Figure 5-57 Refresh users view](image)

Click the icon with a computer and lightning bolt to refresh the list.
Exporting the Notes users from TFS Directory to Exchange

Now that we have a full directory in the TFS server, we need to synchronize the Exchange recipients to the tsusers database and the Lotus Notes users to the Notes container in the GAL.

1. Click Tools → TFS Directory Sync → Lotus Notes (Figure 5-54 on page 186).
2. Select the Export Lotus Notes users to other e-mail system and click the Start Dir-Sync button. The Notes users will now be added to the Exchange GAL. Figure 5-58 shows the Exchange Administrator for the example of Notes users in the GAL.

Exporting the Exchange users from TFS Directory to Notes

2. This time select the Export MS Exchange users to other e-mail system and click the Start Dir-Sync button. The Exchange recipient users will now be added to the tsusers database in Domino. See Figure 5-59 on page 189 for an example of users in the Notes directory.

Figure 5-58  Notes users in the GAL
Testing the mail flow
After we synchronized, we tested e-mail flow between the addresses without any problems.
Using SMTP routing for coexistence

Simple Mail Transfer Protocol (SMTP) is a coexistence option for organizations that do not need long-term coexistence or cannot, for various reasons, implement the MS Exchange Connector for Notes. SMTP coexistence requires SMTP to be running in both environments.

This chapter covers the following topics:

- Overview of SMTP in both the Microsoft Exchange 5.5 and Lotus Domino 6 environments
- Requirements for the Exchange IMC (Internet Mail Service)
- Configuring and customizing the Exchange IMS
- Configuring Lotus Domino 6 for SMTP message transmission
- Using SMTP in the Microsoft Exchange and Lotus Domino environments
6.1 SMTP coexistence scenario

The scenario for our examples has two SMTP domains, as illustrated in Figure 6-1.

![Figure 6-1 SMTP coexistence: Two domains](image)

6.2 Overview of the SMTP environment

In our discussion of the SMTP environment, we describe message transmission between Microsoft Exchange 5.5 and Lotus Domino 6.

6.2.1 Microsoft Exchange 5.5 SMTP support

The Internet Mail Service (IMS) is the SMTP server component of Microsoft Exchange Server. It provides message transfer and translation between a Microsoft Exchange Server computer and SMTP messaging systems, such as the Internet. You can also use the IMS (Internet Mail Service) to connect to foreign X.400 systems or to connect Microsoft Exchange Server sites that are not on the same local area network (LAN).
6.2.2 Lotus Domino 6 SMTP environment

With the introduction of Lotus Domino R5, the Domino router provides mail routing over both SMTP and Notes routing protocols, thus eliminating the need for installing an SMTP MTA. Therefore, the Domino server can act as an Internet mail server, using SMTP/MIME, POP3, and IMAP4, as well as a Domino messaging server. This means that users can send mail in either Notes format or MIME format. Because Domino automatically converts between Notes and MIME format as required, clients can send and receive mail with no concern about format. For example, if a Notes client sends a Notes-formatted message to an IMAP client, Domino converts the message to MIME format for the IMAP client.

6.2.3 Configuring the Microsoft Exchange Internet Mail Service

This section describes how to establish SMTP message transmission to Exchange using the Internet Mail Service.

**Pre-configuration tasks**

Before you configure the Internet Mail Service to communicate with Domino, you should review the following list to ensure that the environment is configured correctly and that you have the information needed to complete the Internet Mail wizard.

- We are assuming that you already have the Exchange IMS configured to route to the Internet via a direct connection or by transferring messages to a smarthost.
- Know the SMTP addressing schemes for your organization.
- Determine the SMTP address for the site.
- Determine the address space the Internet Mail Service services.
- Obtain the host name and domain name of the computer on which the Internet Mail Service is installed.
- Determine whether Domain Name System (DNS) is used to provide host and domain name-to-Internet Protocol (IP) address resolution.
- Obtain the IP addresses of DNS servers or the SMTP hosts that service the Internet Mail Service.

**Configuring the IMS**

1. Open the Exchange Administrator program (Figure 6-2).
2. Click the Connections icon, which looks like a small globe with a network connection at the base.
3. Highlight the Internet Mail Service in the right-hand pane. To open the properties page, click File → Properties.

![Exchange IMS Properties Page](image)

4. Click E-Mail Domain and verify the current SMTP e-mail domain. In our example, the Exchange SMTP domain is `smbdomain.com`.
5. Click the Connections tab, then click the E-Mail Domain button in the Message Delivery section (Figure 6-6). This brings up another window (Figure 6-7) where you enter the SMTP domain information for the Domino SMTP domain. By adding the Domino SMTP domain to the Message Delivery section, you are telling the Exchange IMS to route all messages that are destined for the Domino SMTP domain to be delivered via that path or IP address.
6. Click the Add button to add the SMTP e-mail domain of the Lotus Domino environment. In our example we used the SMTP domain smbnotes.com (Figure 6-7).

Figure 6-7  E-Mail Domain properties page (routing to domain info)
7. Enter the SMTP domain name in the E-Mail Domain input box (Figure 6-8). In our example we entered smbnotes.com. In the Delivery section, click the Forward all messages for this domain to host: box, then enter the IP address or hostname of the Domino server that will receive SMTP mail. We entered the IP address of our Domino server. The IP address or hostname that you enter must be on your routed network.

![Figure 6-8  E-Mail domain delivery information](image)

8. Click OK to save these settings.

9. You should see the window shown in Figure 6-9 with your target Domino domain added as a destination host.
10. Once you make a routing change to the IMS, the IMS service needs to be restarted. You will be prompted with the dialog box shown in Figure 6-10.

11. Click OK to proceed to save the settings. Then bring up the Control Panel by clicking Start → Settings → Control Panel, then click the Services icon.

12. The Services window will appear. Scroll down to the Microsoft Exchange Internet Mail Service. Click Stop. Click Yes when you are prompted with the dialog box shown in Figure 6-11.
13. When you click Yes, you will see the dialog box shown in Figure 6-12.

14. After the service stops, click Start. You will see the dialog box shown in Figure 6-13.

6.2.4 Configuring Lotus Domino 6 for SMTP message transmission

In this section we describe how to customize the Lotus Domino server for SMTP mail traffic.

You must make several modifications to the Lotus Domino 6 server to establish SMTP support. The necessary steps are as follows:

- Prepare the server to send and receive Internet mail via the Global Domain document.
- Update the Server document to listen for incoming SMTP connections (receive SMTP mail from other servers in your organization and from the Internet).
- Update the Configuration Settings document to do the following:
  - Use SMTP to send mail outside the local Internet domain.
  - Use SMTP inside your local Internet domain.
Ensure the Person document for the Notes user reflects the correct Internet address.

Creating the Global Domain document
You need to tell the Domino Server how to deal with Internet or SMTP mail routing. We are assuming that you have an internal secured LAN or WAN connection to the Exchange environment that you wish to communicate with.

You need to tell the Domino Server where to send messages that are destined for your internal MS Exchange environment. If you let Domino use DNS to resolve the domain address, DNS would return the address of the Exchange Server's Internet-based IP presence. This would route message to the Exchange server over the Internet. While this is an option to consider, the current discussion is about how to create a secure internal route to the Exchange Server. To establish SMTP message transfer, begin by customizing the Global Domain document, using the following steps:

1. From the Domino Administration client, click the Configuration Tab of your Domino Server (Figure 6-14).

![Figure 6-14 Domino Administration Program (Configuration tab)]
2. From the Messaging navigator, select Domains.

3. Click the Add Domain button.

4. Click the pull-down list selector to choose the Domain Type that you are creating. The default, pictured here, is Foreign Domain. Scroll down and select a Global Domain document, then click OK.
5. Type or select the appropriate entries to complete the Basics tab. In our case, we specified the following:
   - Global domain name: EXSMTP
     
     **Tip:** This field name must correspond to the Server document field for the MTA/SMTP Global Domain Name field for Release 4.x.

   - Global domain role field: R5 Internet Domains or R4.x SMTP MTA. We selected this from the Global domain role pull-down list (Figure 6-17).
   - Use as default Global Domain (for use with all Internet protocols except HTTP) was checked as Yes.

![Figure 6-17 Global Domain type selection box](image)

6. The Basics tab after the changes is shown in Figure 6-18.
7. If appropriate, accept the defaults on the Restrictions tab. In our case, we did not change any settings on the Restrictions tab.

8. Click the Conversions tab.
9. In order for Domino to properly configure the address lookup and address generation, make the necessary changes to the defaults. Type or select the appropriate entries. In our case, we specified the following:
   - Local primary Internet domain field: smbnotes.com
   - Local part formed from field: Short name
   - Notes domain(s) included field: None
   - Notes domain(s) position field: Right of '@'

10. If appropriate, accept the defaults on the Administration tab. In our case, we did not change any settings on the Administration tab.

11. Save and close the Domain document.
On the Domains view shown in Figure 6-20, you can see our newly created Global domain called EXSMTP.

This completes the procedure to create and modify the Global domain document.

**Implementing the SMTP listener task**

You now need to tell Domino to listen for SMTP traffic. You also need to define the Internet domain names that this Domino environment will be servicing. Use the following steps to customize the Server document for the SMTP listener task.

1. From the Server navigator on the Configuration tab, select the All Server Documents view.
For the purpose of this discussion, we assume you are working with the itsosrv1/itso server, and have your environment set up like in our lab.

2. Select the itsosrv1/itso server.

3. Click the Edit Server button.
4. In the Fully qualified Internet host name field, specify itsosrv1.smbnotes.com.

5. Enable the SMTP listener task field.

6. No fields on the other tabs for the Server document need to be modified.

7. Click the MTAs tab.
8. In the Global domain name field, type EXSMTP.

9. Save and close the Server document.

The SMTP listener task is now enabled.

**Establishing SMTP message routing**

Use the following steps to set up the SMTP routing for both internal and external Internet mail.

1. From the Messaging Navigator, select Configurations view.
2. Click the Add Configuration button.
3. For the Group or Server name field, specify itsosrv1.smbnotes.com.

4. Click the Router/SMTP tab.

5. On the Basics tab, type or select the appropriate entries. In our case, we specified the following:
   - Number of mailboxes: 3

   **Tip:** During our testing, we only specified one SMTP mailbox, but a good rule of thumb would be to specify two mailboxes, in order to better serve a production messaging volume.

   ▶ SMTP used when sending messages outside of the local Internet domain: Enabled
   ▶ SMTP allowed within the local internet domain: Disabled

6. For the remaining tabs (Restrictions and Controls, Message Tracking, and Advanced), we made no changes and accepted the defaults.

7. Save and close the Configuration document.
Updating the Person document

The last step in establishing SMTP message transmission is to ensure that the Person document reflects the appropriate Internet address for your Notes user, given the SMTP configuration steps described previously. Do this by following these steps:

1. From the Person document, click the Mail tab.
2. Update the Internet address field for the user, if required.

3. In the Internet address field for your user, enter the user’s SMTP address. For our user, Sean Long, we set up Sean’s SMTP address when we created his ID.

All the documents have been configured within the Domino 6 server to enable SMTP message transmission.

6.2.5 Sending mail between Exchange and Domino 6 via SMTP

You are now ready to test the SMTP message transmission between Microsoft Exchange and Lotus Domino. For our scenario, we have Microsoft Exchange user, Kurt Nielsen, send an e-mail message to a Notes user, Graeme Povall. The Notes user will then reply to the message.
Tip: Before you begin, make sure that the SMTP task has been loaded onto the Domino server and that the Microsoft Exchange IMS has been restarted on the Exchange server.

1. User “Kurt” logs on to the Exchange server with his profile.

   ![Microsoft MAPI profile](image)

   **Figure 6-28** Microsoft MAPI profile

2. The user’s inbox is presented.

   ![Outlook 98 (Inbox View)](image)

   **Figure 6-29** Outlook 98 (Inbox View)

3. From Exchange, the user “Kurt Nielsen” creates a mail message to the Notes user, “Graeme Povall.”
4. The Lotus Notes user, “Graeme Povall” logs in and opens the e-mail message sent via MS Exchange and delivered via SMTP.

5. The Lotus Notes user then replies to the Microsoft Outlook user sending the message back over the SMTP connection.
6. The Lotus Notes user creates an address book entry for the MS Exchange user and enters that user's SMTP address.
7. The Notes user sends the message to the Exchange user.

---

Figure 6-34 Lotus Notes e-mail to MS Exchange user

---

Kurt

This is a message sent from Notes/Domino to MS Exchange via SMTP.

Thanks,

Graeme

P.S. Please reply.
Using Microsoft Exchange Calendar Connector

This chapter provides detailed instructions on installing, configuring, and using the Microsoft Exchange Calendar Connector.
7.1 Overview of the Calendar Connector

The Calendar Connector runs as a Windows NT Service on the Microsoft Exchange server. It provides for free/busy time searches between Lotus Domino Systems and the Microsoft Exchange Server.

On Microsoft Exchange the free/busy time calendar information for users is stored in the free/busy public folder. Lotus Domino stores users’ free/busy time calendar information in a Domino database called Busyt ime.nsf.

When Lotus Notes and Domino users are added to the Microsoft Exchange Server directory via directory synchronization, their free/busy calendar information is also stored in the free/busy public folder on the Microsoft Exchange Server. Thus, when an Exchange user queries a Domino user’s busy time, the most up-to-date data is retrieved by the Calendar connector.

When a Lotus Notes user queries an Exchange user’s calendar, the Schedule Manager attempts to supply the data. After checking the Domino Directory and determining that the target user is not on the local Domino server, it will pass the query to the Calendar Connector task for the other system. In the case of the Exchange Foreign Domain, the Calendar Connector task that will be used is called the Exchange Calendar Connector task (EXCALCON).

7.2 Installing the connector

Your Exchange Server must be at Service Pack 2 level in order to use this function, and you must have the Lotus Notes connector installed and configured.

You need to be logged onto the Exchange Server with administrator privileges to install the Connector. Use the following steps to install the Connector.

Note: You can download the installation file CALCONW3.EXE from the Microsoft Web site.

1. Locate and launch CALCONW3 to begin the installation.
2. At the Welcome screen click Next.
3. You will be presented with the licensing agreement. After reading the licensing agreement, click Yes to proceed.
4. A dialog box asks you if you wish to install the Calendar Connector; click Yes.
5. In the Services Username and Password dialog box, type the name of your Exchange administrator and the password, and confirm the password (Figure 7-1). Click Next.

![Figure 7-1 Admin ID request](image)

**Important:** The account should be the same one that was used to install the Microsoft Exchange Server software.

6. The program will begin to copy files to your hard drive and a status screen will be displayed providing messages about the installation.

When complete, a dialog box appears telling you the installation was successful. Click OK to proceed.

7. Close all windows.

The general installation of the software is now complete. The following steps will assist you in the configuration of the program.

### 7.3 Configuring the Connector

Now that you have installed the Calendar connector software, use the following steps to configure it.

1. You must be in the Exchange Administrator program to do the configuration. Launch the Exchange Administrator program.
2. From the Connection container, double-click the Calendar Connector by selecting Organization → Site → Connectors → Calendar connector.

3. Select the General tab (Figure 7-3).
– The Exchange field contains the name of the Exchange server you will be using.
– The Exchange site containing custom recipient addresses of users on connected systems field should be set to the Exchange site you are using.
– The Number of days of free/busy information to request from foreign calendars field defaults to 60 days; we accepted the default.
– The Maximum age in minutes of foreign free/busy data in Exchange that can be used without querying the foreign calendar field defaults to 15 minutes; again we accepted the default.
– The Maximum number of seconds to wait for response from foreign calendars field defaults to 15 seconds; we found this to be adequate.
– The Administrative Note field can be updated with descriptive information.

4. Click Apply to accept the changes.

### 7.3.1 Creating a connection

1. Select the Calendar Connections tab.

![Figure 7-4](image-url)  
*Figure 7-4  The connections tab*
2. Click the New button to create a new connection.
3. From the Calendar Type dialog box, select Lotus Notes (Figure 7-5).

![Calendar Connector (EX01) Properties]

**Calendar Connector (EX01)**

---

4. Click OK.

You will be presented with the Notes Calendar Connection dialog box; our completed one can be seen in Figure 7-6 on page 223.

- In the Connection Name field, type a descriptive name. We used Lotus Notes.
- In NT Server Hosting the Notes Server field, type the network name of the computer that the Domino Server is running on. You can use either the network name or the IP address. We used the IP address.
- In the Path to the local Notes.ini file field, type the full path to the Notes.ini file.
5. Click OK.
6. Click Apply to apply your changes.

### 7.3.2 Creating a schedule

The schedule controls how often and when the connector will become active. Based on the frequency of calendar updates, you should set the value accordingly. We found it difficult to judge this, so we chose to have it active at all times. This means the connector will update information every 15 minutes.

1. Click the Schedule tab (Figure 7-7 on page 224).
2. Select Always for the schedule, or select Selected times if you want to specify times when the connector is activated.

3. Click Apply and accept the changes.

### 7.3.3 Diagnostics logging

The Diagnostics Logging tab, shown in Figure 7-8, allows you to set the level of logging that will be recorded to the event logs.

By default, the logging level is set to none. If you experience problems with the calendar connector you will need to raise the level accordingly.
7.3.4 Permissions

The final tab is the Permission page, shown in Figure 7-9. The permission should have been picked up by the login account; however, you have the opportunity to modify the permissions here. In our case, we did not have to make any modifications.
You have completed the customization of the property pages.

7.3.5 Other modifications

Some minor modifications to files on the Exchange Server are necessary for the Calendar connector.

The Calendar Connector provides an amap.tbl file. You will need to update the one used by the Calendar Connector. The file can be found in the path \exchsrvr\connect\exchconn\dxaNotes, as shown in Figure 7-10 on page 227.
To update the file:

1. Open the amap.tbl file in Notepad.

2. Using the Microsoft document, README.RTF located in \exchsrvr\connect\calcon, modify the appropriate fields in AMAP.TBL. An extract of the file is shown in Figure 7-11. Change the calendar domain line (CALDOM) and add a mail server line (MAILSRV) as per the document. A modified amap.tbl can be seen in Figure 7-12 on page 228.
3. Save and close the amap.tbl.

### 7.3.6 Modify Domino server configuration

The Calendar Connector provides an EXCALCON add-in task for the Domino server, which allows Notes users to check Exchange free/busy time.

To make this task available:

1. Locate the EXCALCON.EXE file. It should be in a subdirectory on the Exchange Server (generally, the path is `exchsrvr\connect\calcon\excalcon\i386`).
2. Either copy the file to a disk or, more conveniently, set up a mapped disk to the Microsoft server and place the EXCALCON.EXE in the Domino executable directory on the Domino server. (Prior to R5 the path was ..\Notes; in R5 and upwards the directory is ..\Domino. In our environment this was c:\lotus\Microsoft.)

The required program files are now on the Domino server.

The next customization step is to update the Foreign Domain document. Perform the following steps from the Domino Directory:

1. Select the Foreign Domain document for Exchange and open it in edit mode.
2. Click the Calendar Information tab.
3. In the Calendar server name field, type the name of your Domino server that the Exchange connector will communicate with. In our case this was itsosrv1/itso.

4. In the Calendar system field, type the name of the mailbox used by the connector (EXCHANGE.BOX in our example).

5. Click Save and Close.

You have customized the Connectors and are now ready to operate them.

7.4 Operating the connectors

Starting the calendar connector requires 2 operations:

1. Start the Calendar Connector service on the Exchange server.
   - You start this the same way as any other service in Windows NT. Open the Services list and select the Microsoft Exchange Calendar Connector. This service will have no status and a startup option of Manual. See Figure 7-14 on page 230.
Migrating from Microsoft Exchange 5.5 to Lotus Notes and Domino 6

2. Start the Calendar Connector add-in task on the Domino server.

From the Server Console, type:

```
load excalcon <server name> <system name>
```

where `<server name>` is the name of the Exchange Server and `<system name>` is the Connector's mailbox name (EXCHANGE.BOX).

In our example this was:

```
load excalcon ex01 Exchange.box
```

The Exchange Lotus Notes calendar connector has now started. Run some tests to verify that it is operating successfully.

To enable this on startup, add the excalcon task to the end of the server tasks line of the Notes.ini, leaving off the load statement. For example:

```
excalcon ex01 Exchange.box
```

### 7.4.1 Examples of busy time lookup

We ran a few tests to verify that the connector was working as expected. This section displays some screen shots showing our test results.
In our first test we checked that the connectors where operating correctly:

- We created a meeting in Notes and then checked for availability of some users in Exchange. The results are shown in Figure 7-15.

- We then modified Kurt's calendar to mark some of his time as unavailable and ran the test again. The results are shown in Figure 7-16 on page 232.
In our test, the objective was to check that the connectors were operating correctly. We ran the same test again—but this time from Outlook—with the same expected results.

We ran further tests with the calendar connectors stopped, and again the expected results were obtained, showing no information available.

**Monitoring the connectors**

There is a console task on the Exchange Server to monitor calendar connector activity. To start the task to monitor the connector:

1. Choose Start → Programs → Run → Browse.
2. Go to the directory with the CALCON.EXE file (exchsrvr\connect\calcon).
4. Watch the messages on the console.
5. Close the window to close the Calendar Connector console.
6. On the Microsoft server you can check the status of the connector.
7. From the Domino server console: Issue the command `show tasks`.

**Note:** When EXCALCON is first started and no free/busy query has yet occurred, the status returned is "Not Connected." This is normal. Once the first free/busy query of an Exchange user is performed, the status returned is "Connected."
Coexistence results – SMTP routing

This chapter displays the results of SMTP coexistence between Microsoft Exchange 5.5 and Domino 6. We connected two environments that had two different domains via SMTP. For the purpose of this discussion, we are assuming that users are going to add e-mail addresses manually.
8.1 Coexistence scenario

Figure 8-1 shows how SMTP message traffic flows in the test environment. The Exchange server and the Domino server transfer messages via SMTP to the other domain via the internal secure network, and only send messages to the Internet that are not destined for the other domain.

8.2 Results of various tasks in the coexistence scenario

In this section we describe various tasks that a user would perform using either Notes or Outlook client.

8.2.1 Adding a Notes recipient into Contacts in Outlook

1. Start off using MS Outlook, as shown in Figure 8-2 on page 237.
2. Create a new contact by selecting File → New → Contact. The new Contact dialog is shown (Figure 8-3).
3. Click the address book icon in the right-hand side of the screen. It will show return the Address book dialog.

Select Outlook Address book. There are currently no contacts in the address book (Figure 8-4).

![Create an Outlook Address](image)

4. You are going to add an address of a Notes user to the Outlook user's address book. When you click the New button in the Address book window, a new Contact dialog is shown. Choose Internet Address as the entry type.

![Address type](image)
5. Enter a display name and the email address of the person (Figure 8-6). Notice the domain name is smbnotes.com.

6. Click OK. You are returned to the Address book dialog. You can now see that an entry has been added (Figure 8-7).
8.2.2 Adding a Notes recipient into a message in Outlook

1. When creating a new memo, click the To button to add a recipient address to the memo. The Select names dialog is shown in Figure 8-8.

2. Select the address book entry you just created and click the To button to add it as a message recipient. Click OK.

3. The name of the recipient is added to the To field. Type in the message and click Send to send the message.
8.2.3 Adding Exchange recipient to Personal Address Book in Notes

1. With Notes open, open the personal address book open. Click New and select Contact from the drop-down list (Figure 8-10).

2. A New Contact document is shown in Figure 8-11 on page 242.
3. Click the icon next in the Email field. The Mail Address Assistant dialog is returned (Figure 8-12).

4. Choose Internet Mail as the mail system for your contact person. The Internet Mail Address Assistant dialog is returned, as shown in Figure 8-13.
5. Type in the first name, last name, and e-mail address. Notice the domain name is \textit{smbdomain.com}. Click OK. You are returned to the contact person document. The name fields as well as the e-mail field have been filled in.

6. Click Save & Close.

7. Open your mail and create a new memo. Click the To link to add a recipient address. The Select Addresses dialog is shown (Figure 8-15 on page 244).
8. After selecting the recipients, click OK. The recipient address is added to the e-mail (Figure 8-16).

9. Type your message and click Send to send the message.
8.2.4 Results of sending e-mail between Exchange to Notes

Now, let’s take a look at the results of sending e-mail between the two systems.

1. Figure 8-17 shows the inbox of our Notes user, Graeme. It shows that Graeme has received an email from Exchange user Kurt.

![Outlook SMTP message received in Notes Inbox](image)

2. Double-click the message in the view to open it; you can see that the message has been send by kurt@smbdomain.com.
3. Click Reply to create a reply message (Figure 8-19).

---

**Figure 8-18  Outlook SMTP message being sent to Notes recipient**

**Figure 8-19  Notes reply to SMTP message sent via Outlook**
4. You can now change users and take a look at your Exchange user's (Kurt's), inbox. You can see that the inbox has a reply message from Graeme. (Figure 8-20).

![Figure 8-20](image)

**Figure 8-20**  SMTP message received in Notes from Outlook user

5. Double-click to open the message. You can see that the message came from Graeme.Povall@smbnotes.com. (Figure 8-21).
To change the message format setting in Notes, do the following:

a. Select File → Preferences → User Preferences. The User Preferences dialog is shown.

b. Change the Internet mail format field from Plain Text only to HTML and Plain Text (Figure 8-22 on page 249).
6. Now, send a new message from Notes to the Exchange user. (Figure 8-23). The result in Outlook can be seen in Figure 8-24 on page 250.
Figure 8-23  Sending an email to a Exchange user in HTML format

Figure 8-24  A message send from Notes in HTML format
Migration
Migrating users using Domino Upgrade Services

This chapter provides a step-by-step procedure to migrate users and other server data from an existing Microsoft Exchange environment to a Lotus Domino 6 server. This is accomplished using the Domino Upgrade Services (DUS) tools.

This chapter covers:

- Installation of the administration client and migration tool
- The migration process itself
9.1 Preparing to migrate Microsoft Exchange users

The DUS migration tool in the Domino Administrator client allows you to easily migrate information from your existing Microsoft Exchange messaging and directory system to Domino 6. With DUS, you can import users from the foreign directory, such as the Exchange Global Address List, register them as Notes users, and then convert the mail from an Exchange mail system to a Domino mail database. The migration tool lets you migrate all users from the foreign directory or select specific users to migrate.

This section covers the tasks that you are required to do prior to performing the migration using the Domino Upgrade Services migration tool. The migration tools are not installed with the Domino Administrator client by default; you need to select the migration tools during the installation process. Perform the following tasks on the administrative workstation before you start the migration process:

- Install the Domino Administrator client with DUS.
- Install the Microsoft Outlook client.
- Specify the Administrative mail profile.
- Set up the Outlook client.

9.1.1 Installing Domino Upgrade Services

On your administrative workstation (ours was running on Windows NT 4.0), install the Lotus Notes Domino Administrator client along with the Microsoft Exchange migration tools. You must perform a custom installation to install the migration tools component.

**Note:** Be sure to install the latest version of Domino Administrator client available, preferably version 6.0.2 or later, because that version contains the latest version of Domino Upgrade Services tools as well as the latest fixes.

We performed the migration using the Domino Administrator client at release 6.0.1 in our test environment. Use the following steps to install Domino Upgrade Services (assuming you have the same setup as in our lab):

1. Launch the Lotus Notes client installation program. Fill in the necessary fields and proceed normally with the installation until you see the window shown in Figure 9-1.
2. Select the Domino Administrator option, and click Customize.
3. Select only the Exchange Migration Tools, as shown in Figure 9-1, and click Next.

4. Click Install to complete the installation.

### 9.1.2 Installing Microsoft Outlook client

You must install the Microsoft Outlook client on the same workstation as the Domino Administrator client, and set it up for Microsoft Exchange Administrator access. This creates a MAPI profile on the administrator's workstation, which allows the Domino Administration client to access the MS Exchange server information store. We used the Microsoft Outlook 98 client in our test environment, but Outlook 2000 will work as well. Use the following steps to perform the installation:

1. Log on as administrator to the Windows NT domain from the administrative workstation. If you have the Outlook 98 or later client already installed on this workstation, go to Section 9.1.3, “Specifying an Exchange Administrator mail profile” on page 257.

2. Launch the Outlook installation program, and click Next to continue.
3. On the E-mail Service Options window, select the Corporate or Workgroup option, and click Next to continue (Figure 9-3).
4. After you complete the installation and before you launch the Microsoft Outlook client, you must specify an Administrator profile.

9.1.3 Specifying an Exchange Administrator mail profile

To migrate users from Microsoft Exchange, you must connect to the Exchange server that has the mailboxes you want to migrate. You connect to an Exchange server by selecting the Administrator mail profile for the Exchange server that you want to migrate. The Administrator account, which must have the Service Account Administrator role for the Exchange site and server, gives you full access to all accounts and all mailboxes in the Exchange server directory.

The profile you use should connect with the Microsoft Exchange server service only; do not use a profile that connects to multiple messaging services. If necessary, create a new profile for use during migration. The profile must be available locally or on a network drive accessible from the workstation where you are running the Domino Administrator. In our test environment, the Windows NT user account with Service account administrator role was the Administrator.

Verifying the service account administrator role

In order to verify that the account exists and has the correct privileges, complete the following steps to see the user with the service account administrator role on the Microsoft Exchange site and server:

1. Launch the Microsoft Exchange Administrator program, and select the site name. In our example, the site was called Headquarters. See Figure 9-4.
2. Select File → Properties as shown in Figure 9-5.
3. Click the Permissions tab on the pop-up window to display the Windows NT accounts with permissions in the Service Account Admin role for this site. See Figure 9-6.

![Configuration Properties]

Figure 9-6 Exchange Site Permissions

4. To see the user account with the Service Account administrator role on the Exchange server, select the Microsoft Exchange server name, as shown in Figure 9-7. In our example, the Exchange server was EX01.
5. Select File → Properties.

6. Click the Permissions tab on the window that appears to display the Windows NT accounts with permissions, Service Account Admin role, for this server. See Figure 9-8.
You control access to objects in the directory by using the Microsoft Exchange Administrator program to assign roles to Windows NT user accounts and groups. Roles are sets of permissions that define how much and what type of access a user or group has to an object. In the lab we used the defaults as shown.

9.2 The migration process

You are now ready to run the Domino Upgrade Services from the administrator workstation. Be sure to log on to the Windows NT Domain with an account that has the Service Account Admin role for the Microsoft Exchange site and server. In our example, the account was EXADMIN. This gives you full access to all accounts and mailboxes in the Exchange server directory.

Sizing the migration workstations is a critical component for the overall success of the actual migration. The main factors in determining the size and number of migration workstations are:

- The size of the Exchange Information Stores to be migrated
The actual migration process can be accomplished via several workstations at once, each handling a different portion of the user community. If you have a large number of users to migrate, with lots of data and a short timeframe, we suggest using several migration workstations working in tandem. This is illustrated in Figure 9-9. You should use workstations that have the following characteristics:

- The fastest CPU
- The most RAM
- 100mb network card
- Windows 2000 or higher

![Migration architecture: Multiple migration workstations](image)

1. Start the Domino Administrator client from the Lotus Applications Program folder, and log on using the Domino server Administrator's user ID.

2. Ensure that you are connected to the correct Domino server. From the Server pane of the Domino Administrator, select your target Domino server.

4. Select the Domino server on which you want to migrate the Microsoft Exchange server users. In our example, we selected itsosrv1/itso as shown in Figure 9-10.

![Figure 9-10  Select Domino Server](image)

5. Click OK to continue.

6. In the Task pane, click the Tools icon. Under the People section, select Register.

![Figure 9-11  Domino Administrator selecting Register](image)

7. Select the certifier ID, and enter the password of your certifier ID. Click OK to continue. If you need to register the user within an Organization unit (OU), you may select the certifier ID of that OU here.

8. If you have not set up a recovery ID process, a message pops up that warns you that the certifier does not contain recovery information. Click OK to continue (Figure 9-12).
Migrating from Microsoft Exchange 5.5 to Lotus Notes and Domino 6

9. Click the Migrate People button.

Figure 9-12  Recovery ID warning message

You will see the Register Person dialog box as shown in Figure 9-13.

Figure 9-13  Register new person
10. On the People and Groups Migration window, in the Foreign directory source field, select Microsoft Exchange Users (Figure 9-14).

![Figure 9-14   Selecting a foreign directory source](image)

11. You are now prompted for a MAPI profile that allows you to access the Microsoft Exchange server. Select the profile name that has privileged access to the Exchange server, or click New to create a profile. In our example, we used the Administrator account. The Administrator account has the Service Account Admin role for the Exchange site and server (Figure 9-15).

![Figure 9-15   Selecting a profile for the Exchange server](image)

12. Click OK to continue.

13. Click the GO! button to retrieve the list of people/groups from the Microsoft Exchange Global Address List. The results are shown in the Available
people/groups field. Select the users or groups that you want to migrate, and then click the Add button to add them to the People/Groups to migrate. In our example, we selected user Natalie Long, who is an Exchange user (Figure 9-16).

![People and Groups Migration](image)

Figure 9-16 Available Exchange people and groups

**Note:** With Domino Upgrade Services, you can also migrate groups and their members. Furthermore, DUS supports the migration of two types of group members:

- Local users: These users have entries in the local directory, that is, the same directory where the group entry exists. When you select a group to migrate, the local users in the group are selected for the migration tool.

- Nested groups: Groups that are members of another group. By default, when you migrate a group, you also migrate the groups nested within it. Local users can also exist in those groups.

**Tip:** We recommend that you do not select a large number of users to migrate initially. Perform the migration for a couple of users first, and then proceed with groups or departments.
Figure 9-17 Migration options

14. Click the Options button to open Migration Options, as shown in Figure 9-17. You have the following migration options:

- Generate random passwords for users with no passwords
  
  For users who have no existing password to import, or whose passwords the migration tools cannot import (Windows NT users, for example), the migration tools provide an option to generate a random password, conforming to the specified password quality scale. The default setting for this option differs for each of the migration tools. When using this option, passwords are only generated for users if the password field is empty; generated passwords do not overwrite passwords imported from the legacy system.

  This option and the “Overwrite existing passwords with random passwords” option are mutually exclusive. If you select one of the options and then attempt to select the other, an error message appears.

- Overwrite existing passwords with random passwords
  
  Select this option to generate new random passwords for all migrating users, regardless of whether they already have a password available for import from the legacy directory. The migration tool generates passwords that conform to the password quality scale specified in the current registration preferences. If a migrating user already has a password imported from the legacy system, the new password overwrites it.

  This option and the “Generate random passwords for users with no passwords” option are mutually exclusive. If you select one of the options and then attempt to select the other, an error message appears.

- Add full name provided to the Notes person document
  
  The User name field of a Person document lists one or more full names (as opposed to name components) by which a user is known in Domino. For a registered user, the first name listed in this field, the primary Notes name, is a hierarchical name based on the certifier ID used to register the user. This same name is checked when authenticating a user’s right to access Domino resources. In addition to this primary name, the User
name field can contain secondary entries, which serve as aliases for the user and can be used in addressing mail.

– Allow addition of empty groups to Notes

Because imported groups may contain users who are not available for import, it is possible that the membership of a migrated group will differ from the original membership. This can occur, for example, with e-mail distribution lists, which can include entries for users from foreign messaging systems, such as Internet addresses.

Because the migration tools cannot register users from outside the current directory, by default, these entries are omitted from Notes groups created from migrated groups. Groups selected for import are considered empty if they do not contain any members who can be registered in Notes. By default, the migration tools do not import empty groups. A group may be empty because it contains no members, for example, an obsolete group that was never removed from the address book. Or a group may not contain any local users, for example, an e-mail distribution list that lists only the Internet addresses of users on other mail systems.

Migrating a group whose members are not available—and that would, therefore, be empty—results in an entry in the Domino Directory that serves no useful purpose. Set this option only if you intend to add users to any empty groups either during registration or after registration completes.

– Convert mail

The Domino migration tools for cc:Mail, Microsoft Mail, and Microsoft Exchange provide you with the option to convert existing mail files into Domino mail files. By default, this option is enabled. If you choose to convert mail, during the registration process, the migration tools automatically convert mail files on the old system to Domino mail files.

Mail files are created on the Domino server that is specified in your registration preferences. If the migration tool cannot create a user's mail file for any reason, such as if the specified mail server lacks sufficient disk space, the user remains unregistered, and an error is logged. Because mail conversion requires mail files to be created immediately, you cannot choose the option on the Mail pane of the Register Person dialog box to create mail files using a background process (adminp). An error message is displayed if you attempt to select this option.

– Add Administrator to mail file access control list

When you create a mail file for a user during migration, by default, your Domino Administrator ID is temporarily placed in the ACL of the new mail file and is assigned Manager access. After the migration completes and the migrated user is successfully registered in Domino, the administrator
ID is removed from the ACL and replaced with the name of the mail file owner. At this point, only the mail file owner can open the mail file.

**Note:** If you are migrating user mailboxes and choose to retain the default mail file ACL during migration, if the mailbox conversion fails, the administrator ID remains in the ACL as Manager.

In some cases, you may need to convert additional messages for users after you migrate them to Domino and create their Domino mail files. However, under the default mail file ACLs, you (as the administrator) do not have the level of access needed, and must ask the owner to restore your name in the ACL.

If you anticipate needing to perform such a secondary migration, when you first select users to migrate, also select the Add administrator to mail file access control list migration option from this list on the People and Groups Migration dialog box. This will save you time later since this option changes the default mail file ACL so that the administrator retains Manager access to the mail file. The owner of the mail file also remains in the ACL with the default Manager access.

**Note:** This option adds the administrator ID to the ACL of every mail file you create during the migration process, regardless of whether any messages are migrated. We recommend that you not to use this option because it retains the mail file owner as the administrator and needs to be changed manually.

Table 9-1 shows the default status for the migration options and how we set them in our example during migration. It is important to note that the options you select apply to all users imported from a given directory during the migration session.

<table>
<thead>
<tr>
<th>Migration option</th>
<th>Default status</th>
<th>Our example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate random passwords for users with no passwords</td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>Overwrite existing passwords with random passwords</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Add full name provided to the Notes person document</td>
<td>On</td>
<td>On</td>
</tr>
<tr>
<td>Allow addition of empty groups to Notes</td>
<td>Off</td>
<td>Off</td>
</tr>
</tbody>
</table>
15. Click Migrate to add the selected persons/groups to the registration queue.
16. You will be presented with a window, similar to the one shown in Figure 9-18, showing the status of the migration process.

### Migration option | Default status | Our example
--- | --- | ---
Convert mail | On | On
Add Administrator to mail file access control list | Off | Off → On → Off

**On** = Select; **Off** = Deselect
1 Make sure to first turn on this option, and then turn it off again to take effect. In our test environment, the default off status did not take effect unless we proceeded this way.

**Attention:** Add administrator to mail file access control list, the last migration option, is by default set to off. If you leave this at the default status, the DUS still retains the Domino Administrator as the owner of the user’s mail file. In our test environment, the default off status did not take effect unless we followed the workaround mentioned at the end of Table 9-1.

17. Click OK to return to the Register person window.
18. Select the Advanced check box to show additional tabs. See Figure 9-19.
19. Select the Basics option. On this display, click the Password Options button to set the Internet password option. Take note of this because you will be required to give it to the user later.
20. We checked the Set internet password box and the Synch internet password with Notes ID option.

21. Select the Mail tab pictured in Figure 9-21. On this display, select the Mail (R6) (file name mail6.ntf) mail template from the list of mail file templates. Leave the remaining settings at their defaults. Do not set any database quotas at this time because the user's Exchange mailbox already exists and is going to be converted into an .nsf database. You may set database quotas once the user has been registered and the mail database migrated to the Domino server.
22. Click the Address tab to control the creation of the SMTP address format.
23. Click the ID Info tab, pictured in Figure 9-23. Make sure that the location for storing the user's ID file is set to In Domino directory. Also verify the Certifier ID information to make sure that it is the one that you selected earlier.

(Optional) You may want to store the user's ID in a file. To do this, select the In file option. Then set the path to where you want the ID file to be stored by clicking the Set ID file button.
24. Select the user, then click the Register button to finish the registration process and complete the migration. If you have multiple users in the registration queue, you can click the Register All button. After the migration is completed, the registration process:

- Creates a Domino Person document and Notes user ID for each migrated user.
- Creates a Domino mail database for each user.
- Migrates mail messages, calendar entries, to do tasks, and sticky notes from the Microsoft Exchange mailbox to the newly created Domino mail database on the Domino server.

This completes the server-side migration of the Exchange users to Lotus Domino.
Chapter 10. Binary Tree Common Migration Tool for Lotus Notes

This chapter provides detailed instructions for setting up the Binary Tree Common Migration Tool (CMT) and using it to migrate users from Exchange to Domino. We explain in detail the setup, usage, and on-the-fly configuration, followed by some examples of the expected results obtained when using the tool.
10.1 What is Common Migration Tool

The Binary Tree Common Migration Tool (CMT) migrates data from one e-mail system to another. While the tool can be used to migrate from numerous e-mail systems to Lotus Notes, the focus of this chapter is to describe its capabilities in migrating from Exchange 5.5 and Outlook to Lotus Notes and Domino 6.

Like the DUS, the CMT has the ability to migrate both Server-based data and end user-based data. The results of both server and end user migration are presented in Chapter 11, “Migration results” on page 319.

During our testing we found that the CMT provides:

► Easy setup
► Good control and selection of data to migrate
► Usable logging of status at each stage of the migration process
► Good failover when encountering errors, including:
  – Usable references to reason of failure
  – Ability to continue with further migration requests
► Ability to trigger and restrict end user migration, that is, where, how, and when
► Ability to migrate public folders (separate migration tool)

10.2 Installation

The CMT tool is physically a Domino database. All administration and configuration is conducted within this database. It is good practice to install the CMT databases into a subdirectory, preferably called CMT, of the Notes data directory of the Domino Server.

**Important:** For end user migration the CMT database needs to be installed on the Domino server rather than on the client. However, you can replicate it to a local workstation and work from there.

**Prerequisites**

The following prerequisites should be in place to ensure that the migration process is as smooth as possible:

► A Lotus Domino server 4.6 or higher
► A workstation with Lotus Notes 4.6 or higher
A Notes Client with an ID file that is a member of the administrators group and
that has appropriate access to the Domino Server.

- If the ID to be used is not the administrator, grant the ID Editor access to
  the certification log database.
- Also ensure the ID has been granted Editor access, along with the group
  and the roles of GroupCreator, GroupModifier, UserCreator, and
  UserModifier to the Domino Directory for the organization.
- Add the ID to the Access Server field in the Domino Directory for all
  servers to which CMT will be migrating data.
- The ID should also sign all design elements of the CMT database through
  the Domino Administrator Client.

For server-to-server migration:

- In the case of already created mail databases, the ID used for migration
  should have full Manager access to all target Lotus Notes mail databases.
- Ensure a version of Outlook is installed with a profile that has Administration
  privileges to the Exchange servers that data will be migrated from.

For end user migration:

- All users must have write access to their Windows system directory for DLL
  installation (for example, c:\windows, c:\winnt, c:\winn98, c:\win2k). If they do
  not, the appropriate DLLs needs to be moved to where the system path can
  see them. If the company will not grant users write access to their Windows
  System directory, the administrator will have to push out BinaryTree.com files
  to this directory. The minimum level of access the user has to have to the
  Windows system directory for a migration is:
  - Windows NT, Win95, Win98: Read access
  - Windows 2000: Read and Execute access
- All users must have write access to their operation system's temp path. They
  need write access to whatever directory the environment variable TMP or
  TEMP is set. If TMP or TEMP does not exist they need write access to the
  <install drive>:\temp.
- All end users need at least Editor Access to their Lotus Notes mail database.
  They also need at least Author access to the CMT database on the Domino
  server. They need to be able to access the Domino server from their Notes
  client during the migration.
10.2.1 Set up the licenses

Before you can start to use the migration tool to migrate users, you need to install the license key. The licensing is per user and is not dependent on either the source or target mail system.

1. Open CMT by selecting from the databases folder or use:
   File → Database → Open or Ctrl+O and entering the file location (that is, data\CMT\commonmigration.nsf).

2. Select License information. This opens the License Information view.

3. Double-click Enter License Information in the view to open the document.
4. Enter the license key supplied by BinaryTree and click OK (see Figure 10-2).
5. Save and close the CMT License Information document.

### 10.2.2 The five steps to migration with CMT

The Binary Tree company recommends the following five high-level steps to use the migration tool for setup and migration of users.

1. Configure CMT settings
2. Add users from foreign directory source
3. Select users for migration
4. Migrate server data
5. Migrate local user data

In the following sections we describe these steps in detail. Although manual configuration and migration is possible, for this discussion we have used the CMT wizards in each case. The CMT wizards are useful aids in setting up a migration, particularly for the first time user of the tool, since they help you determine which information is needed based on the type of migration that you intend to do. When you open the database, the following wizard buttons are located at the top of the screen:

- Configure EU Settings
- Add Users
- Server Migration
- End User Migration
You can move forward and backward through most of the screens by clicking the Next and Back buttons located at the bottom right-hand corner of the screens. There is also a Cancel button in that corner.

10.2.3 Configure CMT settings

The first stage of the migration is to configure the CMT tool by providing information on both the target and source mail systems.

1. Open the Database and click Configure EU Settings (Figure 10-3). You will be presented with the main source mail system selection screen shown in Figure 10-4. By default, all supported mail systems are selected; you will need to deselect the mail systems not required, leaving you with the mail systems you wish to migrate from.
2. When you have only the correct source mail systems selected click Next. Lotus Domino is selected as the target mail system by default.

Figure 10-5  Domino Directory settings

3. Now you are required to enter information on the Domino mail system, such as the default directory server. In most cases, all other fields can be left with their default values. Click Next to proceed.
4. The Outlook and Exchange settings dialog is where you provide information on the Outlook and Exchange systems, such as default migration contents. The settings dialog provides the following options:

- **Message types to migrate**
  
  The CMT tool lets you select which message types are migrated. For example, you could choose to migrate mail messages but leave calendar entries untouched. As can be seen in Figure 10-6, we opted to migrate all data. However, you may decide that not all data is relevant for migration, so you can refine the selection.

- **Message stores to migrate**
  
  - **Migrate Exchange server data**
    
    The user’s mailbox and data are on the Exchange server. When you migrate Exchange server data, the user’s mail and folder structure saved on the server will be migrated. When you choose to migrate Exchange server data, you also have the option to migrate shared Exchange mailboxes. A shared Exchange mailbox is used by more than one user. To migrate shared Exchange mailboxes, select the Migrate Shared Exchange Mail Boxes check box.

  - **Migrate personal folder data**
    
    The data are local to the user's machine or stored on a network drive. They are in the form of a .PST file. This data is not stored on the server. If there is more than one .PST file, CMT will migrate all of them.
• Migrate personal address book data

The data are local to the user’s machine or stored on a network drive. They are in the form of a .PAB file.

You may also decide that the only data you want to migrate is calendar, messages, and contacts. Later, during the selection of users for migration step, you have the ability to further refine the data selection by changing from the defaults and adding date ranges, so as not to migrate older data.

– MAPI profile to use

Unless you have created a single/default MAPI profile with administration access, you should select Let users choose profile to ensure that a profile with sufficient privileges for logging into Exchange can be chosen.

– Migrate shared Exchange mail boxes

The option to migrate shared mail boxes should be used with caution since this data is used by more than one user, and is only available if you have chosen to migrate Exchange server data. When this option is selected, the shared data will appear in each user's mailbox. It may be more appropriate to create a mail in database into which to migrate the shared data, and giving the users that require it access.

– Migrate to Notes systems folder

Data from Exchange, by default, will be migrated by the CMT into the top-level folder in Notes. The Exchange/Outlook folder structure will be retained. All of the users' Exchange folders will be placed under this top-level folder, and the relevant data/mail messages will be stored within them. Thus within the Notes user's mail database they will have separate folders for their Notes data and old Exchange data.

By selecting Migrate to Notes system folders, data within the Exchange system folders (Inbox, Sent Items, Drafts, and Deleted Items) will be migrated directly into the equivalent Notes system folders (Inbox, Sent, Drafts, and Trash). All other non-system Exchange folders will be migrated to Notes. In other words, the folders will appear under the Notes root-level folder structure and not under an Exchange top-level folder.

When you have completed your selections, click Next and you will be presented with the fourth settings screen. (Figure 10-7 on page 286).
5. Provide information on the Outlook Express system. Select from the data options areas that are available. You need to specify a top-level folder: all data and subfolders migrated from Outlook Express 4 will be migrated under this folder. Click Next.

6. The final settings dialog allows you to provide information on top-level folders in the Exchange mail clients. If you did not select Migrate to Notes system folders (Figure 10-5 on page 283), all data migrated from Exchange will be migrated under the top-level folder named.

You also have the option to select which message classes to migrate. A message class is how a note is stored in Exchange. To specify which message classes to migrate, type in the message classes separated with a semicolon (;). A semicolon must also follow the last message class entered.
To have all message classes and rich text migrated, use an asterisk (*); this will reset message classes to default. The defaults are:

IPM.Note.RFC822.MIME;IPM.Note.RFC822;

Click Next and you will be presented with the settings completion screen.

7. Click Finish and you will be returned to the CMT Database main view.

10.2.4 Add users from foreign directory source

When you have completed the configuration, you need to add users from the foreign directory into the CMT database before you can register them.

**Note:** It is possible to select pre-registered users from a Domino database.

1. To add users into the CMT migration database, click the Add Users button; this will launch the add users wizard.

![Figure 10-9  Select Add Users button](image.png)

You can add users from a foreign directory source or select users from the Domino directory.

We opted to select our users for migration from the Exchange 5.5 Global address list, and therefore we selected Import from Foreign Directory Wizard. (Figure 10-10)
2. Click Run Wizard; you will be presented with a screen where you select the source systems to import the users from (Figure 10-11).

We selected Exchange as the source system for directory information. The target Domino server and directory have been acquired automatically from the configuration information provided earlier. If the intended destination server is different, it is possible to change it now. Select the mail template version 6.0.

3. Click Next. The Exchange input parameters screen will be displayed (Figure 10-12).
Figure 10-12  Exchange input parameters

Here you have the option to specify the settings for the migration of users from the identified directory source, and override the default parameters set earlier.

- Select the type of data to migrate from the following choices:
  - Mail items: All e-mail messages a user has received.
  - Calendar items: A user's calendar items. When reoccurring appointments in Outlook do not have a reoccurring end date, a reoccurring end date will be created for them that is five years past the current year. For example, an appointment is on August 1, 1999, and reoccurs yearly, but does not have a reoccurring end date. It will migrate to Notes as the same appointment, but with a reoccurring end date of August 1, 2006.
  - Journal: Journal entries made by a user.
  - Task items: All tasks a user has entered.
  - Contact items: Contacts in the user's address book.
  - Note items: All notes a user has made.
CMT can migrate the folder structure from the source, as well as the data contained within. If you enter a top-level folder name here, all migrated data will be located in that folder structure, separate from the standard Notes folders. In our example we used Exchange mail. We would therefore expect that the folder structure and its contents from Outlook will be placed here in the migrated user’s mail file, unless we select Migrate to Notes system folders (see “Migrate to Notes systems folder” on page 285).

Select to use either the alias or name value when logging into Exchange:

- If you select Alias, CMT will use the unique ID for each user to access each user’s mail store. Using the alias is recommended because it is unique to each user.
- If you choose Name, CMT will use the user’s last name, first name, and middle initial to access the mail store. This is not recommended because the incorrect mail store could be accessed when users have similar names.

If you want rich text format (RTF) data to be migrated, click the check box next to Migrate Rich Text Format (RTF) when available.

If you select Create Exchange distribution lists in Domino Directory at registration time, you are telling CMT that you want it to create the distribution lists in which the individuals being registered by CMT belong.

Note: The groups will be migrated only when the individuals are registered to the Domino directory with CMT. If individuals are not registered with CMT, the groups to which they belong will not be created.

If you select Attempt to resolve names, CMT will attempt to resolve names in the contacts list and e-mails to the counterparts in the Domino directory.

As per recommendation, we used the alias profile for logging into Exchange.

4. Click Next. The screen returned gives you the option of further limiting the amount of data that will be migrated by specifying date ranges for several types of data (Figure 10-13 and Figure 10-14 on page 291).
Figure 10-13  Exchange input parameters filter

Figure 10-14  Exchange input filter with date range selected

Specify start and end dates. Only the data within the specified range will be migrated to Domino.

5. Make your data selections and click Next.
6. You are presented with the Exchange User Filter screen (Figure 10-15). The options are:
   a. Select all users in GAL
   b. Select GAL users from list
   c. Select only users from one Exchange Home Server
   If you select a particular server you are required to specify the name, and only users from this server will be available for selection.

![Figure 10-15 User selection options](image)

The two other options are to import the entire GAL or to select from currently imported users. If this is the first time you are doing the migrations, you should opt for Select all users in GAL.

**Note:** The purpose of Import of users is to create CMT person documents in the cmt database that will be used for registration and migration. This does not add users to the Domino Directory.

Rather than import all the users, and to show additional options, we opted to select users from the GAL. Click Next to proceed.
Depending on the option taken, you are presented with either the Exchange User Selection screen (Figure 10-16) or the Import Users screen (Figure 10-21). If you selected to import all users, go to step 14 on page 295. Select the Build Exchange user list.

7. You are requested to select a MAPI profile, Figure 10-17. Ensure you have set one up as mentioned in the “Prerequisites” on page 278. If not, you will have to cancel, build the profile, and start the Add Users wizard again.

Ensure the selected profile has administrator privileges. Otherwise, you will not be able to access either the Global address list or, during migration, the user data to migrate.

8. Click OK to select the profile. You are prompted for a password. If you are not logged into the NT Domain you are presented with a window asking for the
logon credentials for the Domain. Enter the required information and click OK. Importing users batch starts.

Figure 10-18  User import status screen

9. A status screen is displayed while the import is running. An example of this screen is in Figure 10-18.

10. When the import has completed you are presented with a screen informing you of the number of successfully imported users. Click OK.

11. You will return to the select users screen, similar to the one shown in Figure 10-16 on page 293. This time, click Select users from Exchange user list. You are be presented with a list of users, as illustrated in Figure 10-19.

Figure 10-19  Selecting users to import

12. Select the users to import and click OK. The users will be added to the import list.

13. If you selected to import distribution lists, the screen shown in Figure 10-20 on page 295 will be displayed. Specify settings related to the importing of the distribution lists and click Next.
14. The final step is to import users. Click the Import Users from Exchange button (Figure 10-21).

15. You may be requested for a MAPI Profile again (or for the first time if you are importing all users from the GAL). Click OK.
16. Click OK and ensure you select a profile with Administration rights to the GAL. You will be prompted for a password. If you are not logged into the NT Domain you will be presented with a window asking for the logon credentials for the Domain (Figure 10-23). Enter the required information and click OK.

17. Depending on the size of the directory and the speed of the network, the process of importing can take a fair amount of time. You may receive some requests when the tool encounters duplicate addresses, such as shown in Figure 10-24. You may receive resolution requests like this if you have a directory coexistence solution in place and have users with duplicate/similar names on both systems.
You have the choice of changing to either of the selected names, or creating a new one. If you choose to create a new one you will be requested for an address type, for example Notes, Internet, msmail, and so forth.

18. When the import is complete you are presented with a message box informing you of how many users have been successfully imported (Figure 10-25).

19. Click OK.

20. The Import users screen remains on your screen. Click Next.

21. A message appears informing you that you have finished importing users. Click Finish and you are returned to the database main view.
10.2.5 Select users for migration

The next task is to select and register users.

**Note:** This task is not necessary for any of your users who are already registered in the Domino server.

1. Click Add users (as in Figure 10-9 on page 287); you are once again presented with the user migration setup screen.
2. This time, select Register to Domino Directory wizard in the Add user dialog. Click Run Wizard to start. (Figure 10-28).
3. The registration settings screen is presented (Figure 10-29).

4. Complete all the fields, following these guidelines:
   a. It is advisable to enter the server's IP address.
   b. In a single server environment the mail server, template server, and registration server will be the same. This may or may not be the case in a multi-server scenario. Ensure you enter the correct server names in the fields.
   c. The standard mail template file for Domino 6 is Mail6.ntf.
   d. We recommend that you select the unlimited filename format.
If it is required (mostly during the pilot project), add the mail administrators group to the ACL of the mail databases. Remember to remove this once you start your full deployment!

In the LocalAdmins field enter the names of the administrators or groups who should have administrator access to users' person documents in the Name and Address Book (NAB) after they are registered. The format should be: administrator's name/mail server. Separate each administrator with a comma (,). The default is the localadmins group.

You also have the option to generate a random password or use a default one. If you select default, be sure to enter a password in the default password box.

Attention: Passwords are saved in the CMT person document.

Set the complexity of the password that users must use when changing the password. Values range from 0 (weak) to 16 (complex).

If you want to create an internet password for the user, select the Set internet password box.

Click next to proceed to the second registration settings screen.
6. Enter the location of the certification ID, the certification log, select the relevant security type, and complete all other fields. You also have the option of adjusting the format of the Internet address to be created and the location to store the created ID file.

7. Click Next; you will be prompted for the certifier ID password.

8. Enter the password and click OK. The Select People screen appears.

![Figure 10-31 Select users for registration](image)

9. Click the Select Users button. You are presented with a list of users flagged ready for registration from the CMT database. Select the users you wish to register.

10. When you have selected all the required users, click OK to close the dialog, then click the Register Users button (Figure 10-32). The selected users will now be registered.

![Figure 10-32 Run registration](image)

11. You will be prompted to supply the certifier ID password.
A status bar is displayed during registration (Figure 10-34), followed by the completion message (Figure 10-35).
Troubleshooting the migration

In the event that a registration fails, you are presented with the status screen. It lets you know the number of successful and the number of failed registrations. In the event of a failure, further investigation will be required. Most causes of failure are simple and easily rectified. To find out the cause of the failure, open the CMT database and click Registration. A list of users and their status is displayed (Figure 10-36).

Select and open the failed user's document, which will be in the Failed registration category.

A migration information section is at the bottom of the document. The cause of the error is displayed in this section (Figure 10-37).

Figure 10-36   Troubleshooting: CMT registration view

Figure 10-37   Troubleshooting status of migration
10.2.6 Migrate server data

Once you have registered users and selected them for migration, you are in a position to start the migration of the user data from Exchange to Domino. Users are eligible for migration when:

- They have a status of “Registered” and a green or purple icon in the column under the server that will be migrated.
- They have a status of “Registered” or “Ready for Registration,” the server being migrated is Exchange, and they have a green icon under that server column.

**Note:** Users with a status of “Ready for Migration” and no yellow light will not be imported during the server-to-server migration. They either will be or have been migrated with an end-user migration.

For a full description of the status categories, see the CMT help accessible via the CMT database.

Figure 10-38 People by ready for registration status view

In our example (Figure 10-38) we show four users. Three of them registered and one failed migration, assuming all four users will be available for migration.

Once again BinaryTree has provided an easy to use wizard for migration. As with a manual migration, the migration wizard will only allow you to select users from the CMT database that are in the correct status.

1. To use the wizard click Server migration from the main database view (Figure 10-39).
2. You will now be presented with the migration source selection screen (Figure 10-40). Select Exchange.

3. You also have the option to migrate all users ready for migration or select the users for migration. If you select all users, the wizard will attempt to migrate all users that are in the relevant status noted previously, meaning it will not attempt to migrate all the Exchange users in the GAL.

   Click Next.

4. If you choose Migrate Selected, you are presented with the user selection screen (Figure 10-41 on page 306).
5. Select the users and click Next.

6. You are presented with the Run Migration screen (Figure 10-42). Click the Migrate users button.

7. You are requested to select a MAPI profile. Be sure you have set one up as mentioned in the “Prerequisites” on page 278. If not, you will have to cancel, build the profile, and start the Add users wizard again.

   The selected profile must have administrator privileges; otherwise, you will not be able to access either the Global Address List or, during migration, the user data to migrate.

8. Click Next. The migration begins and a status screen displays its progress (Figure 10-43). Depending on the amount of data and speed/bandwidth of the network, the migration might take a fair amount of time.
During the migration process, you have the option to suspend, and resume, the migration. This is a useful option that in our testing did not result in either a failed migration or migration with errors. The option is useful if you need to suspend the process due to resource constraints. The option to cancel is also available.

9. A completion notice is displayed when the migration is finished (Figure 10-44). Take note of and follow up on any errors.

10.2.7 Migrate local user data

An end user migration migrates data such as contacts and local folders and archives that may be stored on users’ local drives. The end-user migration is initiated by the end users you’ve selected to migrate. There are two wizards that need to be run:

- Schedule Users wizard: This wizard is used to choose and to control the time period and number of users who can perform the migration.
10. **Configure Trigger wizard:** This wizard allows you to configure how the end user migration will be triggered: either upon mail database open, or via an option (similar to the DUS) of pressing a Start Migration button in a mail message the user receives from the migration administrator.

**Setting the trigger**

1. To ensure that the automatic scheduling works, you first need to set the trigger. Start the end user migration wizard by clicking the End user migration button in the CMT database (Figure 10-45).

![Figure 10-45 End user migration setup](image)

2. Select Configure Trigger Wizard (Figure 10-46) and click Run Wizard.

![Figure 10-46 Selecting Configure Trigger wizard](image)

3. You are presented with the trigger type selection screen. Select your trigger method, either via an e-mail message or automatically on mail database open (Figure 10-47).
If you select the custom e-mail button you are presented with the screen shown in Figure 10-48, which is used to prepare the e-mail for your end users. Edit this e-mail as appropriate. The available tags for this message are described in Table 10-1.

Click Next. The trigger is now set.

Table 10-1  Available tags for customizing the e-mail message

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;!-Subject-&gt;</td>
<td>Subject of the message</td>
<td></td>
</tr>
<tr>
<td>&lt;!-SendTo-&gt;</td>
<td>Who to send the migration message to</td>
<td>The full name stored in the user's person document</td>
</tr>
<tr>
<td>&lt;!-MigrateTo-&gt;</td>
<td>Migration Platform to migrate to</td>
<td>Target mail system, located on the General Settings tab of the Settings document</td>
</tr>
</tbody>
</table>
4. To initiate the end user migration, click the End user migration button in the CMT database. See Figure 10-45 on page 308.

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;!--DeliveredDate--&gt;</td>
<td>Date the migration message was sent to the user</td>
<td>The date the mail message was sent</td>
</tr>
<tr>
<td>&lt;!--StartDate--&gt;</td>
<td>Start Date for the user to begin their migration (also the date range the 'Start Migration' button to trigger migration is valid)</td>
<td>Defined on the CMT person document under the End User Migration info section</td>
</tr>
<tr>
<td>&lt;!--EndDate--&gt;</td>
<td>End Date for the user to finish their migration by (also the date range the 'Start Migration' button to trigger migration is valid)</td>
<td>Defined on the CMT person document under the End User Migration info section</td>
</tr>
<tr>
<td>&lt;!--AllowedProducts--&gt;</td>
<td>The products the users is allowed to migrate</td>
<td>AllowedProducts corresponds to the Allowed Products on the User's person document</td>
</tr>
<tr>
<td>&lt;!--HelpContact--&gt;</td>
<td>Person to contact if the migration encounters a problem</td>
<td>Corresponds to the custom help text used in the standard migration document</td>
</tr>
</tbody>
</table>

- If you select to automatically trigger when the user opens the database, a piece of LotusScript is generated; you must insert this script into the mail template. By default, the code will be generated in the Windows temp directory.
  - To change the location, enter or browse for the location and filename for the generated script by clicking on Browse.
  - After the location and filename have been entered, click Next.
  - The custom code will be written to file and displayed in the wizard screen. Click Next.
  - Click Finish.
  - After the custom script has been generated, open the output file and follow the instructions to complete the mail template installation. The instructions are included in a comment section of the generated LotusScript code, with the user specific %INCLUDE statement described in step 5.
  - Run the load design task to refresh the design of all user mail databases so that they contain this script.
  - Repeat this procedure for all mail servers to which users will migrate.
5. Select the appropriate Schedule wizard button (Figure 10-49) and click Run Wizard. This allows you to configure the window of opportunity a user has for migrating.

6. You are presented with the migration type selection screen (Figure 10-50). The options are:
   - Schedule All people: All migrated users and all users available for migration are selected for end user migration. Use this option if you have opted to use a stepped migration and have registered, but have yet to migrate, some users.
   - Schedule Selected people: Only selected users will be migrated.
   - Schedule All groups: Same as all users, all users in registered groups will be scheduled for end user migration.
   - Schedule Selected groups: Only the selected groups will be migrated.
7. If you choose to schedule selected users or groups, an additional screen to select the groups or users is presented. Make your selections and click OK.

We made our selection as shown in Figure 10-51.

![Selecting users for end user migration](image)

**Figure 10-51** Selecting users for end user migration

8. The next option, shown in Figure 10-52, is to specify a start date for the migration. The migration will use this as a constraint and will not allow an end user migration to begin until this date. The number of users selected for migration will also be shown.

Enter a date and click Next. You are presented with the option to migrate based on an end date or number of users per day (Figure 10-53).
9. We recommend running a few test migrations to get some metrics on the available bandwidth and length of time the user migrations are likely to take. Based on these and project constraints, select the relevant method for user migration. We had no particular preferences, so we selected based on the number of users per day.

Click Next when you have made your selection.

10. You are presented with the screen to set the migration window, which basically restricts the user to migrate within this time frame. We selected 2 days. This means that the end users have two days to complete their migration.

Enter your required migration window and click Next.
– If you selected to schedule based on an end date, you are presented with the select end date screen (Figure 10-55). Enter the migration end date here.

– If you selected based on the number of users per day, you are presented with the select number of users per day screen (Figure 10-56). Enter the number of users you wish to schedule per day.

![Figure 10-55 Entering an end date](image1)

![Figure 10-56 Setting number of users per day](image2)

11. After you have entered either an end date or number of users per day, click OK.

12. You are presented with a summary screen. The wizard will calculate either an end date or number of users per day based on the information you provided. You have the option to recalculate or click Finish.
Sending the migration e-mail

1. To send the migration e-mail, open the person document in the CMT database.

2. Scroll down the document and click the Send Migration Document button, as shown in Figure 10-57. The document will be sent to the user.

![Figure 10-57  Send migration doc](image)

Alternatively, you can select the user and select Actions → Send document. This is much easier than opening individual documents if you are sending documents to multiple users.

3. The user will receive a message like the one shown in Figure 10-58 in their Notes inbox.
4. The user needs to click the Start Migration button. The migration will begin and the user will be given status messages as the migration progresses. An example is shown in Figure 10-59.

5. When the migration is complete, the user is presented with the migration complete message shown in Figure 10-60.
6. Click OK.

End user migration is now complete.

Migration document

The user's migration document is updated in the CMT directory, and the administrator can check the status. A sample is shown in Figure 10-61.

Figure 10-60  Migration completed

Figure 10-61  Extract of status of end user migration

Various details about the end user migration have been recorded and can be very useful for both troubleshooting and planning of further deployments.
Tip: We noticed during our testing, that if selected in the EU setting of the configuration, the end user migration will migrate both local and server data if the server migration has not already completed. This function of the CMT tool can be useful in distributing the responsibility of the data migration to the end user and restricting the window of opportunity for the period available to the user for migration, thus helping to plan the migration load.
Migration results

This chapter provides a review of the migration results of a user’s messaging workspace. The format for the comparison is that the “pre-migrated” image comes first, the DUS-migrated image second, and the CMT image is displayed third. The migration tools have been configured and run with their suggested defaults to give the reader an understanding of the “out of the box” capabilities of these tools. We discuss the flexibility and control options of these tools in the migrations section.

This chapter deals with the migration results obtained with the DUS and CMT tools for the following items:

- Inbox view with folder structure
- Mail message conversions
- Calendar entries
- Contacts
- Tasks/To do Entries
11.1 Mail migration results

This section shows the results of migrating various mail items using both the DUS and CMT tools.

11.1.1 Welcome page

The welcome page view section represents the “before” and “after” of the welcome page view and its folder structure. This is important during a migration because this is what the user will see right after a migration.

![Outlook Welcome page view](image)

Figure 11-1  Outlook Welcome page view

Figure 11-2 is an example of the results of a DUS migration of the welcome page view after the Notes 6 client is installed and configured. The welcome page in Notes is highly customizable, and we were able to implement the functionality available for users in Outlook into the welcome page in Notes.
11.1.2 Inbox

The user is able to scroll messages and preview a message in the preview pane in the Outlook client.
Both DUS and CMT convert the inbox and its contents. The user has access to functionality similar to that available in the Notes client.
Chapter 11. Migration results

Figure 11-4  Notes 6 Inbox view: DUS migration

Figure 11-5  Notes 6 Inbox view: CMT migration
11.1.3 Mail message migration results

In this section, we show migration results of individual mail messages with various elements in them.

HTML messages
The first object is an HTML message. It is possible that Outlook users have sent other users to Web pages, or perhaps the newsletters of your company go out to your users as HTML pages.

![Outlook HTML message](image)

Both tools convert the HTML message fairly well and very similarly. The message retains its functionality; however, some of the formatting is lost during the migration.
Figure 11-7  Notes 6 HTML message conversion: DUS

Figure 11-8  Notes 6 HTML message conversion: CMT
Messages with embedded objects

Mail messages in Outlook may contain embedded objects. Most often these are objects created with one of the MS Office applications, such as Excel or Word.

**Document with an embedded Excel graph**

![Embedded Excel graph](image)

DUS does not convert the embedded object at all.

CMT tools convert embedded objects into images in attachments and includes them as attachments to the message. We also show the enclosed attachment (Figure 11-12 on page 328). After the migration, the Excel graph is not editable in Notes; however, you are able to view it in Notes.

If your users have created embedded objects and you need to bring them, fully functional, from Outlook to Notes, you need to look into other solutions.

One solution would be to convert the objects into attachments before migration. This could be automated programmatically, for example, by writing a VBScript to iterate through mail messages, creating attachments. There might also be third party applications that will do this.
Figure 11-10  Notes 6 embedded Excel graph: DUS

Figure 11-11  Notes 6 embedded Excel graph: CMT
Migrating from Microsoft Exchange 5.5 to Lotus Notes and Domino 6

**Message with embedded Excel worksheet**

DUS does not convert the embedded object at all.

CMT tools convert embedded objects into images in attachments and includes them as attachments to the message. We also show the enclosed attachment (Figure 11-16 on page 330). After the migration, the Excel worksheet is not editable in Notes; however, you are able to view it in Notes.
Figure 11-14  Notes 6 embedded Excel worksheet: DUS

Figure 11-15  Notes 6 embedded Excel worksheet: CMT
Message with embedded table

Figure 11-17 shows a message where we created a table with some cells and sample text using the Outlook editor.

DUS converts the table correctly, maintaining the text inside the table, as well as the formatting of the table.

CMT migrates the table only partially: some of the text inside the table, as well as table formatting, is gone.
Chapter 11. Migration results

Figure 11-18  Notes 6 embedded table: DUS

Figure 11-19  Notes 6 embedded table: CMT
**Message with a URL in the message body**

Both DUS and CMT tools convert the URL properly and it is functional in the mail message in Notes.

![Figure 11-20  Outlook URL in message body](image)

![Figure 11-21  Notes 6 URL support: DUS](image)
11.2 Calendar migration results

Calendar migrations were performed against an Outlook client connected to our Exchange 5.5 server. We performed migrations with the Lotus DUS tool and Binary Tree’s CMT tool. The results varied, mainly because the calendar entry conversion philosophy is very different between the two vendors. The calendar migration results show the most differences between the two tools. This section shows the results of our calendar migration activities.
Overall calendar view in Outlook client

Figure 11-23  Outlook calendar view
Figure 11-24  Notes 6 calendar view: DUS

Figure 11-25  Notes 6 calendar view: CMT
All day event

Figure 11-26  Outlook calendar view: All day event
Chapter 11. Migration results

Figure 11-27 Notes 6 calendar view DUS: All day event

Figure 11-28 Notes 6 calendar view CMT: All day event
We found varied results for an All Day Event calendar migration. As you can see in Figure 11-26 on page 336, the Outlook calendar entry has the All Day Event check-box option checked and it has invitees as well.

The DUS conversion actually changes the type of meeting from an All Day Event to a meeting that occurs from midnight to midnight on the day that the All Day Event was to occur and in the Time Zone in which the meeting was scheduled.

**Attention:** This may or may not be an issue in your environment. It depends upon how each user uses All Day Events. Make sure you investigate how your Outlook users have been using the event.

**Example 11-1   Airplane engine stress testing all day event**

If an “All Day Event” was created in Helsinki Finland for stress testing on an airplane engine that began at midnight Helsinki time, and required monitoring of an engineer in Seattle, WA, USA, the “All Day Event” would start at midnight Helsinki time but it would have started at 2:00pm the previous day in Seattle.

![Figure 11-29   Helsinki - Seattle All Day Event](image)

When the calendar entry is converted with the DUS tool, a user would actually know what time and in what Time Zone the meeting starts and ends. With the CMT conversion, the user would not know any of this information and could potentially be ten hours late for that event!

The invitee information is also carried over in the DUS conversion and it is not in the CMT conversion. When the calendar entry was created, separate entries were created in each invitees calendar and the entries will be migrated when each user is migrated. However, in the CMT conversion, these calendar entries are disconnected and changes or updates made by the chairperson will not be able to be updated in the other users calendar entries.

A potential problem with the DUS conversion is that if an invitee of that meeting or event is in a different time zone, as we set up for the test, you can see that the
meeting will actually be displayed as occurring on that day but running from 11:00 PM Saturday to 11:00 PM Sunday. It is technically correct because the meeting for that user will actually be occurring in that time frame, but it could be confusing to an end-user.

The CMT conversion, as displayed in Figure 11-28, takes a different approach to converting the All Day Event calendar entry. CMT converts the All Day Event as an actual All Day Event, but when displayed in Notes 6, it loses the invitee list. However, the meeting is still an All Day Event, not a meeting lasting for the whole day.

**Note:** Binary Tree was on site during the migrations and stated the following about the differences in the results of the calendar migration:

When creating the migration functionality, CMT’s primary goal is to preserve the original intent of a calendar entry. Appointments or meetings which are defined in Outlook as All Day Events are migrated to Notes as All Day Events. Unfortunately, Notes does not display participants for All Day Events; therefore, if any participants were defined for such entries, they are presently not visible. In a future release of CMT, this information will be added to the Description field.

CMT always maintains original time zone for the migrated meetings and appointments. Thus, users in different time zones will always see the proper entry time representation for their local time zone, as well as for the entry’s original time zone. This will continue if users change time zones temporarily or permanently. The only drawback is that if the user is in the same time zone as the entry’s time zone, the user will still see both their own and the entry's time zones, with the same values, of course. If this is an issue, a user can simply Edit and Save the entry to only display a single value.

### 11.3 Contacts

This section shows the results of the migration of contact information from Outlook to Notes using both DUS and CMT tools. Although the contacts and the contacts view look a bit different in Notes than in Outlook, the data has been converted correctly and similar functionality is available for users in Notes.
Migrating from Microsoft Exchange 5.5 to Lotus Notes and Domino 6

Figure 11-30  Outlook contact view

Figure 11-31  DUS contact view
11.4 Tasks/To Do entries

This section shows how the tasks in Outlook are migrated to Notes. Tasks are called To Dos in Notes. Again, the tasks list looks different in Outlook than the To Do list in Notes, but the data has been correctly migrated and similar functionality is available for users in Notes.
Figure 11-33  Outlook tasks view

Figure 11-34  DUS To Do view
11.4.1 Summary

In this chapter we have shown the results of Exchange-to-Domino migration. Migration of mail messages, calendar entries, contact information, and tasks were detailed. The migration was done using both the Lotus Domino Upgrade Services tools and BinaryTree's Common Migration Tool.

Although the data is successfully migrated, some items are converted differently, as the creators of the migration tools had a different design point. Compare the migration results to the way your users use these items to determine what tool to use for the migration, as well as to set the expectations of the end users, whose data is being converted.
Part 5

Public Folders
Public folders for Domino administrators

In this chapter we describe what Public Folders are in Exchange, and what they are used for. We show how to create them and how to administer them. The topics in this chapter should help you understand the environment you are migrating better, as well as position and compare different elements in the Exchange environment to your new Domino environment.
12.1 Public Folder concepts

This section explains basic concepts related to the Exchange Public Folders.

12.1.1 Public Folders defined

Public Folders are a way of making Exchange documents available to users throughout an Exchange organization. Public Folders have forms that contain fields which, when completed by an end user, become a document. Documents are then presented to an end user, either through the original Exchange client, Outlook, or the Web, in a view sorted based on the contents of a field or fields. Folders can be bookmarked as favorites and used in a disconnected state away from the office. Public Folders can be created from a template, customized to contain business logic, and even mail-enabled. If it wasn't for the single store used for all Public Folders on a given Exchange server, it would almost sound like we were talking about a Notes database. Many companies use public folder applications, like a shared calendar, to make information available for a community of users in an Exchange organization, just like a Domino organization would use Notes databases. So being able to migrate this data could be a significant consideration in a move to Domino.

12.1.2 Public Folders and Domino databases

The differences between public folders and Domino databases range from the physical location of the database to the methods by which permissions are granted. Forms and views are created, typically, with the Outlook client. There is a replication topology to consider, just like in Domino, and the Outlook user in a coexisted state must be accommodated. There are also system folders that, unlike the AdminP database, are initially only on the first server.

12.1.3 File locations

Just like a Domino Server has a set of default databases like a Domino Directory, every Exchange 5.5 server begins with a single private (priv.edb) and public information store (pub.edb). If the default locations are used, they are placed in the exchsrvr\mdbdata folder (think lotus\domino\data). The physical drive location will vary based on an administrator's preference or the Optimizer utility, which will move files to what the optimizer thinks is an ideal location for a given Exchange server configuration.

An Exchange server can be specialized to either be a mail or a public folder server. Therefore, it is quite possible that either a public or private information store may not be on the Exchange server you may be looking at.
12.1.4 Exchange system folders

If you are migrating an Exchange organization, you need to understand where certain critical system folders are to prevent a loss of functionality during the migration. An Exchange 5.5 server can have system folders (Figure 12-2 on page 350) and the first Exchange server in an Exchange organization will have some additional folders that must be considered before that server is removed from the organization.

In our test lab’s first Exchange server (EX01) there are four system folders:

- A folder for forms that can be used by a client if no form exists for an application locally. The folder is called EFORMS REGISTRY.
- A folder for events (agents). The folder is called Events Root.
- Two additional folders are for the offline address book and for busy time lookups.

Our second Exchange server (EX02), shown in Figure 12-3 with the Exchange Administrator focused on EX01, does not have a copy of those folders, nor will it until we create replicas on it.
**Important:** Consult the Microsoft Web site for documentation on removing Exchange servers from an organization. Not removing servers properly will lead to errors in the Events Logs and a possible loss of functionality. This could include trying to replicate directory information or trying to send mail to a connector or server that is no longer available.

Figure 12-2  Exchange server Public Folders

Figure 12-3 on page 351 shows the Public Information Store on our second Exchange server. Notice that we have not created any replicas of the system folders on this server just yet.
12.1.5 Public Folder structure

Public Folders have two components, the hierarchy and the data. The hierarchy is what users see in the Outlook client when they look at All Public Folders. The hierarchy is replicated to all Exchange servers' public information stores. Public Folder data is selectively sent to other stores depending on an administrator's preference. These components are sent separately, so it is therefore possible for one of the components to be available before the other.

12.2 Creating Public Folders and administering them

Knowing how to create and administer a Public Folder and the possible restrictions a user might encounter can help you, the Domino Administrator, design and apply ACLs and Roles and allow you to create similar restrictions for database creation and access on a Domino server.

12.2.1 Tools used to create public folders

With Exchange 5.5, the only tools you can use to create a public folder are Outlook or the old Exchange client. The Exchange Administrator's program is
used to create replicas of existing public folders and control permissions once the folder is created.

12.2.2 Required permissions

If you are creating a Public Folder, the permissions needed depend on where you are creating the folder. If you wish to create a subfolder, you need to create the it right in the permissions page of the parent folder (Figure 12-4). If you wish to create a folder at the root of the Public Folder hierarchy, you need rights to the Information Store at the site level (Figure 12-5).

![Figure 12-4 The properties tab of the Test public folder](image)
Figure 12-5 shows the default configuration, which is everyone can create a top level public folder. It is very possible that this has been changed to prevent unnecessary root folder creation. So if you find yourself in a position where you have to create a root level folder and you can’t, this is the first place to check.

The Information Store Site Configuration dialog box can be reached by selecting Site → Configuration container in the Exchange Administration Program (Figure 12-6 on page 354). Using the Top Level Folder Creation tab is very similar to restricting database or replica creation in a Domino server document. To make any changes to this permission in the Exchange Administrator yourself, you need the appropriate permissions at the site and configuration levels.
12.2.3 Creating a Public Folder

Using the Outlook Client and having the focus set at the root or an existing public folder, the menu is File → New → Folder. Using the dialog box returned to you is similar to creating a new Domino database in Notes. You are presented with a list of simple applications that are like templates (Figure 12-7 on page 355).
Figure 12-7  Outlook’s “Standard Templates”

For this example the type of application we chose was the Contact Items type (Figure 12-8). We could then elect to place a shortcut in the Outlook toolbar. One thing you may consider in your migration strategy is to recreate these applications and shortcuts as databases and bookmarks in your Notes client deployment.
12.3 Controlling access

You may want to examine the permissions to accomplish several things if public folders are used. Maybe you want to mimic the permissions in the Domino databases you will be creating. It is possible that as you migrate applications, you will want to “turn off” public folder applications and prevent any new data from being added. This section provides the information necessary to view and modify permissions on public folders.

12.3.1 Setting permissions on a Public Folder in Outlook

The owner of a public folder, which is by default the creator of the public folder, has the ability to assign permissions. Permissions are not based on an NT domain. They instead are based on the mailboxes and distribution lists that are in
Exchange’s directory. Not listing someone gives them the default rights. Listing users but not giving them the right to view the folder “hides” it from the users in Outlook.

To gain access to the permissions page, right-click a folder and select Properties, or from the menu bar select File → Properties. If you do not see the permissions tab (Figure 12-10) you do not have the rights required to change permissions.

![Figure 12-10 Permissions to a public folder](image)

It is possible that an Exchange administrator might not have permissions to change things in a public folder using the Outlook client. To remedy that, an alternate way of changing permissions is to use the Exchange Administrator program. Here, too, sufficient rights are required to make changes to the client permissions.

Now if you look at the properties of an Exchange public folder in the Exchange Administrator program (for instance, our Test Public Folder shown in Figure 12-11), there are two kinds of permissions options. One set of permissions is for client access to the Public Folder from Outlook. The other is for rights to control the object in the Exchange directory.
If you do not see the Permissions tab on the Public Folder object (Figure 12-10 on page 357), do the following:

1. Go to the Tools → Options → Permissions tab (Figure 12-12 on page 359).
2. Check the Show Permissions page for all objects and the Display rights for roles on Permissions page. These options will really help clear up any odd rights issues you may have.
Important: Be very careful if you have folders nested in a folder. This case is illustrated in Figure 12-13. You can tell there are nested folders when the propagate option next to the client permissions is checked. Changing the permissions on the parent will give you the option of propagating the changed permissions to the child objects as well. This can present big problems if a secure folder is made less so by your actions.

Figure 12-12  Permissions option page

Figure 12-13  Note the propagate option
12.4 Public Folder replica creation and replication

As you migrate to Domino, knowing how long your changes will take to propagate throughout your organization will help diagnose any latency issues. When you decommission servers it may be necessary to create replicas of Public Folders on other servers to maintain an acceptable level of performance for clients remaining on Outlook.

12.4.1 Exchange connectivity and replication

Domino and Exchange administrators need to create different types of connection documents to accomplish similar things, such as moving mail around in a systematic, predictable manner, and managing the latency of both directory servers and either Exchange public folders or Domino databases. Domino’s primary advantage is that Exchange 5.5 replicates entire objects while Domino offers field-level replication.

Exchange is organized into “Sites” for either administrative, geographic, or network issues. Data, either mail or directory service information, gets automatically transferred between servers within a site and data flow is not controlled in any fashion. Public folder replication within a site can be controlled as far as latency of the data is concerned. Between sites you need to connect Exchange servers so they can send information to each other.

Exchange has several types of connectors it can use:

▶ A Site Connector uses a Remote Procedure Call (RPC) to send data to another Site Connector in another site. You cannot schedule the Site Connectors, but they can be hidden from parts of the organization and point to either a bridgehead or multiple servers in another site. Figure 12-14 on page 361 shows the Site Connector we set up to connect different sites.

▶ X.400 connectors can connect to other Exchange servers in either the same organization or in another one. They do have a schedule and can also be configured for use by parts of an organization.

▶ The Internet Mail connector is shown and described Chapter 4, “Using the Microsoft Exchange Connector for coexistence” on page 77. It can connect to either internal or external systems.

All of the connectors roll up together into what is know as the GWART, or Gateway Routing Table. The routing table for an organization can be seen in two places: the Site Addressing Object in the Exchange Administration object, or the exchsrvr\Mtadata folder as gwart0.mta.
In the same way mail can be separated from a Domino replication event, Directory Replication in Exchange is a separate event. This is important to understand as far as public folders go because certain public folder components are incorporated into Exchange’s Directory.

Using any underlying messaging topology, Directory Connectors are made available based on a schedule. You can calculate how long directory changes will take to propagate by looking at these documents. Figure 12-15 on page 362 is our Directory Replication connector.

**Tip:** If you accidently make a change that you want to rescind, look at gwart1.mta. It is the routing table before you made the changes.
Since Exchange uses the messaging topology to move Public Folder data, we now have an idea how long it could take for our changes to get around.

12.4.2 Creating a Public Folder replica

Public Folder replicas are created using the Exchange Administrator program.

1. On server EX01, select the Test public folder, go to the properties page, and select the Replicas tab (Figure 12-16 on page 363).

2. On this tab you can access servers in any site. We will be creating a replica of our test folder to the server EX02, the other server in our Exchange organization.

3. Select EX02 from the list and click the Add button.
4. The replica is created on the EX02 server.

Now, how long should this all take? It depends on both the underlying messaging and directory replication infrastructure. For example, the replication interval for a public information store might be set at 15 minutes, but the connector to another site might not be available for several hours. You can check a stores replication interval by going to Site → Configuration → Server → Public information store → Schedule. The replication interval can be seen there (Figure 12-18 on page 364). The replication interval can be customized at many levels; refer to the Microsoft documentation for further information.
If an instance of a public folder is still not available to your end users, it is possible that Public Folder Affinity between sites is an issue. Public Folder Affinity is analogous to controlling traffic with Notes Named Networks. Outlook clients don’t select an instance or replica of a public folder to open. The Outlook user points to the Public Folder Hierarchy and the folder replica they attach to is controlled. They are directed to their home server first, then randomly to servers within their site and to other servers in other sites based on costing metrics provided by administrators. If no affinity between sites exists, a replica of a public folder that is physically there is just inaccessible to an Outlook Client. Public Folder Affinity is configured at the site level on the Information Store Site Configuration Public Folder Affinity tab (Figure 12-19 on page 365).
12.5 Summary

Learning how to create, manage, and replicate Public Folders and knowing a little about how Exchange moves data around is a critical component in being able to make the migration a seamless experience until it is completed.
Public Folder migration & coexistence using ecKnowledge

In a large migration it is likely that large parts of your user community will not immediately be using the Notes clients. If your organization is using Public Folders, there might be a need to not only migrate the Public Folders, but to maintain some level of coexistence with bidirectional updates.

In this chapter, we shown how to set up and use CASAHL Technology Inc.'s ecKnowledge product. We tested the tool in our lab using a sample Public Folder and Domino database, setting up coexistence between them and then migrating the information. We have included all of the steps required to set up the product and connector. We strongly advise testing this product and the other products in the marketplace to determine which one is best for your organization.

For more information about ecKnowledge, visit the CASAHL Web site at: http://www.casahl.com/ecKnowledge/default.asp
13.1 Product setup and considerations

The installation of the ecKnowledge product is simple enough, but there will be some decisions to make prior to beginning the process.

13.1.1 Exchange considerations

On the server that will act as a gateway, you need an Outlook client along with a profile with sufficient rights to read and write to any public folder you wish to migrate and coexist with. For the sake of simplicity we used the Administrator's account, which has the rights to control any object in the Exchange hierarchy.

You also need an account to associate with the service account created by the ecKnowledge program. We used the Administrator's account here as well, again for simplicity's sake. In a real world implementation, you should consider creating a specialized account with a complex password for this application and giving it any necessary permissions to any Public Folders you intend to use.

You also need to understand which forms were associated with which Public Folder applications. ecKnowledge gets data from the Organizational Forms library on the Exchange server or from within the Public Folder itself. With that information, it reads fields in the Public Folder form and creates them in a Domino database, if necessary, or allows you to do mappings. We advise taking a look at the properties pages of the Public Folders you wish to work with to see what forms are being used. You may also wish to look at the design of the forms for any underlying logic that you might want to change before you begin.

13.1.2 Domino considerations

During our testing we installed the ecKnowledge product on our Domino server. The ecKnowledge product uses the Domino dll files to access the Domino databases. We do not recommend nor do you need the Notes client on the Domino server for ecKnowledge to work. ecKnowledge can also be placed on a computer with just the Notes client if you prefer.

- You will need to know the password, if any, that is associated with the ID on the server.
- Make sure that the ID has sufficient rights in the access control list to read and write to any Domino database.
- At a minimum, you also need to create blank Domino databases for each Public Folder you wish to migrate and coexist with, assign the appropriate rights, and replicate as required for your environment.
Create (or have someone create for you) additional forms and views for each of the migrated Public Folders/Domino databases to better mimic the look and feel of the Public Folder.

Monitor the performance of the Domino server that is acting as a gateway. You might want to dedicate a server for this function.

13.1.3 Other considerations

Make sure the profile you use can connect to the Exchange server. It is also wise to create replicas of the Public Folders you are coexisting with, if they are not there already, on the server with which the profile is associated. That should help avoid any unnecessary network traffic. You should also set expectations as to the latency of any transaction. Remember that what starts out on an Exchange server somewhere needs to replicate to the server with the profile, through the gateway, and then to whatever Domino server has a replica. The latency that you had with Exchange may no longer be true in this coexisted state.

13.1.4 Application design

Before we begin, it is useful to do a before and after comparison of the Exchange Public Folder and the Domino database.

Domino Developers will want to create multiple views and build forms with sections and tabs in the target database to mimic the appearance of the Exchange Public Folder. Outlook can use auto fill-in features to do what Domino developers might “mask” in a field like a telephone number. So the Public Folder design should be examined carefully before the migration of data begins. While ecKnowledge can create a form and propagate it with fields from an Exchange Public Folder, it will be basic at best, and the views will have no value for the end user. One final note: certain types of embedded objects, such as Visio, do not seem to render properly. Test the migration thoroughly and set your end users’ expectations appropriately before you begin.

Figure 13-1 on page 370 shows the Sales Tracking public folder in Outlook before migration. Basically, it contains detailed information about contact persons.

Figure 13-2 on page 370 shows the Domino database before the data is migrated into Notes. We have created basic items, such as views, forms, actions and navigators using Domino Designer.
Figure 13-1  Data in an Outlook view

Figure 13-2  The Domino database before migration
13.2 Setting up ecKnowledge

First, you should be logged in with the account and e-mail profile you will use to run the program. If you are installing the program on a Domino server, be aware of the fact that you have to reboot the system after installation. Once you get started, setting up ecKnowledge is simple enough if you’ve covered all the issues mentioned earlier.

1. The initial screens are the typical Windows/InstallShield setup routines and licensing agreements (Figure 13-3, Figure 13-4, Figure 13-5).

![Figure 13-3 First screen you see after starting the executable](image)

![Figure 13-4 Welcome screen](image)
2. When you get to the registration screen, accept the defaults and use the Key Manager later to get the proper keys from CASAHL.

3. The program location can be modified from the standard destination folder if you wish (Figure 13-7).
4. You can select either a custom or typical setup (Figure 13-8). ecKnowledge has a wide variety of connectors for other products, such as Oracle, Microsoft’s SQL, and SAP. Licensing is done per connector, so you may decide to use this product for things other than just Exchange and Domino migration and coexistence. We chose the Typical installation.

5. We decided to create a separate program group for the icons.
6. After the program groups are created you are asked for an account (Figure 13-10) to associate a service with. We used the Administrator’s account, but that is not what you would normally do in a production setting. You should create an account, which you will use with your Outlook profile as well, that has rights sufficient that it can act as a service. The service associated with this account initially will be set to manual, which means it will not start automatically if the server requires a restart. After testing of the connector is completed, you should consider setting the service to automatic.

7. Figure 13-11 shows you a dialog box for creating a system option. An MDB (Microsoft Access) database is created for this purpose. The ecKnowledge program uses MDAC to create the database. It will install MDAC if it is not found. We strongly advise downloading the latest MDAC from Microsoft, or using another kind of database for the catalogue. Consult the CASAHL documentation for more information.
When you install ecKnowledge with the samples, you will find some additional services added to the mail profile associated with the account used to install the program.

13.2.1 Entering the product keys

1. Start the Key Editor program located in the ecKnowledge directory (Figure 13-13).
2. The first time you start the program you might see the dialog box shown in Figure 13-14. Click OK.

![Figure 13-14 Dialog box after starting Key Editor for the first time](image)

3. Enter the Site and the Features key you obtained from CASAHL (Figure 13-15 on page 377).

**Note:** The Key Editor automatically generates a Site Code based on the machine. If you move the program to another machine, you may need to contact CASAHL for a new Site Key and Features key.
13.2.2 Post-installation tasks

1. After entering the product keys, go to Windows services and set the ecKnowledge service to start automatically. Otherwise, when you reboot the server you will need to restart the service manually. Quit Domino if it is running and reboot the computer.

2. After rebooting the computer, verify that the ecKnowledge service is running.

13.2.3 Creating the connection between Domino and Exchange

Connections are created with the Composer program, which is also located in the ecKnowledge program group (Figure 13-16 on page 378).
We found two approaches to the next step. You can either create the connections to Domino databases and Exchange folders first, or as part of the Import/Export wizard. We selected to use the Wizard.

1. Select Create → Import/Export to start the wizard.

2. Click Create New Connection to create the connection (Figure 13-18).
3. You need to be very specific when filling in the dialog box shown in Figure 13-19. Be careful if the machine you are using has multiple profiles. Make sure you spell correctly the profile with the proper credentials to the Public Folders you wish to migrate/coexist with.

4. Click the button next to the Folder field to choose the source Public Folder.

5. Choose the folder for migration/coexistence and click OK (Figure 13-20 on page 380) to confirm the folder selection and click OK to confirm the Connection dialog. You are returned to the Source dialog (Figure 13-21).
6. Here things get a bit tricky. ecKnowledge reads information from the Organizational Forms Library and the Public Folder. You need to know what form and fields you want to use for the migration before you get started. IPM.Post.Account form has the fields we want and is associated with the public folder Sales Tracking. Choose the form and click Next to proceed to the Destination dialog.

7. The next step is setting up the Domino side. Click Create New Connection to create one.

8. When you create the Domino connection you need to specify the Domino data path and the nsf file you want to use (Figure 13-22 on page 381).
path may vary from machine to machine. Our Domino database has a form, although if it did not, ecKnowledge would create one.

9. Once you click OK to confirm the Connection properties, you are returned to the Target dialog (Figure 13-23). Select the correct form and click Next to proceed.

10. The next step is to map fields (Figure 13-24 on page 382). You can elect to let ecKnowledge do it for you automatically (Figure 13-25) but you will still need to verify the mapping (Figure 13-26 on page 382). Click Next to proceed.
11. The next option asks if you want to match columns based on names, which we accepted.
12. Figure 13-28 shows the field matches ecKnowledge can find and shows fields it could not. One necessary step is the selection of a key field or fields. If this selection is not made, you will see a warning message.

13. Select your key field. We chose the company name field as the key field (Figure 13-29). Click OK.
14. You have the option of setting up filtering for the Import/Export Connector.

Filtering can be set up by field (Figure 13-31) or keyword (Figure 13-32). VBScript or Domino's formula language can be used to set parameters.

**Figure 13-30  Parameter choices**

**Figure 13-31  Field filter choices**

**Figure 13-32  Field sort by keyword**
15. You can also decide what you want to do with the source data and how to handle errors. We selected Update existing records in Target with same keys.

![Parameter control](image13-33.png)

Figure 13-33 Parameter control

16. The step shown in Figure 13-34 provides execution, error control, and job handling.

![Execution control dialogue box](image13-34.png)

Figure 13-34 Execution control dialogue box

17. The following four figures show the different scheduling options. You will need to take into account the expectations of your end users and your long term goals as you make these choices.
Figure 13-35  Coexistence can be run manually

Figure 13-36  Running coexistence as a daily event

Figure 13-37  Running the job weekly
Chapter 13. Public Folder migration & coexistence using ecKnowledge

18. If you want an e-mail notification to occur based on a condition, you can select a user to send it to (Figure 13-39).

13.2.4 Running the coexistence

For our testing purposes, we elected to run the job manually from the Composer program.

1. Select the job in Composer, right-click it, and select Start to start the job (Figure 13-40).
2. Figure 13-41 shows the data populated as a result of the job we created. If we select an entry, we can see how the data appears in Notes (Figure 13-43) and compare it to the same record in Outlook. (Figure 13-43 on page 389).
3. Finally, if you need to modify any job, you can go into Composer and examine it's properties. Figure 13-44 on page 390 shows the options that will be presented.
13.3 Working with a blank database

In the previous example we prepared a customized Domino database, set up the connectors, and migrated the data. The next example shows what an Exchange Public Folder looks like if you start out with a blank database and migrate data to it using ecKnowledge.

13.3.1 The Exchange Public Folder

The Exchange Public Folder has service requests in it (Figure 13-45). The form used is a simple one with a simple page holding all the fields (Figure 13-46).
The steps involved with migrating the data is almost the same as in our previous example. The only difference occurs when you are setting up the Domino side of
the connector. Remember you are starting with a blank database with only the default view. In Figure 13-23 on page 381 you selected from the available Domino forms. Because you have no forms, type in the name of the form you would like ecKnowledge to create.

13.3.2 Migration results using a blank database

ecKnowledge does successfully migrate the data, as seen in the document pictured in Figure 13-47. While somewhat plain looking, it does have the information from the Service Request Public Folder in it and it is somewhat usable.

![Figure 13-47 Migrated data with the form created by ecKnowledge](image)

The view, however, only shows document numbers, and to someone unaware of Domino view capabilities it would look broken (Figure 13-48).
To give end users what they had in Outlook, we need to modify the Notes view to show the contents of the Request Date, Request Number, Requested By and Service Description fields. We will do that with the Domino Designer program.

### 13.3.3 Using Domino Designer to modify the view

This section is not a complete guide to building views; that would be beyond the scope of this book. All we are interested in doing right now is making the views look the same as they do in Outlook. You will need a copy of Domino Designer, which must be purchased separately. This section assumes you have never used Domino Designer before. If you are a Domino developer, you can skip this part since it is only targeted for Exchange Administrators and other who need a very basic high-level overview of how changing a view is done.

1. Open the Service Request Database in Domino Designer.
2. Select the Untitled view in the left side of Designer (Figure 13-49). By default, only one column is defined, and that uses a document number by default defining what is presented to the end user.
3. Each column in a Domino view will have its own set of properties that will control things like appearance, sort order, and data format. You can reach the column properties by right-clicking the column in designer. You can also access them by the menu selections Design → Column Properties).

You change the contents of a column at the bottom of designer. There you can place the content of a field, or multiple fields if you wish. You can add logic and simple functions as well.

4. Let’s change the value of the first column. With the first column selected, at the bottom of the screen select the field radio button (Figure 13-50) and then select the reqdate (requested date) field.
5. You can then go to the properties box for the column and change things like the title and format of data. Clicking the check box saves your changes.

Figure 13-50  Select the field radio button then reqdate

Figure 13-51  Column properties
6. You might as well change the name of the view and save it. In the Domino Designer select Design → Properties.

![View properties](image)

**Figure 13-52 View properties**

7. You can insert or append to add additional columns. Inserting adds a column to the left of the selected column and appending adds a column to the right of the last existing column. If you make a mistake you can drag and drop a column to the right place later. Figure 13-53 shows that we are inserting a new column.

![Adding a column](image)

**Figure 13-53 Adding a column**
8. You can add any field you want to be shown in a view except for a field of type Rich Text.

![Figure 5-56 Appending a column to a view](image)

9. Add the fields you want to each column, and make whatever changes to the column properties you may need, based on the types of data.

10. When you are done, your end users will see something that is similar to what they had in Outlook. This is illustrated in Figure 13-54 on page 398.

If you need more information on how to further customize views for your end users, see the Domino Designer 6 Help database, IBM Redbook *Domino Designer 6: A Developer's Handbook*, SG24-6854-00, contact a Business Partner, attend a Domino Developer's training class, or search the Lotus Developer Domain at [http://www.lotus.com/ldd](http://www.lotus.com/ldd) for additional resources.
13.4 Conclusion

If you have data in your Public Folder that you need to not only migrate but also coexist with, as demonstrated here, you do have options. Success will depend on you setting expectations as to performance and latency and making the transition of entering data in Outlook to Notes as seamless as possible. It may require some planning and effort but that should help overcome any resistant to migrating from Exchange to Domino that is based on data stored in Public Folders.
Public Folder migration using CMT migration tool

This section deals with a one way migration of Public Folder data from Microsoft Exchange 5.5 to Domino 6. The tool we describe for accomplishing this is the CMT for Exchange Public Folders migration tool (referred to as “CMT” or “CMT tool” later) from BinaryTree. The Domino Upgrade Service does not currently support the migration of Public Folder data. As with all the products mentioned in this book, you should thoroughly evaluate the CMT tool to see if it is appropriate for your environment.
14.1 BinaryTree’s CMT for Exchange Public Folders

The data in a Microsoft Exchange Public Folder often has significant value that has been protected with permissions based on the identities stored in Exchange’s Directory. To help firms recover the intellectual capital often found in these Public Folders, Binary Tree has created CMT for Exchange Public Folders. CMT not only takes data from the Public Folders, but can also mimic the permissions that existed on the Exchange servers in brand new Domino databases. CMT migrates the standard Exchange document types, including mail messages, calendar events, journal items, tasks, and notes. If your Public Folders contains forms that have been modified to include additional fields and datatypes, the CMT tool can be customized to migrate this data as well. Visit the BinaryTree Web site for additional information about the CMT for Exchange Public Folders migration tool.

14.2 Setting up the CMT tool

The CMT migration tool is a Domino database that needs to be configured prior to its use. Before you begin that, one issue that came up in our testing: verify permissions on the Public Folders being migrated. A MAPI profile is needed to read the Public Folder Hierarchy and the data in the Public Folders. It is recommended that the MAPI account used have owner rights to any public folder being migrated. That allows the profile to read all of the information in a Public Folder, including attachments, and recreate the Public Folder contents in the migrated databases. Verify, as well, that the Notes user migrating the Public Folders has the necessary rights to create Domino databases on a server.

14.2.1 Preparing the tool to migrate permissions

In order to successfully migrate permissions, you need to import the users from the Exchange directory into the CMT for Public Folder program. It is necessary to have imported all the users whose names you will be mapping from the Domino Directory for this to work.

1. Extract the csv file found in the help view of CMT for the document containing the file (Figure 14-1).
2. Open the document and detach the file, placing it in a directory where you can get to it from the Exchange Administrator program. Using this file is important because it has the proper fields listed in the first row.

3. Use the Exchange Administrator to get a list of users placed into the CSV file you just created. Making sure you have the proper permissions first, open the Exchange Administrator and set the focus to the Global Address List (Figure 14-3 on page 402). Select Tools → Directory Export.
4. When you select Directory Export be sure you select the file you detached earlier (Figure 14-4). Click Export to export users.

5. After you have selected Export, go back to the CMT database.
6. Select the Import from CSV button and specify the file you have been working with (Figure 14-5).
7. Select the root of the organization you want to import (Figure 14-6).

8. Select what part of the organization you want to import. Be sure that you select the “o” component to get all of the users in the Global Address List. Once the import has occurred you will see all of the Exchange users and their matching counterparts in the Domino Directory (Figure 14-7 on page 404).

With the ability to do ACL matching, CMT for Public Folders will translate Exchange permissions into Domino permissions. The equivalent permissions are shown in Table 14-1.

<table>
<thead>
<tr>
<th>Exchange permission</th>
<th>Domino permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>No Access</td>
</tr>
<tr>
<td>Contributor</td>
<td>Depositor</td>
</tr>
<tr>
<td>Reviewer</td>
<td>Reader</td>
</tr>
<tr>
<td>Author</td>
<td>Author</td>
</tr>
<tr>
<td>Editor</td>
<td>Editor</td>
</tr>
<tr>
<td>Owner</td>
<td>Manager</td>
</tr>
</tbody>
</table>
With the users in the CMT database, you next set up the CMT program to import the Public Folders. You should examine the Domino ACL to remove any duplicate names that might appear.

### 14.2.2 Configuring the import of Public Folders tool

1. On your Notes client, open the CMT tool database and open the Migration Settings document (Figure 14-8).

2. The default settings for the Domino address book (Domino Directory) file will need to match your server’s settings (Figure 14-9).
3. On the Exchange Public Folder page (Figure 14-10) you may need to set the Exchange Public Folder Root to have nothing in it, depending on what you would like to import. We left the Exchange Public Folder Root blank, so we could take all of the Exchange Public Folder.

You might also want to specify a profile to use for the migration of Public Folders. That will prevent being asked each time a database is created. Additional options are available for the types of messages that you might want to migrate.
Importing Public Folder names

1. Click Import All Public Folders as shown in Figure 14-11. This does not perform the migration; it just brings in the folder names so you can select the ones you wish to migrate.

![Figure 14-11 Bringing the Public Folder list into the CMT database](image)

2. As the process begins you are asked for the Public Folder root (Figure 14-12). We went with the default of All Public Folders.

![Figure 14-12 Public Folder root selection](image)

3. The next question concerns which MAPI profile you want to use. If multiple profiles exist on the workstation, choose the one with owner rights to the Public Folders you wish to import (Figure 14-13).
Importing Public Folders

The next step requires a bit of analysis before you go forward. The CMT tool is designed to import data from the “standard” kind of Exchange Public Folders, such as Contacts. The CMT tool will use a template with forms that map to fields in those kinds of forms. If you ask CMT to evaluate and import “customized” folders, you might not get the expected results. More on that later.

For our Migration test we started with some basic Public Folders which are based on the “standard” kind of forms, as well as a mix of folders that had the basic Outlook forms customized.

In your testing of the product, be sure to evaluate a wide cross section of documents that are in a Public Folder. In some migrations, success is a seamless transfer of data across systems. Since Public Folders may hold timely and relevant business information, mitigating any issues before hand will help meet any expectations that may be set as part of the deployment.

To import Public Folders:

1. Select the folders you want to import from the list and click the Migrate Selected button to start the job (Figure 14-14).
2. You may be prompted to accept or reject the overwriting of Domino databases and may need to confirm the MAPI profile used during the migration.

3. You will see a progress bar while migrating.

4. When the migration is done, a green check mark appears next to the name of the folder, indicating successful migration.
5. After migration, the Public folders were converted into Domino databases and the documents were converted.

Attention: We did see mixed results when looking at the various documents, and noticed that not all data is migrated without problems. CMT for Exchange Public Folders tool uses the same engine for converting documents as CMT for Notes does, and we have documented the migration results of the individual message types, in 11.1, “Mail migration results” on page 320. We advise that you carefully examine the data types that may exist in your Public Folders and consider the consequences that the possible loss of any data fidelity might present.

6. Figure 14-18 on page 410 shows the Domino database after the Public folder information has been migrated to it.
CMT tool was successful in bringing in standard type of Public Folder data. The following is a series of documents in both Outlook and Notes showing different types of Public Folder data.

The first example is one of more difficult items, a contact form. First shown in Outlook and then in Notes. The users experience will be somewhat similar with data fidelity maintained.
The view of “Contacts”, Figure 14-21 on page 411, also has a similar look and feel to its Outlook counterpart (Figure 14-22 on page 412). The same contact shows up multiple times because of her multiple categorization.
Dealing with customized Public Folder forms
Public folders might contain non standard forms, meaning something other than the standard mail and post, Journal, Contact, Note, Task, and Calendar kinds of forms. Those custom properties (or fields) will be imported as part of the message in Notes. You need to take some extra steps to create the User Interface to show those fields to your end users.

1. Open the Migration settings document as shown in Figure 14-9 on page 405.
2. Go to the Exchange Public Folder configuration page.
3. The very last field in the document is where you set up how Custom fields are treated in the migration. Select Bring across all custom fields.
4. Do the Public Folder migration again.
5. Figure 14-24 shows a non standard form in Outlook.
The default Domino database where we migrated the public folder to is shown in Figure 14-25.

6. To see that the fields actually are part of the document, open the properties for a document (Edit → Properties) and go to the second tab (the Fields tab). Scroll down the list of fields to see the custom fields. *RequestNumber* field in
Figure 14-26 is an example of a custom field. On the right-hand side of the dialog box you can see that the it has the value 1001.

7. If you open the document, you notice that none of those fields are actually shown as part of the document.

8. The document contains a file attachment. When opened, it looks similar to Figure 14-27 on page 414. Each row lists a custom field name and the value of the field in the document. You can use this as a guide when designing the form to show the document.
9. Use Domino Designer to create a form to show those fields to the end user. Going through all the necessary steps to create a form and views to show all these fields is beyond the scope of this Redbook. For detailed information about designing Domino applications, refer to the IBM Redbook Domino Designer 6: A Developer’s Handbook, SG24-6854.

10. Figure 14-28 shows the design of a form in Domino Designer that we created to show the desired end result of the migration. The form is an example of what a application might create to mimic the look and feel of a customized form in a Public Folder.

![Service Request form in Domino Designer](image)

**Figure 14-28 Service Request form in Domino Designer**

11. Figure 14-27 shows the document in the Public Folder and migrated into the Notes client. The document is viewed with the form we created.
14.3 Summary

Migrating data in a one way manner between Exchange and Domino can be done using the CMT tool. What is required is making sure that the profile has the correct permissions on the Exchange side, that the application has not been customized, and that sufficient permissions are available on the Domino server to which the data is being migrated. It is reasonable to expect that some post migration work may need to be done, especially when customized forms have been used in Exchange. Additional development work is need to mimic the functionality of custom applications that have forms with additional fields.
Manually migrating Public Folder data

This chapter covers the manual migration of Public Folder data to Domino. It is assumed here that you only have a very limited set of data in Public Folders that you need to keep. In a small organization, where migrating to Domino can occur quickly, you do not need to provide the coexistence that more sophisticated tools provide, or you may just have limited resources and can’t justify the expense of the automated tools out there.

Manually migrating data will require time and some degree of patience, and you will need to learn how to manipulate data in different programs. If you are going to move data into Domino, you will need to be able to create Domino databases and views, as well as manipulate data in Domino documents.
15.1 Tools to move data

To get data out of Public Folders, your toolkit will at least need the following:

- The Exchange Administrators Program and the rights to create mailboxes
- An Outlook Client
- A Notes Client
- Excel or Lotus 123

With these tools you should be able to get data out of most of the more common Public Folders.

If your needs are a little more sophisticated, some really useful help is on the Slipstick Systems Web site at:

http://www.slipstick.com/dev/customimport.htm

The Web site contains a set of tools to import and export data from Microsoft Outlook forms.

If you can't get the information out of Public Folders using these tools, then you probably need to purchase one of the tools mentioned in the previous chapters.

15.2 Migrating Public Folder data in a mailbox

One reason you might want to take this approach is that you can import a mailbox and its contents using the Domino Upgrade Services (DUS). This tool is discussed in more detail in Chapter 9, “Migrating users using Domino Upgrade Services” on page 253, so our concern is getting Public Folder data into a mailbox first. Remember, any manual operation may require “tweaking,” as is the case here.

The steps, detailed later, are as follows:

- Create a mailbox and give yourself rights to it.
- Add the mailbox to your Exchange profile.
- Copy the Public Folder information into the new mailbox.
- Verify the data integrity.
- Migrate the mailbox.
- Manage the new database.
15.2.1 Creating the migration mailbox

You need Administrative rights on the Exchange server to create a mailbox. When you create the mailbox, give the mail account the NT credentials that will belong to the person who will modify their Outlook profile to include this mailbox later. You are not really creating a new user, just a mailbox to hold Public Folder information.

Notice the Primary NT account that belongs to the user whose profile you will add to the mailbox (Figure 15-1). In this case it is the Administrator.

![Migration Mailbox](image)

*Figure 15-1 Creating a mailbox*

15.2.2 Setting up the profile

In the mail profile of the user you have given rights to, add an additional mailbox.

1. Select the Mail icon on the control panel.
2. Access the profile you will be using (Figure 15-2 on page 420).
3. Go to the Microsoft Exchange properties page (Figure 15-3).

4. Go to the Advanced tab. (Figure 15-4). Click Add to add the mailbox you created earlier.
5. Type in the name of the mailbox you will use to put data in.

6. The mailbox has now been added.
7. Copy the contents of the Public Folder by right-clicking the folder. Select Copy “Your public folder name” (Copy “Service Requests” in our example) from the pop-up menu.
8. Copy the contents of the selected folder into the mailbox of your choice
     Figure 15-8.

     Figure 15-8 Selecting the target mailbox

     After the data has been copied, you may need to do some additional
     manipulation of the data to verify a successful transfer. To do this you may need
     to modify or create a view just like the one that was in your Public Folder.

     1. Set focus on the folder whose view you will customize.

     2. Select Current view → Customize Current View.
3. Click the Fields button (Figure 15-10).

4. You may need to take a look at the fields used in the Public Folder view. In our Public Folder, we needed the user-defined fields in the form (Figure 15-11).
5. Once you've added the fields, click OK. You can see that new columns have been added (Figure 15-13).
We can now use the Domino Upgrade Service to bring the data into Domino.

15.3 Using a spreadsheet to massage data

If you are familiar with Domino design, you know that you can import data from Lotus 123 into a view. You can then modify the forms and views to produce the application look and feel you want. But what if you have Outlook and Excel, but no Lotus 123?

Go to the Public Folder whose data in a view you wish to capture. Select all the documents you want.
Then do a copy (Figure 15-14) and paste the information into Excel (Figure 15-15).

You may need to use this technique a couple of times to extract all the data you want to pull out, and you may need to create some custom views to achieve your goal of data extraction.
Remember that Domino can use Lotus 123 data, which can be imported into a view. Just save an Excel spreadsheet as a 123 spreadsheet and you have the data format you need for your application.

15.4 Dealing with Outlook contact information

Outlook contact information is a common Exchange Public Folder application. You can use the view, copy, and paste technique we just demonstrated to migrate this information, or you can take advantage of a new Notes 6 feature, vCards. vCards are standardized ways of electronically sending business cards. You can send a vCard from Outlook. But instead of mailing them, here’s what you can do:

1. Go to wherever your contacts are. Select as many cards as you want (Figure 15-16).

2. Select Actions → Forward as vCard.
3. What you can then do is mail the cards to someone who can import them into a personal address book and make that database public later. Or you can detach the files and make them available to end users so they can do it themselves.
15.5 Archiving or sending Public Folder data elsewhere

If you do not feel comfortable creating applications using extracted Public Folder data, you can send the Public Folder elsewhere for someone else to work on it. It's unlikely that you will want to send the entire data store because that would require an Exchange 5.5 server and recreating permissions. A PST (personal storage file) is a much more convenient way of doing it.

**Tip:** A PST could also be used in a migration to store old mail messages of a critical nature. In the future, an Outlook client is all that would be required to recover a single document, which could be printed or e-mailed to the new system later.

**Attention:** The larger you make the PST, the more likely it is to get corrupted. There is a 2 gigabyte limit on PST files. You would be better served by created several smaller PSTs instead of one big one.

Creating a PST from a Public Folder is simple.

1. Select the Public Folder and go to the File → Import/Export option.
2. This invokes a wizard that walks you through the steps that get the job done. When the wizard begins, select the Export to a File action (Figure 15-19).

   ![Figure 15-19 Select export to a file](image)

3. Select Personal Folder File (.pst)
4. You can select one or a set of nested folders if you want.

5. Give the file a name and specify a location.
6. It is usually a good idea to give the Public Folder a different title than the default of Personal Folder, just in case the developer has multiple personal folders to work with (Figure 15-23).

![Figure 15-22 File name and the location](image)

**Figure 15-22** File name and the location

![Figure 15-23 Specify a name for the personal folder](image)

**Figure 15-23** Specify a name for the personal folder
7. You can put a password on the PST. Be aware that if you lose the password you will need to recreate the file.

After the PST is created you can send it to anyone you choose, by any means, including electronic. Just remember that if you burn the file onto a CD you will need to copy it back to disk and remove the read only attributes before you use it.

15.6 Summary

Data can be moved from Exchange Public Folders manually and be reused later. In this chapter, we have described several ways to do this. You might consider using one of these techniques if the data in your public folders is simple in structure and coexistence is not required.
Part 6

Migration project wrap up
Chapter 16. Removing the Microsoft Exchange environment

This chapter deals with removing Microsoft Exchange from your organization. The process can be simple or fairly complex depending on the size of the installation and the speed of your migration.
16.1 Removing Exchange servers

As you begin removing Exchange servers from your company, be sure to consult the appropriate Microsoft documentation, some of which is listed here. Not following the proper procedures might lead to a disruption in the messaging flow, Public Folder access, directory services, and other Exchange server functionality.

16.1.1 Reasons to remove Exchange carefully

If you are removing a single server from a single site the process is a very straightforward one. After you migrate your users and are confident that all is well with your Domino migration, you simply power off or reconfigure the server.

If you run a multi-server, multi-site environment, you will most likely need to go through a period of coexistence before you can reuse the equipment, if that's your plan.

During that period of coexistence there might be Public Folders that need to be replicated and re-homed. Connectors may need to be replaced or removed, routing may need to be recalculated, and directory connectors may need to be removed. You need to consider where you are in your migration before you start.

16.1.2 Reasons for leaving things alone

You may, of course, elect to leave your Exchange structure intact, shutting it off only after you've migrated completely. This certainly will give you a fallback position should something in your Domino migration go wrong. The servers which hold Exchange could be getting old as well, so reusing those servers will probably not be a high priority. Leaving the Exchange servers up could also facilitate the recovery of any messages that might have, for whatever reason, not migrated over successfully. Finally, there is the possibility of problems with some regulatory issues concerning the deletion, however unintentional, of mail.

16.1.3 Additional resources

The Microsoft Knowledge Base has some very important articles on the topic of removing Exchange 5.5. Failure to take a look at these documents first can result in some serious issues later. You can get to any of the following technotes by going to http://support.microsoft.com

- Knowledge Base article 189286 covers deleting a server from a site.
- Knowledge Base article 152959 covers deleting the first server in a site. This may or may not be the same as the previous item.
If you accidently erased the Organizational Forms Library, Knowledge Base article 239760 may help you recover the lost forms.

And finally, if you need to recover a single mailbox from a deleted server without causing problems with your remaining Exchange organization, see Knowledge Base article 163713.

16.1.4 Before you begin removing Exchange

First, you should be completely confident that the Domino migration is going according to your plan. Your connectors should be working, and both messages and directory changes, if you've elected to put both in, are working predictably. Any profiles that users had to the old Exchange servers should be gone by now and, if they are not, you should be removing them. Having a user start Outlook and have nothing happen will make no one happy.

You should have good backups that have been thoroughly tested. Few things could be worse than finding out management wasn't quite ready yet, and you've just finished removing Exchange and the tapes don't work.

What is your Exchange contraction strategy? If you can't answer that question you better start working on one. Do you know what Public Folders are on what servers? How about the one connector you had in an Exchange site that acted as a gateway? Removing Exchange is easier than installing it, but that doesn't mean you can get away with no planning.

In the locations that have Exchange, how many Exchange servers are there in a given site? If there is more than one, do you know which was the first one? If this is a phased contraction, it might make a difference.

As you are removing Exchange from your network, remember the old carpenter's motto: "Measure twice, cut once."

We next go through some scenarios of Exchange removal. The two we focus on are a single server in a single site, and multiple servers in a single site.

16.2 Single server, single site

This scenario might apply to a branch office. Consider that you have migrated your users and their mail to Domino and you still have Exchange in your organization. If you just shut down this Exchange server, the other Exchange servers, at the least, would still attempt to send it directory changes and mail. In a worst case situation, this server would have your only internet connection and the removal of the server could impact other users in other sites.
16.2.1 Considerations

Being extremely cautious, let’s imagine some of the things that could be on that server:

- A mailbox you chose not to migrate, like an archival mailbox that held information from the mailboxes of other users.
- Public Folders that do not have replicas elsewhere.
- Connectors, or it could be a key management server.
- The server could be a bridgehead or a replication hub.
- Public Folders might be homed on it.
- Maybe you started to deploy Active Directory and the server has the Active Directory connector on it.
- The server is used to expand a distribution list.

These items, in and of themselves, are not a reason to necessarily keep a server up indefinitely. However, they may represent issues that need to be mitigated prior to decommissioning any Exchange Server. What follows are some suggestions on how to deal with such conditions.

- Mailboxes not migrated
  
  If a mailbox contains messages but was not migrated, there are two alternatives. Either place the mail in a PST—the details on how to do this are the same as for a Public Folder—or confirm you have a good backup, and recover messages as required on an Exchange server that is not really part of the network. For details on this, see Microsoft Knowledge Base article 163713. If you put the mail in a PST and store it optically, you will need to return it to disk and change the permissions from read only. If you are relying on tape, be aware that recovering an Exchange server can take several hours from start to finish.

- Only replica of a Public Folder
  
  Follow the steps in the Public Folder basics section, 12.4.2, “Creating a Public Folder replica” on page 362, for details on creating additional replicas if required. You will need to determine if the folder has any relevancy, or if it is tied to an existing application. You may need to change the configuration of the affected components if that is the case.

- The server has connectors
  
  The impact of removing a server that has a connector could be profound to the other remaining users of Exchange. Be sure to create alternate connectors with a lower cost than the connector being removed. Also, allow for any changes you make to your topology to propagate through the rest of your Exchange environment. If the server is in a single site...
Chapter 16. Removing the Microsoft Exchange environment

is the Internet connector, make sure that you have a way to send mail to the Internet, as well as the appropriate MX records to point to the connector. Allow sufficient time for the MX records to replicate on DNS servers throughout the world. If someone else is hosting DMS services for you, make sure the provider makes the changes correctly.

- It is a key management server

   This server manages keys used to sign and encrypt mail. If this server was unavailable and a user’s certificate expired, they might not be able to open some messages. See the Microsoft documentation on how to move this functionality elsewhere.

- Bridgehead server

   While not very likely, a server might act as a hub for one or more functions. If the single server is acting as a bridgehead, make sure you adjust your topology accordingly.

- Public Folder home server

   If you have a Public Folder that was created on the Exchange Public server you wish to decommission, then the Public Folder will need to be re-homed in order to ensure that proper permissions are maintained. To re-home a folder, first create a replica on another server, and then go to the advanced properties of the folder resetting the home server (Figure 16-1).

![Figure 16-1 Changing the Home server of a Public Folder](image)
Public Folder permissions can be reset when a consistency check is done on the information store. Orphaned Public Folders get new permissions when the original server can no longer be found in the directory. The consistency checker is manually run when you delete a number of objects and want to clean things up. The Consistency Adjuster is on the Advanced tab of the Property page of the server (Figure 16-2).

![Figure 16-2 Consistency adjuster on an Exchange server](image)

- An Active Directory connector is on the server
  The Active Directory Connector is used to synchronize data between the Exchange 5.5 world and Active Directory. Loss of the connector means there would no longer be updates between Exchange 5.5 and perhaps Exchange 2000 servers that might have been part of a cancelled deployment. Your alternatives are to break the connector and let no further changes replicate or place the connector elsewhere.

- Server is specified to expand distribution lists
  A distribution list can be parsed locally or on a specified server. Verify that distribution list expansion is not on a targeted server.
16.2.2 Removing the server

If you are satisfied that you are ready to decommission this single server, take the following steps.

Remove all existing connectors to the site
You need the appropriate levels of permissions to remove connectors.

1. From the Exchange Administrator program, first delete the directory connectors (Figure 16-3).

![Figure 16-3 First step in removing the directory connector](image)

2. Confirm the deletion by clicking Yes.

![Figure 16-4 Confirm the directory connector deletion](image)

3. If you have the rights, you next have the option of removing the connector at the remote site (Figure 16-5). If you do not have permissions, the deletion will fail. Click Yes to confirm the deletion.

![Figure 16-5 Removing remote directory connector](image)
4. The dialog shown in Figure 16-6 warns of the consequences of using the Consistency Adjuster before you have verified that the Public Folders have been re-homed properly. You should have done this as part of your pre-contraction checklist.

5. Remove your site connector to the Branch Office (Figure 16-7).

Important: Besides Site Connectors, you may find either X.400 or SMTP connectors that would need to be removed as well.

6. You will be asked to confirm this action. Click Yes.
Check Event viewer
Make sure you check the Event viewer program for errors. Verify that messaging and directory services between the remaining sites still function.

Force replication
In the site or sites that remain, force replication from servers that connected to the site about to be removed to other sites.

Get rid of orphaned objects
Run the consistency adjuster on all servers (Figure 16-2 on page 442).

Recalculate routing
Run the routing calculation on the routing calculation page of the site addressing tab (Figure 16-8).

Your server’s global address routing table will no longer show a way to get to the Branch Office (Figure 16-9 on page 446).
Uninstall Exchange 5.5
Uninstall Exchange 5.5 software from the server being removed by running the setup program.

16.3 Removing a server from a multi-server site

In this scenario you have multiple Exchange servers in a site. You might have some users on one Exchange server but not on the other. The things you need to be careful of are the same as the single server, single site scenario, but with one big exception: the first Exchange server in a site does things that other Exchange servers do not. Among the things a first server does, by default, include it being:

- A routing calculation server
- Site folder server
- Default site folder replica server
- Offline Address Book generation server

So, if you have a choice, you would delete the first server last under most circumstances. Knowledge Base Article 152960 deals with moving first server...
functionality. Best Exchange practices will have you move those functions before decommissioning the first server.

Otherwise, removing other Exchange servers from a site follows the same pattern as a single server, single site. The steps are as follows:

1. Verify everything on the single server, single site list.
2. Make sure the server is not the first server.
3. Run the Exchange setup from the server you are decommissioning and make sure to remove all connectors. Not doing this may result in your being unable to remove the server.
4. Using the Exchange Administrator on a remaining server, remove the object that represents the deleted server.
5. Force replication to other sites.

If you need to keep users on Exchange in a site but need the server, either migrate the users or use the Exchange Administrator to move them to another Exchange server in the same site.

16.4 Summary

It may take several months to migrate all users from Exchange to Domino in a large organization. In a low bandwidth environment, you do not want unnecessary network traffic from redundant messaging systems, so decommissioning servers is important not only from a networking perspective, but from a cost of ownership perspective as well. It is very important to consult the Microsoft documentation to ensure that contracting your Exchange environment is done properly.
Exchange Connector
installation checklist

In this appendix we provide a checklist to be used to retain information that is required during the installation of the Exchange Connector.
General setup information

To install and configure the Exchange connector for Lotus Notes you will need at a minimum the following information:

- Domino Version ________________
- Notes Client Version ______________
- The Domino server name ________________.
  Note: In a multi-server environment, your registration server and mail server might not be the same.
- The name of the Domino Administrator ID file is ________________.
- The password for the Domino Administrators id ________________
- Mail File Template name ________________
- Domino Certifier location ________________
- Domino Certifier Password ________________
- The Exchange Administration account name ________________
- The Exchange Administration Password ________________
- The Exchange server name is ________________
- The Exchange Organization name is ________________
- The Exchange Site name is ________________
- The WinNT domain name is ________________.
Creating an Outlook profile

In this appendix we show how to create an Outlook profile.
Creating an Outlook profile

To create a profile and add a Microsoft Exchange Server Service to your Outlook client:

1. Right Click the Outlook icon and select Properties.
2. Click Show Profiles.
3. Click Add.
4. In the Use the following information services box, select Microsoft Exchange Server.
5. Click Next.
6. Another dialog box will appear asking for a profile name; give it something descriptive, like admin.
7. Click Next.
8. Fill in the following fields:
   Microsoft Exchange Server, such as EX01
   Your Exchange mailbox name, Administrator in our example
9. Click Next.
10. Click No (default) for Do you travel with this computer, then click Next.
11. Click Finish.

Figure 16-10   Outlook setup properties
Figure 16-11   Select the default profile

12. In the box When starting Microsoft Outlook, use this profile, select your new profile. Figure 16-11.

13. Click Apply and Close to finish.
## Comparing the features of different clients for Domino

### Table C-1  Mail

<table>
<thead>
<tr>
<th>Feature</th>
<th>Webmail</th>
<th>iNotes Web Access</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Views and Folders</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inbox view</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Drafts view</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>All Documents view</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Discussion thread view</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Folders</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Nested Folders</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create and delete folders</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Drag-and-drop messages into folders</td>
<td>No</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>Copy and move to folder</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Soft deletes</td>
<td>No</td>
<td>Planned for 6.0.1</td>
<td>Yes</td>
</tr>
<tr>
<td>From the action bar, open mail into specific view (ie. inbox, sent, drafts, etc)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Message Creation and Addressing</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>Create new memo</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Type-ahead addressing</td>
<td>No</td>
<td>Yes, automatic name resolution provides this function</td>
<td>Yes</td>
</tr>
<tr>
<td>Support file attachments</td>
<td>Yes, limit of 2</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>View file attachments from within message</td>
<td>No</td>
<td>No, third-party products are available for this</td>
<td>Yes</td>
</tr>
<tr>
<td>Spell checking</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Alternate name support</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Sametime integration</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Perform Name &amp; Address Book lookup</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Display contacts sorted by organizational unit</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Perform Integrated Address Book lookup when sending a message</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Name lookups to LDAP directories</td>
<td>No</td>
<td>Planned for 6.0.1</td>
<td>Yes</td>
</tr>
<tr>
<td>Personal Contacts Address Book</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Delivery Options (Importance, Delivery priority, delivery report)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Forward message</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Save message draft</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create a serial route memo</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Forward Web pages and documents from any Notes application</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Forward document as bookmark link message</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>“Copy Into” - convert item to Task, Calendar Entry or New Memo</td>
<td>Yes</td>
<td>Planned for the 6.x codestream</td>
<td>Yes</td>
</tr>
<tr>
<td>Return receipt</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Prevent copying</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Apply mood stamps to messages</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Create/use stationery</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Choose a letterhead</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Create a message containing a signature file</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Type-ahead within “Move to Folder” dialog box</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Specify outbound message with a “reply by” date</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Disclaimer support</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Specify message expiration date</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Internet message format</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Viewing and Responding to Message items

<table>
<thead>
<tr>
<th>Feature</th>
<th>Client 1</th>
<th>Client 2</th>
<th>Client 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support for Read/Unread marks</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Navigate to next document without returning to view</td>
<td>Yes</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>Perform mail file delegation</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Reply w/ history</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Reply to memo</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Reply to all</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Reply without attachments</td>
<td>No</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>Detach attachments</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>View rich text within a message</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for DocLinks, View Links, and Database Links</td>
<td>Yes, on the same server only</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>View tables within messages</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create tables within messages</td>
<td>No</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>Resend documents from within a delivery failure</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>View sections</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Action Bar</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Add Sender of message to Personal Contacts List</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Modify/View the file's ACL from client</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Display of Importance/Type icons in Views</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Read encrypted mail</td>
<td>No</td>
<td>Planned for 6.0.1</td>
<td>Yes</td>
</tr>
<tr>
<td>Verify signature of signed mail</td>
<td>No</td>
<td>Planned for the 6.x codestream</td>
<td>Yes</td>
</tr>
<tr>
<td>Next/previous navigation within an open mail message</td>
<td>No</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>Preference setting for new mail on top/bottom</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Automatically checking for new messages</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Advanced Editing features in Rich Text field

<table>
<thead>
<tr>
<th>Feature</th>
<th>Client 1</th>
<th>Client 2</th>
<th>Client 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left, right, and center, indent, outdent text justification</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Tables</td>
<td>No</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>Sections</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for embedded OLE objects</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Java applet support</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Page break</td>
<td>No</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>Horizontal line</td>
<td>No</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>Hotspots</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Insert image resources</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create sections</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to switch language dictionaries for spell checking</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Support for both bullets and numbered lists</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Feature</td>
<td>6.0.2</td>
<td>6.0.1</td>
<td>6.0.0</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------</td>
<td>------------</td>
<td>--------</td>
</tr>
<tr>
<td><strong>User Preferences</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td>No</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>New mail notification</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Default Mail Send/Save setting</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to archive mail and C&amp;S documents</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Lookup across multiple Address Books</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Automatically create a reply message by clicking on the From field</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Send signed and/or encrypted mail</td>
<td>No</td>
<td>Planned for the 6.x codestream</td>
<td>Yes</td>
</tr>
<tr>
<td>Read encrypted mail</td>
<td>No</td>
<td>Planned for 6.0.1</td>
<td>Yes</td>
</tr>
<tr>
<td>Field, form, view, document, section level security</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>User roles</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Local encryption of Mail database</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Clear browser cache and system temp directory upon logout</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Other Features</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control of database properties/design (refresh, replace, etc.)</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for alternate editors for mail messages</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Built-in news reader, POP mail, IMAP mail</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for Notes/Domino database subscriptions</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Extended Search (within databases, attachments, messages, and so on)</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>control of search - refinement of search with form, etc.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drag-and-drop documents between frames</td>
<td>No</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>User can change their own password from client</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for mail rules</td>
<td>No</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Table C-2  
**To Dos**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Webmail</th>
<th>iNotes Web Access</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Do’s follow day-to-day in calendar view</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Display To Do in calendar view</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Delegate a To Do to another person</td>
<td>Yes</td>
<td>Planned for the 6.x codestream</td>
<td>Yes</td>
</tr>
<tr>
<td>Create To Dos (with start and end dates)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Categorize new To Do entries</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Alarm notification on To Dos</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Mark To Dos complete or uncompleted</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create group To Dos</td>
<td>Yes</td>
<td>Planned for the 6.x codestream</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to set time on To Dos</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Display To Dos in Gantt chart format</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Priorities for To Dos (high, medium, and low)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create personal To Dos</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Owner and participant actions</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Table C-3  
**Calendaring and Scheduling**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Webmail</th>
<th>iNotes Web Access</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Action bar, open Calendar into specific view (i.e. 1-day, 1 week, 1-month, etc)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Calendar views</td>
<td>1 day</td>
<td>1 day</td>
<td>1 day</td>
</tr>
<tr>
<td></td>
<td>2 day</td>
<td>2 day</td>
<td>2 day</td>
</tr>
<tr>
<td></td>
<td>1 week</td>
<td>1 week</td>
<td>5 day</td>
</tr>
<tr>
<td></td>
<td>2 week</td>
<td>2 week</td>
<td>1 week</td>
</tr>
<tr>
<td></td>
<td>1 month</td>
<td>1 month</td>
<td>1 month</td>
</tr>
<tr>
<td></td>
<td>1 year</td>
<td>1 year</td>
<td>1 month</td>
</tr>
<tr>
<td>Summarized calendar views</td>
<td>No</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>Display unprocessed invites in calendar</td>
<td>No</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>Meeting view</td>
<td>Yes</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>Calendar print preview</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Feature</td>
<td>6.0.1</td>
<td>6.0.2</td>
<td>6.0.3</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------</td>
<td>--------------</td>
<td>-------</td>
</tr>
<tr>
<td>Inline calendar view editing</td>
<td>No</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>Work/nonwork hour differentiation</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ability for chairperson to see status of invitees from the view level</td>
<td>No</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Calendar Entries and Group Scheduling

<table>
<thead>
<tr>
<th>Feature</th>
<th>6.0.1</th>
<th>6.0.2</th>
<th>6.0.3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double-click within the calendar view to create an entry</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create Appointment</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create All Day Event</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create Reminder</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create Anniversary</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create Meeting Invitation</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create rich text in detailed description field</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Automatic date (calendar picture) and time selector controls</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Centrally managed rooms &amp; resources</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create repeating entries</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Add alarms to entries</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Attach a file to invitation forms</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Pencil in a meeting / tentatively schedule</td>
<td>Yes</td>
<td>Planned for the 6.x codestream</td>
<td>Yes</td>
</tr>
<tr>
<td>Mark an entry private/&quot;not for public viewing&quot;</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Delivery options on calendar entries</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Address lookup for inviting people</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Check freetime availability for invitees</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Freetime search within a counter-proposal</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Respond with comments within a counter-proposal</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Edit calendar entries</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Send a reschedule notice</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Feature</td>
<td>Client 1</td>
<td>Client 2</td>
<td>Client 3</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
</tr>
<tr>
<td>Add additional invitees after invitation is sent</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Send &quot;broadcast&quot; invitation (no RSVPs/responses)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Send meeting confirmation</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Display invitee responses in invitation</td>
<td>Yes</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>Accept invitation</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Decline invitation</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Counter propose an alternative time</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Accept/decline with comments</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Delegate an invitation</td>
<td>Yes</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>Check calendar from invitation page</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create and maintain group calendar</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create meeting invitation from group calendar view populating group members in invitation</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Accept counter proposal</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for meetings spanning midnight</td>
<td>No</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>C&amp;S entry support for online Sametime meetings</td>
<td>No</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to specify time zones in C&amp;S entries</td>
<td>No</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>Users in different time zones can share the same server and still see meeting times with respect to their own zone</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>User Preferences</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set global default appointment duration</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Set global default calendar entry type</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Option to make freetime available to only certain users</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Options to set allowable freetime</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Enable conflict checking for calendar entries</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Allow another user to manage Calendar without allowing access to email</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Mark default calendar entry as &quot;not for public viewing&quot;</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Autoprocessing of Calendar information

<table>
<thead>
<tr>
<th>Feature</th>
<th>Webmail</th>
<th>iNotes Web Access</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option to remove invitations from Inbox after processing</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to autoprocess invitations</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Table C-4  Personal Contacts

<table>
<thead>
<tr>
<th>Feature</th>
<th>Webmail</th>
<th>iNotes Web Access</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort contacts by Last Name, Company, Email, Address etc</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Add users in Domino Directory to Personal contact list</td>
<td>Yes</td>
<td>Planned for 6.0.2</td>
<td>Yes</td>
</tr>
<tr>
<td>Select multiple contacts and send message</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Select multiple contacts and schedule a meeting</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Business Card Summary view</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Categorization of contacts</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Automatically add email sender to Personal contact list</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Table C-5  Attachments

<table>
<thead>
<tr>
<th>Feature</th>
<th>Webmail</th>
<th>iNotes Web Access</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlimited Attachments</td>
<td>No (Maximum 2)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Drag and drop attachments from desktop/file system</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to rename attachments on download</td>
<td>No</td>
<td>Planned for the 6.x codestream</td>
<td>Yes</td>
</tr>
</tbody>
</table>

---

462  Migrating from Microsoft Exchange 5.5 to Lotus Notes and Domino 6
Table C-6  Miscellaneous

<table>
<thead>
<tr>
<th>Feature</th>
<th>Webmail</th>
<th>iNotes Web Access</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browser Support</td>
<td>Internet Explorer 4.x Internet Explorer 5.x Netscape Navigator 4.x</td>
<td>Win32 Internet Explorer 5.0 with SP1® or higher and Internet Explorer 6.0</td>
<td>N/A</td>
</tr>
<tr>
<td>Advanced Search (contextual by text, author, or date)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Journal integrated in mail file</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Contacts integrated in mail file</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ability to snooze alarms across multiple sessions / logins</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Context sensitive help</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Multilingual template support</td>
<td>No</td>
<td>Planned for the 6.x codestream</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for all Domino server platforms</td>
<td>Yes</td>
<td>Yes (Linux support planned for 6.0.1)</td>
<td>Yes</td>
</tr>
<tr>
<td>Set product as default mail program</td>
<td>No</td>
<td>Planned for the 6.x codestream</td>
<td>Yes</td>
</tr>
<tr>
<td>Offline support for Messaging, PIM and Collaborative Applications</td>
<td>Mail only</td>
<td>Messaging, PIM</td>
<td>Yes</td>
</tr>
<tr>
<td>Welcome Page Support</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Mail view filter for unread messages</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Mail view filter for high priority messages</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Mail view filter for last 10 messages</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Use Web browser to display HTML mail messages</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>
Additional material

This redbook refers to additional material that can be downloaded from the Internet as described below.

Locating the Web material

The Web material associated with this redbook is available in softcopy on the Internet from the IBM Redbooks Web server. Point your Web browser to:

ftp://www.redbooks.ibm.com/redbooks/SG246955

Alternatively, you can go to the IBM Redbooks Web site at:

ibm.com/redbooks

Select the Additional materials and open the directory that corresponds with the redbook form number, SG246955.

Using the Web material

The additional Web material that accompanies this redbook includes the following files:

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProjectPlan.zip</td>
<td>Migration project plan template</td>
</tr>
</tbody>
</table>
create a subdirectory (folder) on your workstation, and unzip the contents of the Web material zip file into this folder.

- **ProjectPlan.zip** contains *How to migrate from Exchange 5.5 to Domino 6.MPP* file which is a MS Project 2000 document meant to be used as a starting point for creation of your migration plan.

- **QuestWord.Zip** contains *Exchange Migration Questionnaire.doc* document which is a Pre-migration questionnaire in Microsoft Word document format.

- **QuestWordPro.Zip** contains *Exchange Migration Questionnaire.lwp* document which is a Pre-migration questionnaire in Lotus Word Pro document format.

All of these documents are not meant to be used as is, rather you want to customize those documents to suit your needs and match your environment.
Related publications

The publications listed in this section are considered particularly suitable for a more detailed discussion of the topics covered in this redbook.

IBM Redbooks

For information on ordering these publications, see “How to get IBM Redbooks” on page 468. Note that some of the documents referenced here may be available in softcopy only.

- Upgrading to Notes & Domino 6, SG24-6889
- Lotus Domino 6 for Linux, SG24-6835
- Lotus Domino 6 for iSeries Implementation, SG24-6592
- Domino Designer 6 A Developer’s Handbook, SG24-6854
- New features of Lotus Domino 6.0.1: Single Copy Template, REDP3681
- Upgrading to Domino 6: Performance Benefits, REDP3634
- Installing and Managing Microsoft Exchange 2000 Clusters, SG24-6265
- Exchange Migration and iNotes Implementation on the IBM eServer iSeries Server, SG24-6230
- Deploying Microsoft Exchange on IBM eServer BladeCenter, REDP3585

Online resources

These Web sites and URLs are also relevant as further information sources:

- Move2Lotus Web page. The Move2Lotus program is designed to help provide customers using competitive messaging and collaboration products, including Microsoft Exchange and Novell Groupwise, the total solution offering you need to migrate to world-class messaging with Lotus Domino. Move2Lotus includes products, migration tools, third party tools vendors, over 500 Move2Lotus-trained business partners worldwide, plus offerings from IBM eServer and IBM Software Services for Lotus.

  www.lotus.com/move2lotus
- Chatham Technologies, IBM/Lotus Business partner that specializes in Microsoft Exchange and Lotus Domino related projects as well as migration projects.  
  http://www.chathamtech.com/
- Binary Tree, IBM/Lotus Business partner that offers a wide range of products, among them migration tools. Binary Tree Migration Suite contains migration products detailed in this redbook, such as CMT for Notes and CMT for Exchange Public Folders.  
  http://www.binarytree.com/
- TFS Technology, IBM/Lotus Business Partner that creates email security and connectivity products, such as TFS Gateway, which is detailed in this book.  
  http://www.tfstech.com
- Wolcott Systems Group offers tools for example for Notes client deployment.  
  http://www.wolcottgroup.com/
- IBM/Lotus Business Partner that has various tools for upgrade and migration projects.  
  http://www.compusven.com

How to get IBM Redbooks

You can search for, view, or download Redbooks, Redpapers, Hints and Tips, draft publications and Additional materials, as well as order hardcopy Redbooks or CD-ROMs, at this Web site:

ibm.com/redbooks
Index

A
Access Control List  98
ACL  98
Active Directory  10, 13, 19–20, 73
  synchronizing with Domino Directory  14
Active Directory Connector  21
Adding a user to Windows NT  163
ADSync tool  14
All day events  338
amap.tbl  226
Assembling the project team  32
Automated application synchronization  63
Automated directory synchronization  62
Automatic Deployment Tool  73

B
Backup and disaster recovery  74
Business requirements  35

C
Calendar Connector  218
  amap.tbl  226
  architecture  218
  configuration  219
  configuring Domino  228
  creating a new connection  222
  customization  219
  installation  218
  loading on Domino server  230
  log  224
  monitoring  232
  Notes calendar connection details  223
  operating  229
  operation  218
  overview  218
  permissions  226
  real-time synchronization  223
  running on scheduled times  224
  schedule  223
  site  221
  specifying date range  221
  starting as a service  229

Client selection
  available options  53
  cost considerations  57
  decision points  59
  Domino Access for Microsoft Outlook  56
  Domino Web Access  55
  existing install base  54
  Linux  57
  Macintosh  57
  Notes  56
  offline usage  58
  performance  58
  platform  57
  requirements  53
  security  59
  TCO  57
  user training requirements  57

Clients  53
CMT  6, 66–67, 277, 399
  add users from Domino  287
  add users from foreign directory source  287
  benefits  278
  choosing items to migrate  289
  configuring input parameters  289
  configuring settings  282
  customizing the migration message  309
  distribution lists  290
  Domino Directory settings  283
  duplicate names resolution  297
  end date  291
  end-user migration  316
  end-user settings  282
  Exchange User Selection  293
  groups  290
  local folders  307
  MAPI profile  285
  migrating calendar  289
  migrating contacts  307

Calendar migration results  333
Calendar synchronization  218
starting automatically  230
testing the connection  231
time-out  221
verifying configuration  230

© Copyright IBM Corp. 2003. All rights reserved.
Contextual collaboration 12
Controlling access to public folders 356
Cost of upgrading Exchange servers 12
Creating a communication plan 37
Creating a PST from a Public Folder 430
Creating a Public Folder 351, 354
Creating a Public Folder replica 362
Creating a risk management plan 48
Creating a schedule for calendar synchronization 223
Creating a training plan 46
Creating an Exchange recipient container 117
Creating Domino views 112
Cross-certification 103
Customizing the directory synchronization 137

D
Data importance 65
Data migration 64
Data retention 65
Defining the project scope 34
Directory assistance 107
Directory Connectors 361
Directory synchronization 107, 180
directory synchronization
site addressing 132
Disaster recovery policy 45
Distributing client software 73
Documenting the current messaging environment 38, 449
Documenting the Exchange environment 39
Domain permissions 166
Domino
amount of servers needed 52
choosing the platform 52
CPU scalability 51
licensing 9
memory utilization 51
platforms 6
scalability 50
Server Configuration Document 211
server types 51
sizing 49
SMTP mail traffic 200
topology 50
Transaction logging 51
Domino 6 11
application development 24
benefits 23
client support 24
new functionality 11
training 24
Domino 7 12
Domino Access for Microsoft Outlook 7–8, 53, 56
additional features 56
architecture 56
e-mail 56
features 56
off-line usage 56
Domino Designer 369
changing the name of a view 396
creating a form 415
modifying a view 393
modifying columns 395
Domino Directory 228
Domino Enterprise Server 7–8
Domino Messaging Server 7
Domino Offline Services 8
Domino server console 233
Domino Upgrade Services
See DUS
Domino Web Access 7–8, 53
architecture 55
calendar 56
e-mail 56
features 55
off-line usage 55
DUS 6, 66–67, 253, 426
adding administrator to ACLs of mail files 268
adding empty groups to Notes 268
connecting to an Exchange server 257
converting mail 268
creating a Domino mail database 275
creating a Domino person document 275
distribution lists 266
Exchange administrator mail profile 257
Exchange Global Address List 265
groups 266
installation 254
installing Notes 255
installing Outlook client 255
mail files 268
migrate people 264
migrating calendar entries 275
migrating groups 266
migrating mail messages 275
migration options 267
migration options table 269
migration preparations 254
migration setup 262
nested groups 266
Password Options 271
passwords 267
people and migration window 265
performing the migration 270
registering users 263
selecting users for migration 266
service account administrator role 257
starting 262
testing the migration 266
the migration process 261

E
eKnowledge 367
administrators account 374
automatic mapping of fields 383
column mapping 381
Composer 377
connecting to the Exchange server 369
connection between systems 377
creating the connections 378
creating the Domino connection 381
customizing the Domino database 393
data comparison 388
designing the Domino database 369
Domino considerations 368
Domino database, after migration 390
Domino database, before migration 370
Exchange considerations 368
execution control 385
filtering fields 384
getting data from Exchange 368
installing on a Domino server 368
key manager 372
manual mapping of fields 383
migration results using a blank database 392
Oracle 373
post-installation tasks 377
product keys 375
profile 368
profiles 369
running as a service 377
running the coexistence 387
samples 375
SAP 373

scheduling 386
setting up 371
setup type 373
source data in Outlook 369
source Public folder 379
specifying the form and fields 380
SQL 373
starting the Composer 388
system catalog 374

ECL 104
EFORMS REGISTRY 349
Embedded objects 326
Encrypted documents 43
Enterprise architecture models 5
Exchange
Administration procedures 46
antivirus 43
applications 42
backup software 43
calendar and scheduling 41
connecting to Notes calendar 222
connection documents 360
connectivity 360
conneeting to other sites 360
contacts 64
creating a mailbox 419
e-mail 41
end of support 10
instant messaging 43
Optimizer utility 348
Personal address books 64
Personal folders 64
platforms 6
public folder server 348
Public folders 42, 64
replication 360
security vulnerabilities 9
Service Level Agreements 45
Site Connectors 360
support 10, 18
system folders 349
User Directory 42
Exchange 2000 4
benefits 20
migrating 20
migration concerns 21
Native mode 22
Exchange 2003 10
Exchange Administrator program 219
Exchange administrators 33
Exchange Calendar Connector task 218
Exchange client topology 40
Exchange Connector
adding containers 121
address synchronization 143
as a service 128
configuration 94
collection document 105
configuring address books 116
creating a configuration document 103
customization 116, 137
customizing the synchronization 137
directory synchronization schedule 126
DocLinks 123
Exchange recipient container 117
export container 116
gathering information about Domino 78
gathering information about Exchange 79
import container 116, 119
import container specifics 122
installation 79
installing 81
monitoring 135
multiple Exchange servers 132
name resolution 142
Notes Address Book 122
Notes configuration utility 94
Notes Configuration Utility database 105
opening 118
operating 128
permission to create Domino databases 101
preparing for the installation 78
pre-requisites 78
propagating distribution lists 123
properties 119
routing tables 125
running the Notes Configuration Utility 102
site addressing 132
site addressing properties 134
specifying Notes connection 124
specifying source address book 107
specifying target address book 107
starting 123, 127
starting the Connector 108
stopping 136
synchronizing groups 122
testing 134
verifying access 98
verifying directory synchronization 129, 131
verifying Domino configuration 109
Exchange Connector installation
foreign domain name 84
installing Notes 79
installing the connector 81
registering a person 89
registering connector with Notes 86
verifying 85
Exchange Enterprise Edition 7
Exchange Internet Mail Connector 360
Exchange Internet Mail Service
starting 200
stopping 199
Exchange server permissions 261
Exchange server topology 39
Exchange services 41
Exchange Site Permissions 259
Exchange Standard Edition 7
Exchange System Folders 349
F
Foreign Domain document 228
Free/busy time search 218
Fully qualified Internet host name 208
H
Hardware inventory 43
Help Desk 45
HP-UX 6
I
IBM DB2 12
IBM Lotus Workplace Messaging 14
IBM Tivoli Configuration Manager 73
Inbox 321
Information Store Site Configuration 353
iNotes
See Domino Web Access
iNotes Web Access
See Domino Web Access
Installing Calendar Connector 218
InstallPump 73
Instantaneous rollout 72
IPM.Post.Account form 380
iSeries 6
iWA
Migrating from Microsoft Exchange 5.5 to Lotus Notes and Domino 6

See Domino Web Access

J
J2EE 5, 14
Java platform 14

K
Key Manager for ecKnowledge 372

L
Licensing 9
  CALs 9
  Client Access Licenses 9
Linux 6, 57

M
Mail migration results 320
Mail rules 41
Manual application synchronization 63
Manual directory synchronization 62
MAPI profile 265, 285, 293, 306, 406
Messaging options 17
  migrating to Domino 6 23
  migrating to Exchange 2000 20
Microsoft .NET 5
Microsoft Domino Connector for Exchange 62
Microsoft Excel 326, 426
Microsoft Exchange Administrator 165
Microsoft Exchange Calendar Connector 217
Microsoft Exchange Connectivity Controller 127
Microsoft Exchange Connector for Lotus Notes 127
Microsoft Exchange Global Address List 265
Microsoft Exchange Internet Mail Service 193
Microsoft messaging products 13
Microsoft SMS 73
Microsoft Word 326
Migration options
  remain on Exchange 5.5 18
Migrating users 253
Migration 3, 254
  abandoning old data 64
  benefits 4
  calendaring data 64
  deciding on data to be migrated 64
  impact 12
  messaging data 64
  platforms 6
  process 5
  public folders 367, 399
  reasons 4, 9
  server consolidation 6
  strategy 60
  TCO 4, 10–11
  user data 64
Migration components 7
Migration options 5
  CMT 277
  upgrade to Windows 2000 19
Migration process 5, 261, 281
  coexistence process 66
  overview 65
  single step 65
Migration project
  administration procedures 46
  acquiring the necessary information 67
  backup and disaster recovery 74
  basic requirements for the new system 35
  categorizing the requirements 36
  client selection 53
  closure 74
  commitment 31
  communication plan 37
  creating a schedule 34
  current environment 36, 38
  dealing with resistance 33
  deciding on the coexistence level 61
  designing the new environment 49
  documenting the business requirements 34
  documenting the expectations 38
  expectations 71
  high-level goals 32
  initial kickoff meeting 32
  instantaneous rollout 72
  key steps 28
  management support 31
  managing risk 48
  network 44
  new environment 36
  planning the servers 49
  requirements 35
  roles 33
  schedule 34
  scope 34
  setting boundaries 34
  setting the expectations 38
  sponsor 31
Staged rollout 72
support structure 45
team 32
team members 33
training plan 46
vision 32
Migration project overview 27
Migration results 319
All day event 336
calendar data 333
Calendar View 334
CMT 322, 325–326, 328, 330, 332, 335, 337, 340, 342
Contacts 339
Contacts view 340
DUS 322, 325–326, 328, 330, 332, 335, 337, 340, 342
embedded objects 326
HTML messages 324
inbox 321
mail 320
mail messages 324
Tasks 341
URLs 332
welcome page 320
workspace 320
Migration strategy 60
Migration tools 66
CMT 66–67
DUS 66–67
Modifying Access Control Lists 102
Monitoring the Exchange Connector 135
Move2Lotus 7
Moving data from public folders 418
Multiple Exchange servers 132
Multiple Internet gateways 140

N
Netscape Mail 4
Network compression 11
Network infrastructure 44
Notes 7–8, 53, 56
client installation 79, 160
configuring 94
features 56
ID files 59
security 59

O
OLE 326
On 405
Optimizer utility 348
Outlook client 7
connecting to Domino server 8
Outlook Contact Information 428
Outlook Web Access 7

P
PAB 41
Password protecting a PST 433
Permissions tab 358
Platform support 6
Platforms 6
priv.edb 348
Private information store 348
Privileges to create Domino databases 101
Project manager 33
Project schedule 34
pSeries 6
PST 41, 430
pub.edb 348
Public folders
access control 356
administering 351
Affinity Tab 365
archiving 430
basics 347
CMT 399
coexistence 367
compared to Domino databases 348
copying content 423
creating 351, 354
creating a contacts application 356
creating a PST 430
creating a replica 362
creating replicas 360
default configuration 353
explained 347
files 348
forms 348
mail server 348
manual migration 417
T
Tasks 341
TCO 10–11
Team members 32
Testing the Exchange Connector 134
TFS Exchange Gateway installation 176
TFS Gateway 6, 62, 145
architecture 148
coeexistence 146
described 146
directories 160
Directory Synchronization 146, 180
Exporting the Exchange users from TFS Directory 188
Exporting the Notes users from TFS Directory 188
features 146
foreign domain document 151
Importing Exchange users to TFS Directory 186
Importing Notes users to TFS Directory 186
installation 148
installing Lotus Notes Connector 172–173
installing the Exchange Connector 174–176
installing the software 167–171
module selection 171
Notes client 160
operation 148
prerequisites 149
registering person 154
setting access rights 161
Setting Notes target address book 184
setting up NT and Exchange 163
starting 185
testing 189
user ID 153
users 164
verifying synchronization 187
Time zones 339
To Do entries 341
Training plan 46
gathering requirements 46
planning for delivery 47
Training resources 48

U
Unsupported software 18
Using a spreadsheet to massage data 426
Migrating from Microsoft Exchange 5.5 to Lotus Notes and Domino 6
Migrating from Microsoft Exchange 5.5 to Lotus Notes and Domino 6

Benefits of migration

This IBM Redbook describes why and how to migrate from Microsoft Exchange 5.5 to IBM Lotus Notes and Domino 6.

Planning and implementing a migration project

It begins with a discussion of the reasons an organization using Exchange 5.5 would want to move to Domino 6, and describes the benefits that can be gained. It lays out the different options that the organization has for a future messaging infrastructure and discusses the pros and cons of each alternative. It is particularly suited to business and IT managers.

The next part is about planning and managing a migration project. It covers how to assess the current messaging environment, design the migration project and future infrastructure, and successfully implement the migration plan. This part is primarily of interest to project managers and IT architects.

The rest of the book deals with the technical aspects of moving to a Lotus Notes and Domino 6 messaging environment. Topics covered are:

- Coexistence and migration scenarios
- Strategies for coexistence during the project
- Installation and setup of coexistence and migration tools
- How to migrate users and messaging and calendaring information
- Public Folder migration and coexistence
- Results achieved in the lab using various tools and techniques
- Wrapping up a migration project

This material is useful for anyone who has to evaluate the tools, install them, and conduct a messaging migration project.